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Warranty

The material contained in this docu-
ment is provided “as is,” and is subject
to being changed, without notice, in
future editions. Further, to the maxi-
mum extent permitted by applicable
law, Keysight disclaims all warranties,
either express or implied, with regard
to this manual and any information con-
tained herein, including but not limited
to the implied warranties of merchant-
ability and fitness for a particular pur-
pose. Keysight shall not be liable for
errors or for incidental or consequential
damages in connection with the fur-
nishing, use, or performance of this
document or of any information con-
tained herein. Should Keysight and the
user have a separate written agreement
with warranty terms covering the mate-
rial in this document that conflict with
these terms, the warranty terms in the
separate agreement shall control.

Technology Licenses

The hardware and/or software described in
this document are furnished under a license
and may be used or copied only in accor-
dance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of a
U.S. Government prime contract or subcon-
tract, Software is delivered and licensed as
“Commercial computer software” as defined
in DFAR 252.227-7014 (June 1995), or as a
“commercial item” as defined in FAR 2.101(a)
or as “Restricted computer software” as
defined in FAR 52.227-19 (June 1987) or any
equivalent agency regulation or contract
clause. Use, duplication or disclosure of
Software is subject to Keysight Technologies’
standard commercial license terms, and
non-DOD Departments and Agencies of the
U.S. Government will receive no greater than
Restricted Rights as defined in FAR

52.227-19(c)(1-2) (June 1987). U.S. Govern-
ment users will receive no greater than Lim-
ited Rights as defined in FAR 52.227-14
(June 1987) or DFAR 252.227-7015 (b)(2)
(November 1995), as applicable in any tech-
nical data.

Declaration of Conformity

To get the latest version of the declaration of
conformity, go to http://www.key-
sight.com/go/conformity and type in the
product number in the Search field.

Latest Information

To get the latest firmware/software/elec-
tronic manuals/specifications/support infor-
mation, go to www.keysight.com and type in
the product number in the Search field at the
top of the page.


http://www.keysight.com/go/conformity

COMPLIANCE WITH GERMAN NOISE REQUIREMENTS

This is to declare that this product is in conformance with the German Regulation on
Noise Declaration for Machines
(Larmangabe nach der Maschinenlarminformation-Verordnung -3.GSGV Deutschland).

Herstellerbescheinigung
GERAUSCHEMISSION
Lpa < 70dB
am Arbeitsplatz
normaler Betrieb
nach DIN 45635 T. 19
Manufacturer’s Declaration
ACOUSTIC NOISE EMISSION
Lpa < 70dB
operator position
normal operation
per IS0 7779

South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in electromagnetic
environments outside of the home.
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WARNING

A\

High Voltage

is used in the operation of this equipment.

LETHAL VOLTAGE on CONTACT

may be present at measurement terminals,
if you fail to take in all safety precautions!

When the RED indicator lights, lethal voltage (+3000 V dc/pulse) may appear at
measurement terminals.

Usually use the interlock function.

Do not operate the instrument unless another person is around the work space who is
familiar with instrument operation and hazards or administering first aid.

Potentials less than £500 V may cause death under certain conditions. Therefore,
adequate preventive measures must be taken at all times!

FIRST AID FOR ELECTRIC SHOCK
SPECIAL ATTENTION TO RESCUE IN SAFETY

Never rush into an accidental situation.

Take special attention to the following notices to prevent second accident.

Do NOT touch the CASUALTY or conductive surface with your hands unprotected.
Shut off high voltage at once.
Disconnect AC mains.

If it is unsure to make safe, the following procedure will helps to protect your lives
during the CASUALTY is rescued.

Stand on a dry insulating material; use a dry wooden or plastic implement to free
the CASUALTY from contact with hazardous electrical source.

Ground the circuit to de-energize.



«  Free the CASUALTY from the LIVE conductor
CALL EMERGENCY

«  Call your local Emergency number immediately, if any of signs or symptoms shown in
the following table will be found.

http://en.wikipedia.org/wiki/Emergency_telephone_number#Emergency_numbers
DELAYED SYMPTOMS

In some cases, electric shock can cause injuries that are not evident and symptoms
may be delayed.

Burns to the CASUALTY may be greater than they appear on the surface.

For these reasons, all electric shock CASUALTY should be taken to hospital for
advanced observation.

English Deutsch French Japanese Korean Simplified Traditional
Chinese Chinese
Symptoms Symptome Symptémes JefE 3 fiEfE e
Cardiac arrest Herz-Kreislauf-Stillsta | Arestation DR | Al AR | OMELE | DO s LR
nd cardiopulmonaire
Abnormal cardiac | Arrhythmia Arythmie AHEERR 574 PKEEARTT | IREEASTR
rhythm
Respiratory failure | Respiratorischer Echec respiratoire MERARE | % A | FERAE | FERRA
(difficult or absent | MiRerfolg
breathing)
Muscle pain and Muskelschmerz und Douleurdumuscle | FiA0W / | <% / | LA / | LR /
contractions Zusammenziehungen | et contractions i T =z JE g
Seizures (heart Herzlahmung Paralysie cardiaque | /BRI | A28 wER] | DD FRBRET | O iERRIE
beat stopped)
Numbness and Eine Taubheit / Un engourdissement | i1 / At /| KRR/ BEFR /
tingling Stachel / Une épine ellbr 7 Al b elpr
Unconsciousness | Bewusstlosigkeit Evanouissement A | 94 B | BiEAH | BEERH
Entrance and exit | Eine elektrische Une trace du choc JREER ) A A= | fhEgEE | R
wound burns Schockspur électrique




First Aid for Electric Shock Procedure

Do not give compression-only CPR to infants and children — all infants and children who have a sudden
cardiac arrest need conventional CPR.  Also should not be used for adults whose cardiac arrest is from
respiratory causes, or for an unwitnessed cardiac arrest.

D

Danger

Check for DANGER, make SAFE first to YOU, Others, and the CASUALTY.

R

Response

Check for a RESPONSE.

Leave on back.

If not conscious,
1. Ask others to emergency CALL for an ambulance immediately.
2. HELP to bring AED, ASAP.
3. Start CPR by YOU.

CPR
for ADULT only

Start the center of chest compressions (>100 compressions per minute) without
stopping until emergency medical services arrive.

One of the most famous chest compression-only CPR is AHA Hands-Only CPR which
is without mouth-to-mouth rescue breaths.

http://handsonlycpr.org/

http://www.youtube.com/watch?v=zuJkRpJ7Fxg

Rhythm of chest compression:
http://www.heart.org/HEARTORG/CPRAndECC/CommunityTraining/ CommunityPro
grams/CPR-Week_UCM_427219_SubHomePage.jsp
http://www.youtube.com/watch?v=n5hP4DIBCEE&feature=player_detailpage

Continue CPR until

®  Signs of life return.

® AED is ready to use.

® Medical services arrive and take over.

If YOU have a trained

rescue skill, should apply the following step.

If not, only keep chest compression until others help.

A Airway No foreign material Foreign material

Leave on back, open airway. Place in the recovery position, clear of objects.
B Breathing 30 compress & 2 breaths
D Defibrillator Apply AED with following voice prompts.

+

If no AED available, continue CPR until qualified personnel arrives.

¢ AED: Automated External Defibrillator
P CPR: Cardio Pulmonary Resuscitation
¢ AHA: American Heart Association, Inc.



http://www.heart.org/HEARTORG/CPRAndECC/CommunityTraining/CommunityPrograms/CPR-Week_UCM_427219_SubHomePage.jsp

Reference

AHA CPR & Emergency Cardiovascular Care (ECC)
(http://www.heart.org/HEARTORG/CPRANdECC/CPR_UCM_001118_SubHomePage.j
sp)

AHA Hands-only CPR (http://handsonlycpr.org/)

Save a Life
(http://www.heart.org/HEARTORG/CPRANdECC/CommunityTraining/CommunityPro
grams/CPR-Week_UCM_427219_SubHomePage.jsp)

AHA CPR Translated Website
(http://www.heart.org/HEARTORG/CPRANdECC/International/TranslatedWebsites/Tr
anslated-Websites_UCM_303149_SubHomePage.jsp)

Deutsch (http://www.american-heart.de/startseite)

Japanese (http://eccjapan.heart.org/) available as of March, 2012))

Chain of Survival
(http://www.heart.org/HEARTORG/CPRANdECC/WhatisCPR/ECCIntro/Chain-of-Surv
ival_UCM_307516_Article.jsp)

ECC Guidelines Highlights 2010

English (http://eccjapanheart.org/pdf/ECC_Guidelines_Highlights_2010.pdf)
Japanese (http://eccjapanheart.org/pdf/ECC_Guidelines_Highlights_2010JP.pdf)
Deutsch (http://www.american-heart.at/fileadmin/downloads/Guidelines2010-Highl
ights_D/Guidelines2010-Highlights_D.pdf)

International
ILCOR (http://www.ilcor.org/home/)

ILCOR CoSTR 2010 Consensus
(http://www.ilcor.org/consensus-2010/costr-2010-documents/)

Europe

ERC (https://www.erc.edu/)

ERC Guidelines 2010 (http://www.cprguidelines.eu/2010/)

Local language translation (https://www.erc.edu/index.php/doclibrary/en/185/1/)
America

AHA (http://www.americanheart.org/)

AHA Guidelines 2010 (http://guidelines.ecc.org/2010-guidelines-for-cpr.html)



NOTE

WARNING

Safety Summary

The following general safety precautions must be observed during all phases of
operation, service, and repair of this instrument. Failure to comply with these precautions
or with specific warnings elsewhere in this manual may impair the protections provided
by the instrument. In addition, it violates safety standards of design, manufacture, and
intended use of the instrument. Keysight Technologies assumes no liability for
customer’s failure to comply with these requirements.

Product manuals may be provided on CD-ROM or in printed form. Printed manuals are an
option for many products. Manuals may also be available on the Web. Go to
www.keysight.com and type the product model number in the Search field at the top of
the page.

Do not use this instrument in any manner not specified by the manufacturer. The
protective features of this instrument may be impaired if it is used in a manner not
specified in the operation instructions.

This instrument is an INDOOR USE product.

This instrument complies with INSTALLATION CATEGORY Il for mains input and
INSTALLATION CATEGORY | for measurement input terminals, and POLLUTION DEGREE 2
defined in IEC 61010-1.

If an instrument is marked CAT | (IEC Measurement Category I), or it is not marked with a
measurement category, its measurement terminals must not be connected to
line-voltage mains.

DANGEROUS PROCEDURE WARNINGS

Warnings, such as example below, shall be complied. Procedures throughout in this
manual prevent you from potentially hazard. Their instructions contained in the
warnings must be followed.

Hazardous voltage, instrument maximum output voltage may appear at the
measurement terminals (High, Force, Guard, and Sense) if Interlock terminal is closed.
Open the Interlock terminal when the measurement terminals are accessible. Voltage
applied to the terminals will be limited up to +42 V.

Do not work the interlock function intentionally in order to bring the output voltage to
the safe level. While the high voltage indicator is lit, the dangerous voltage by the
output voltage or the residual charge appears on the measurement terminal.



BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the instrument
before applying power. Note the instrument's external markings described under
“Safety Symbols”.

GROUND THE INSTRUMENT

This is Safety Class | instrument. To minimize shock hazard, the instrument chassis
and cabinet must be connected to an electrical ground. The power terminal and the
power cable must meet International Electrotechnical Commission (IEC) safety
standards.

DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE

Do not operate the instrument in the presence of flammable gases or fumes.
Operation of any electrical instrument in such an environment constitutes a definite
safety hazard.

DO NOT REMOVE COVERS

No operator serviceable parts inside. Refer servicing to qualified personnel. To
prevent electrical shock do not remove covers.

IN CASE OF DAMAGE

Instruments that appear damaged or defective should be made inoperative and
secured against unintended operation until they can be repaired by qualified service
personnel. Return the instrument to a Keysight Technologies sales or service office
for services and repair to ensure that safety features are maintained.

USE ONLY THE SPECIFIC ACCESSORIES

Specific accessories satisfy the requirements for specific characteristics for using the
instrument. Use the specific accessories, cables, adapters, and so on for safety
reasons.



> 010 CO—F F ® +

WARNING

CAUTION

Safety Symbols

The general definitions of safety symbols used on equipment or in manuals are listed
below.

Direct current.
Alternating current.
Earth (ground) terminal.

Protective conductor terminal. For protection against electrical shock in case of a fault.
Used with field wiring terminals to indicate the terminal which must be connected to
ground before operating equipment.

Frame or chassis terminal. A connection to the frame (chassis) of the equipment which
normally includes all exposed metal structures.

Grounded terminal which indicates the earth potential.
On supply.
Off supply.

Standby supply. The equipment will be marked with this symbol is not completely
disconnected from AC mains when power switch is in the standby position.

In position of a bi-stable push switch.
Out position of a bi-stable push switch.

Hazardous voltage and potential for electrical shock. Do not touch terminals that have
this symbol when the equipment is on.

Hot surface. Avoid contact. Surfaces are hot and may cause personal injury if touched.

Caution, refer to accompanying documentation. The equipment will be marked with this
symbol when it is necessary for the user to refer to the instruction manual.

The warning sign denotes a hazard. It calls attention to a proced ure, practice, condition
or the like, which, if not correctly performed or adhered to, could result in injury or
death to personal.

The caution sign denotes a hazard. It calls attention to an operating procedure, practice,
condition or the like, which, if not correctly performed or adhered to, could result in
damage to or destruction of part or all of the equipment.



ICES/NMB-001

ISM &ss A

Read operator's manual. To indicate that the operator's manual or card should be read
before continuing the operation.

IEC Measurement Category |
The CE mark shows that the product complies with all applicable European Directives.
The CSA mark is a registered trademark of the Canadian Standards Association.

The RCM mark is a registered trademark of the Australian Communications Authority. This
signifies compliance with the Australian EMC Framework Regulations under the terms of
the Radio communications Act.

This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

This is the symbol for an Industrial, Scientific and Medical, Group 1 Class A product.
(CISPR 11)

Korea's safety and EMC mark

China RoHS - Environmentally Green Product Label
China RoHS - Product with Toxic Substance 40 yr EPUP

The Chinese mark for paper-based packaging materials; Paperboard and Corrugated
Fiberboard

Plastic Material Coding Identification

Low temperature or freezing conditions. Avoid contact. Surfaces are cold and may cause
personal injury if touched.



Power Supply and Measurement Safety

Power Supply Safety

This instrument can output high currents and voltages. Make sure that the load or
device under test can safely handle the output current and voltage. Also, make sure
that the connection leads can safely withstand the expected currents and are
insulated for the expected voltages.

The instrument outputs may be connected so as to float relative to earth ground.
Isolation or floating voltage ratings are indicated on the instrument, near the output
terminal or the Circuit Common terminal. There is the danger of electric shock by
touching the floated measurement terminals. Keep in mind it to protect yourself. And
it is a reason of using the recommended accessories.

Voltage/Current Measurement Safety

Multimeters and other instruments capable of measuring high voltages and currents
are subject to specific safety concerns because of the circuits to which they may be
connected. To safely use these instruments, you need to understand the markings on
the instrument near the input terminals, which include the Protection Limits and the
IEC Measurement Category.

Protection Limits

Keysight multimeters and other voltage measurement instruments provide protection
circuitry to prevent damage to the instrument and to protect against the danger of
electric shock, provided the Protection Limits are not exceeded. To ensure safe
operation of the instrument, do not exceed the Protection Limits shown on the input
terminals.

Source/Monitor Terminals

Source/monitor unit, SMU, can simultaneously perform DC voltage or current output
and measurement. Typical SMU has the Force, Guard, Sense, and Circuit Common
terminals as shown below. Normally the Force, Guard, and Sense terminals are the
same potential. Voltage marked around the terminals indicates the Protection Limits.

Force and Sense must be connected to a terminal of a device under test for the Kelvin
connection which is effective for high current measurement and low resistance
measurement. For the non-Kelvin connection to ease the connections, connect Force
only. Do not connect Sense. It must be opened.



Guard should be extended to around the device terminal for reducing leakage current
caused by a coaxial cable used. Guard must be never connected to anything at the
device side.

Circuit Common should be connected to shielding of the coaxial cable used.

The following image is the Kelvin triaxial connector of Medium Power SMU.

Guard\ Force Circuit Common Sense /Guard
ones Force 3™ | e | )Sense
- \Qa \ e f » \
10 ) al (@)
Guard ©
Circuit .

i {

+100V= Max

To Avoid Risk of Residual Charge

1.E-06

C=0.1uF

1.E-07

Capacitance (F)

1E-08 =——— GSafetyArea = >\_

1.E-09

100 1000 10000

Voltage (V) (Based on standards IEC60950-1 and IEC61010-1.)
This graph shows the load capacitance vs voltage characteristics generally
considered as safety. Use the instrument within the safety area up to 0.1 pF or 45 uC
according to the voltage. Also do not connect the capacitive load over the maximum
load capacitance specified for the instrument, for example 10 nF for HYSMU.

Before touching the measurement terminal, confirm that it has been discharged
enough. For that, ground and discharge the terminals over 10 seconds after stopping
the high voltage output, and confirm that they have been safety voltage by using
another volt meter.

If abnormal end of measurement, breaking of cable, or device damage occurs, do not
touch the terminals until they are discharged enough.

Also if a series resistor is connected, do not touch the terminal until it is discharged
enough.



A High Voltage Shock Hazard

Keysight B1506A can force dangerous voltages (+3000 Vdc for HYSMU and £100
Vdc for MPSMU) at the High, Force, Guard, and Sense terminals. To prevent
electric shock hazard, the following safety precautions must be observed during the
use of Keysight B1506A.

Connect the instrument to an electrical ground (safety ground) by using
three-conductor AC power cable.

Before performing measurement, connect the interlock circuit to the Interlock
terminal of thisinstrument.

Confirm periodically that the interlock function works normally.

Before touching the connections of the High, Force, Guard, and Sense terminals,
turn the instrument off and discharge any capacitors of the measurement path. If
you do not turn the instrument off, complete “all” of the following items,
regardless of any instrument settings.

« Terminate measurement by pressing the Stop key, confirm that the
Measurement status indicator is not lit.

e Confirm that the High Voltage indicator is not lit.
e Open the Interlock terminal.
« Discharge any capacitorsif the capacitance is connected to an SMU.

Warn workers in the vicinity of the instrument about hazardous conditions.



Gefahr durch Hochspannung

Von den Gerédten Keysight B1506A kénnen Spannungen an den Anschllissen
“High”, “Force”, “Guard” und “ Sense” von bis zu 3000 V ausgehen. Um
elektrischem Schlag vorzubeugen, ist bei der Bentitzung der Geréte Keysight
B1506A folgendes zu beachten.

Verwenden Sie ein dreiphasiges AC-Stromkabel fur die Gerétsteckvorrichtung
(Eingang) und schliefien Sie das Instrument an eine Erdung an
(Sicherheitserdung).

Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem
Interlock-Anschluss dieses I nstruments.

Prifen Sie in regelméaidigen Absténden, dass die Verriegelungsfunktion
ordnungsgemal3 funktioniert.

Bevor Sie die Verbindungen zu den Anschliissen “High”, “Force”, “Guard” und
“Sense” bertihren, schalten Sie das Instrument aus und entladen alle
Kondensatoren des Messwegs. Wenn Sie das Instrument nicht ausschalten,
fuhren Sie, unabhéngig von den Instrumenteinstel lungen, alle folgenden Schritte
durch.

« Beenden Sie die Messung, indem Sie auf die Taste “Stop” driicken. Stellen
Sie sicher, dass die Statusanzeige “Measurement” nicht leuchtet.

« Stellen Sie sicher, dass die Anzeige “High Voltage” nicht leuchtet.
«  Offnen des Interlock-Anschlusses.

« Entladen Sie ale Kondensatoren, wenn die Kapazitdt mit einer SMU
verbunden ist.

Warnen Sie Mitarbeiter in der Umgebung des I nstruments vor den Gefahren.



Danger de choc di a une hautetension

Une tension dangereuse (max. £ pour HV SMU; 3000 Vdc, max. = pour MPSMU,;
100 Vdc) émanant du dispositif Keysight B1506A peut étre sortie aux bornes High,
Force, Guard et Sense. L es précautions suivantes doivent étre obserées contre com-
motion électrique accidentelle.

Utilisez un cable d' alimentation CA atrois conducteurs vers le coupleur secteur
(entrée) et branchez I’ instrument sur une mise électrique alaterre (prise deterre
de sécurité).

Avant de procéder aux mesures, connectez le circuit de sécurité ala borne
Interlock de I’ instrument.

Vérifiez régulierement le bon fonctionnement de la fonction de sécurité.

Avant de toucher les connexions des bornes High, Force, Guard et Sense, mettez
I’instrument hors tension et déchargez tout condensateur du chemin de mesure.
Si vous ne mettez pas |’ instrument hors tension, effectuez « toutes » les
opérations ci-dessous, quels que soient |les paramétres de I’ instrument.

» Terminez les mesures en appuyant sur latouche Stop ; vérifiez que
I"indicateur d' état Measurement est éteint.

» Vérifiez que le témoin High Voltage est éteint.
¢ Quvrez laborne Interlock.

» Déchargez les éventuels condensateurs si la capacité est connectée a une
unité SMU.

Informez les personnes travaillant a proximité de I’ instrument des conditions.
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Prod uct Steward ship

Waste Electrical and Electronic Equipment (WEEE) Directive 2002/96/EC

This product complies with the WEEE Directive (2002/96/EC) marking requirements.
The affixed label indicates that you must not discard this electrical/ electronic
product in domestic household waste.

Product Category: With reference to the equipment types in the WEEE directive
Annex 1, this product is classified as a “Monitoring and Control instrumentation”
product.

Do not dispose in domestic household waste.

To return unwanted products, contact your local Keysight office or visit the following
website for more information.

http://about.keysight.com/en/companyinfo/environment/
LCD Fluorescent Lamp

Certain products sold by Keysight contain a liquid crystal display (LCD); backlighting
for the LCD is provided by a fluorescent lamp which contains mercury, and must be
managed, recycled, and/or disposed in accordance with all applicable laws,
ordinances and regulations.

For information on how to recycle or dispose of the fluorescent lamp contained in
your own product, visit the following website.

http://about.keysight.com/en/quality/env_compliance.shtml

If you live in the U.S., also visit the following websites.
http://www.lamprecycle.org

http://www.eiae.org

If you have additional questions, please visit the following website.
http://www.keysight.com/go/contactus

Perchlorate Information

Perchlorate Material - special handling may apply. Visit the following website.
http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

Equipment's real-time clock battery or coin cell battery may contain perchlorate and
may require special handling when recycled or disposed of in California.



Precautionary Statement

Keysight B1506A Power Device Analyzer for Circuit Design operates in the Microsoft
Windows environment. Keysight B1506A requires Keysight Easy Test Navigator software,
a specially-designed Windows application program.

About guarantee and support for Keysight B1506A

Keysight Technologies guarantees and supports the performance of Keysight B1506A
for the same condition as the preload condition when shipped from the factory.

About updating Keysight Easy Test Navigator and the Windows Update

Keysight Technologies confirms the operation of Easy Test Navigator patch programs
and important Windows security patches, and provides recommended update
information. Visit Keysight B1506A support site, download the patches, and perform
the software update.

About Windows application programs and peripherals (including driver)

Using commercial products on Keysight B1506A is your responsibility. Keysight
Technologies cannot provide compatibility information for commercial products. If
problems arise, perform Keysight B1506A system recovery.

About servicing

Bench repair service is available at your nearest Keysight Technologies service
center. Be aware that the B1506A configuration might be updated to the latest one
without notice because of support issues.

The internal hard disk drive (HDD) might be initialized during servicing. If peripherals
are connected, they will be removed.

When Keysight B1506A is returned, the internal HDD might be initialized. Peripherals
will be returned separately.

Other notes

Back up the internal HDD to prevent loss of data by accident or failure.
Protect Keysight B1506A from computer viruses.

If you connect Keysight B1506A to the network, take care to protect it from
computer virus.



Working in Comfort

To optimize your comfort and productivity, it is important that you set up your work area
correctly and use your instrument properly. With that in mind, we have developed some
set-up and use recommendations for you to follow based on established ergonomic
principles. Improper and prolonged use of keyboards and input devices are among those
tasks that have been associated with repetitive strain injury (RSI) to soft tissues in the
hands and arms. If you experience discomfort or pain while using the instrument,
discontinue use immediately and consult your physician as soon as possible. For more
information on RSI you may wish to consult the About Repetitive Strain Injury section.
Please study the recommendations described below. Included there are references to
relevant parts of international standards, regulations and guidelines, such as I1SO 9241
and the European Community Display Screen Equipment directive. You may also wish to
consult your employer’s human resources department or other relevant departments for
guidance specific to your company.

About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly recommend that
you use the instrument in accordance with established ergonomic principles and
recommendations. Scientific literature suggests that there may be a relationship between
injury to soft tissues -especially in the hands and arms- and prolonged improper use of
keyboards or other equipment requiring repeated motions of the hands and forearms.
This literature also suggests that there are many other risk factors that may increase the
chance of such injury, commonly called Repetitive Strain Injury.

What is RSI?

Repetitive Strain Injury (RSI -also known as cumulative trauma disorder or repetitive
motion injury) is a type of injury where soft tissues in the body, such as muscles, nerves,
or tendons, become irritated or inflamed. RSI has been a reported problem for those who
perform repetitive tasks such as assembly line work, meatpacking, sewing, playing
musical instruments, and computer work. RSI also has been observed in those who
frequently engage in activities such as carpentry, knitting, housework, gardening, tennis,
windsurfing and lifting children.

What causes RSI?

The specific causes of RSI have not been established. Nevertheless, the incidence of RSI
has been associated with a variety of risk factors, including:

Too many uninterrupted repetitions of an activity or motion.

Performing an activity in an awkward or unnatural posture.



Maintaining static posture for prolonged periods.
Failing to take frequent short breaks.
Other environmental and psychosocial factors.

In addition, there have been reports associating the occurrence of RSI with the use of
keyboards, mice, and other input devices. Also, certain medical conditions, such as
rheumatoid arthritis, obesity and diabetes, may predispose some people to this type of
injury.

What if | experience discomfort?

If you are experiencing any discomfort, seek professional medical advice immediately.
Typically, the earlier a problem is diagnosed and treated, the easier it is to resolve.

Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your risk of
discomfort or injury. Observing the following recommendations may reduce that risk.

Try to keep your hand, wrist, and forearm in a neutral position while using your mouse
or other input device.

If you use your thumb to rotate the ball on a trackball or spaceball, keep itin a
relaxed, natural shape, and maintain a neutral posture in your hand, wrist, and
forearm.

Hold the mouse gently by draping your fingers over it. Keep your hand relaxed and
fingers loose. Do not grip the mouse tightly.

It takes very little pressure or force from your fingers to activate the buttons or scroll
wheel on your mouse, scrolling mouse, trackball, or other input device. Using too
much force can place unnecessary stress on the tendons and muscles in your hands,
wrists, and forearms.

If you are using a scrolling mouse, be sure to keep your fingers and hand in a relaxed,
neutral position when activating the scroll wheel. Also, this type of mouse features
software that can minimize the number of mouse movements or button clicks.

When using a mouse, trackball, or other input device, position it as close to the
keyboard as possible, and keep it at the same level as you do not have to stretch while
using it.

Be sure to keep your mouse and trackball clean. Regular removal of accumulated
dust and dirt helps ensure proper tracking and reduces unnecessary hand and wrist
motions.



In This Manual

This manual describes the product overview, installation information, measurement
operation, and software reference information of Keysight Technologies B1506A.

This manual consists of the following chapters:

1. “Introduction”
This chapter describes basic features of Keysight B1506A.
2. “Installation”
This chapter describes installation and maintenance.
3. “How To Perform Measurement”
This chapter explains how to perform measurement by using Keysight B1506A.
4. “GUI Reference”

This chapter provides the reference information of Keysight Easy Test Navigator
software.
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Introduction

This chapter describes the basic functions and features of Keysight B1506A Power
Device Analyzer for Circuit Design, and consists of the following sections.

“Overview”

“Mainframe Front View”
“Mainframe Rear View”
“Test Fixture Front View”

“Test Fixture Rear View”
“Software”
“Accessories’

“Options’

“Measurement Resources’

1-2
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Overview

Overview

Keysight B1506A Power Device Analyzer for Circuit Design is a complete solution
that can help power electronic circuit designers maximize the value of their power
electronics products by enabling them to select the correct power devices for their
applications. It can evaluate all relevant device parameters under a wide range of
operating conditions, including IV parameters such as breakdown voltage and
on-resistance, aswell as three terminal FET capacitances, gate charge and power
loss. The B1506A has awide range of capabilities that help it identify substandard
devices under actual circuit operating conditions, including awide voltage and
current range (3 kV and 1500 A), awide temperature measurement range (- 50 °Cto
+250 °C), fast pulsing capahility, and sub-nA level current measurement capability.
Its unique software interface presents the user with afamiliar device data sheet
format that makesit easy to characterize devices without going through any formal
training. Integrated switching circuitry within the test fixture supports fully
automated testing, with the ability to automatically change between both high
voltage and high current testing as well as between IV and CV measurements. In
addition, a unique plug-in style device test fixture socket adapter eliminates cable
connection and other human-related errors. The B1506A also supports the complete
automation of thermal characterization. This can be accomplished either through the
integrated Thermostream control or viathe Thermal Plate. Sincethe DUT isin close
proximity to the B1506A’s measurement resources, the large parasitics caused by
cable extensions leading to a temperature chamber do not exist. For this reason,
oscillation free ultra-high currents of up to 1500 A can be accurately evaluated at
both low and high temperature.

Keysight B1506A User’s Guide, Edition 2 1-3
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Keysight B1506A provides the following packages.

» B1506A-H21: 20 A/3 kV/C-V/Gate Charge/Thermal Fixture Package
» B1506A-H51: 500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package
» B1506A-H71: 1500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

Each package contains the mainframe, the test fixture, the connection cables, and
the control software. For the furnished accessories, see Table 1-1.

Mainframe

Mainframe is equipped with the measurement resources listed below, the 15-inch
touch screen LCD panel, hard disk drive, DVD drive, USB, LAN, GPIB, GPIO
interfaces, and so on. For more information on the measurement resources, see
“Measurement Resources’ on page 1-26.

» HVSMU, high voltage source/monitor unit, 1 ea.

»  HCSMU, high current source/monitor unit, 1 ea. for the B1506A-H21,
0 ea. for the B1506A-H51/H71

« MCSMU, medium current source/monitor unit, 2 ea. for the B1506A-H21,
4 ea. for the B1506A-H51/H71

« MFCMU, multi frequency capacitance measurement unit, 1 ea.
MPSMU, medium power source/monitor unit, 1 ea.
* GNDU, ground unit, 1 ea.

The B1506A provides an intuitive graphical user interface, touch screen LCD,
stylus pen, USB keyboard, and USB mouse for easy and effective measurement and
analysis on the Windows environment, and supports the following B1506A control
software. For more information, see “ Software” on page 1-20.

» Easy Test Navigator software
» EasyEXPERT software

1-4 Keysight B1506A User’s Guide, Edition 2



NOTE

Introduction
Overview

Test Fixture

The test fixture is required to connect your device under test (DUT). The following
furnished accessories are available.

e Socket module for connecting a 3-pin inline package device
» Universa socket module kit for connecting variety of packaged devices.

» Accessoriesfor connecting other type of device

e Blank silicon plate

» Connection wire

« Clip

« Bananapin adapter
» Socket adapter for performing gate charge measurement
»  Thermocouple for performing temperature measurement

Also, the test fixture initially installs the selector for switching the measurement
resource connected to the collector/drain terminal of the DUT. The measurement
resource will be the MFCMU, the HV SMU, the MPSMU, or the HCSMU for the
B1506A-H21 or the ultra high current unit (UHCU) for the B1506A-H51/H71.

The B1506A-H51/H71 configures the UHCU by using the test fixture and two
MCSMU installed in the mainframe. And the B1506A-H51 supports up to 500 A
and the B1506A-H71 supports up to 1500 A.

Additionally, for controlling temperature of DUT, the test fixture can be equipped
with Thermal Plate inside the fixture cover or Thermostream by using the
B1506A-TO1 Thermal Test Enclosure.

For the Thermal Plate and the Thermostream, contact inTEST Corporation.

Selector may emit a noise sound during operation. However it is hot abnormal
status.
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NOTE

Mainframe Front View

This section describes the front view of the mainframe.

n e e i e e e B,\ _ o N

\

b | S— ) — T

1. Standby switch

Turns on/off the mainframe. Pressing the button in the ON state makesit in the
standby state. The green LED lightswhen it isin the ON state.

Opening measurement terminals

Open the measurement terminals at the device side when turning the B1506A on.
Also disconnect the device from the measurement terminals and open the
measurement terminals after the measurement. If you leave the connection with the
device, the device may be damaged by unexpected operations or charge-up of
measurement cables.

2. HDD accessindicator

This green LED lights in the access status of HDD or DVD drive. Do hot turn
the instrument off during this LED lights.
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LCD adjustment keys

L CD Off enables or disablesthe LCD panel. The green LED lights when the
LCD isdisabled.

Four keys are available for adjusting brightness. Use + and - to adjust it and
then press Set to fix it. Pressing Cancel instead of Set cancels the adjustment.

USB interfaces
USB, 2 ports. For keyboard, mouse, and so on.

To remove USB devices from the instrument, use “ Safely Remove Hardware”
on Windows taskbar. If it is not used, the instrument may cause the internal USB
communication error. If the error occurs, turn the instrument off and disconnect
the power cable from it. Leave it about 30 seconds before rebooting it, and
connect the power cable again, and then turn the instrument on.

LCD panel

15inch TFT XGA display, 1024 x 768 resolution. Displays the Windows screen,
the B1506A control software window, and so on. Touch screen operation is
available when the Touch Panel Off indicator does not light.

To adjust the touch panel, use Microchip TSHARC Control Panel whichis
opened by selecting Microchip TSHARC Control Panel from the Start menu.

Stop key

Stops the present measurement or source output immediately.

High voltage statusindicator

This red LED lights when a source channel applies dangerous voltage.
Measurement status indicator

This green LED lights when a measurement channel performs measurement.
Rotary knob

Works on the execution environment of the B1506A control software. Rotating
the knob moves the marker on the graph, or increases/decreases/changes the
value in the active entry field. Pressing the knob sets or enters the value.

Softkeys

Seven softkeys are available for the B1506A control software. Used to select an
aternative for the entry field specified or the dialog box.

Keysight B1506A User’s Guide, Edition 2 1-7
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11. DVD-R drive

For data backup, software update, and so on. With the option DR1, the driveis
changed to the DVD-ROM drive.

12. Touch Panel Off key

Works on the execution environment of the B1506A control software. Enables
or disables the touch screen operation. The green LED lights when the touch
screen is disabled.

2] - — ity B,\ _ o N

\
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Mainframe Rear View

This section describes the rear view of the mainframe.

To avoid electrical shock and instrument damage, turn the all instruments off
before connecting or disconnecting measurement cable.

Mettez la machine horstension pour fixer le connecteur ou pour retirer le
connecteur del’unité centrale.

There are potentially hazar dous voltages (+ 3000 Vdc for HYSMU and + 100
Vdc for MPSMU) present at the High, Force, Sense, and Guard terminals of
theinstruments. To prevent electrical shock, the following safety precautions
must be observed during the use of instruments.

Connect the instrument to an electrical ground (safety ground) by using
three-conductor AC power cable.

Connect the mainframe Interlock terminal to the test fixture Interlock
terminal by using an interlock cable.

Confirm periodically that the interlock function works normally.

Before touching the connections on the High, High Force, High Sense, and
Guard terminalsin thetest fixture, turn the instruments off and discharge
any capacitors. |f you do not turn the instruments off, complete all of the
following items, regardless of the instrument settings.

* Pressthefront panel stop key to set the source output off.

e Confirm that thefront panel High Voltage indicator isnot lit.

e Openthelnterlock terminal (open the fixture cover).

» Discharge any capacitor s connected to a measurement resour ce.

Warn personsworking around the instruments about dangerous
conditions.

Keysight B1506A User’s Guide, Edition 2 1-9
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B1506A-H51/H71

1. Seria number

You need this serial number when using Keysight Technol ogies telephone
assistance program.

2. LED statusindicator

For troubleshooting. Followings are some examples.

* Both LEDsturn off:
Theinstrument isin the standby state and Standby switch is OFF position.
¢ OnelLED turnsgreen:
Power supply works normally.
e Both LEDsturn orange:
Theinstrument isin the standby state and Standby switch is ON position.
3. LINE input receptacle
AC power cable is connected to this receptacle.
4. GPIB interface

1-10 Keysight B1506A User’s Guide, Edition 2



WARNING

CAUTION

CAUTION

Introduction
Mainframe Rear View

Use an Keysight 82357A USB/GPIB interface or Keysight 10833A/B/C/D
GPIB cable to connect to an external computer or equipment.

5. Video output terminal

VGA connector. For an external display. Signal to the built-in LCD isalso
applied to this terminal.

6. Measurement Resources

See A to F described |ater.

A 7. Circuit Common (‘%) and frame ground ( ,_}_,) terminals

Normally, connect the terminal s together by using the shorting bar. For floating
measurement, remove the shorting bar.

If the Circuit Common terminal is not connected to the frame ground terminal
(for floating measurement), a potential shock hazard may present. Do not
touch any of measurement circuit at any time while a floating measurement is
in progress.

For floating measurement, do not apply dangerous voltage to the Circuit Common
terminal. Failure to heed this caution may result in damage to the instrument.

8. Zero Check terminal

Ground reference point of the instrument.
The Zero Check terminal can be used for the service purpose only. For the normal
operation, leave thisterminal open and do not connect anything to this terminal.
Connecting anything can damage the instrument.
9. GNDU terminal

0V constant voltage source. Used for the reference of measurement ground.
Triaxial connector.

10. LAN interface
RJ45 connector.
11. USB interfaces
USB, 2 ports. For keyboard, mouse, or peripherals.

To remove USB devices from the instrument, use “ Safely Remove Hardware”
on Windows taskbar. If it is not used, the instrument may cause the internal USB
communication error.
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If the error occurs, turn the instrument off and disconnect the power cable from
it. Leave it about 30 seconds before rebooting it, and connect the power cable
again, and then turn the instrument on.

12. Ext Trig terminals

Two BNC connectors, one for trigger input, and one for trigger output. For
details about the trigger function, see Programming Guide.

13. Digita 1/0O terminal
Used to connect the test fixture.
A 14. Interlock termina

Used to connect the test fixture. If the fixture cover is open, maximum output is
limited to +42 V.

To verify the interlock function, perform the Interlock Open/Close test on the
Main Frame tab screen of the EasyEXPERT Configuration window.

WARNING Danger ous voltage, instrument maximum output voltage may appear at High,
Force, Sense, and Guard terminalsif the fixture cover is closed.

B1506A-H21
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GNDU/ADC
Ground unit (GNDU) and A/D converter.
MPSMU

M edium power source/monitor unit (MPSMU) hastwotriaxial connectors, force
and sense, for the Kelvin connections.

MFCMU

Multi frequency capacitance measurement unit (MFCMU) has four coaxial
connectors, Lcur, Lpot, Hpot, and Hcur, for the four-terminal pair connection.

Do not apply voltage more than £25 V to the MFCMU input terminals. Failure to
heed this caution may result in damage to the MFCMU.

/\ D.

ANE

NF

MCSMU

Medium current source/monitor unit (MCSMU) has two triaxial connectors,
force and sense, for the Kelvin connections.

HCSMU for B1506A-H21

High current source/monitor unit (HCSMU) has the force coaxia connector and
the sense triaxial connector, for the Kelvin connections.

HVSMU

High voltage source/monitor unit (HV SMU) has the force connector.

Keysight B1506A User’s Guide, Edition 2 1-13
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Test Fixture Front View

This section describes the front view of the test fixture.

Al.

Measurement terminals

Connects the connection wire or attaches the socket modul e/adapter for
connecting your device under test (DUT). For more information, see
“Measurement Terminals” on page 1-16.

DUT stage

In the above picture, the Blank Silicon Plate is set on the stage, and the Thermal
Plateis placed on the Blank Silicon Plate. For the Thermal Plate, contact
inTEST Corporation.

3. Terminal for connecting wrist strap

Fixture cover

The fixture cover should be closed to avoid electrical shock by touching
measurement terminals and to prevent a device under test from external noise.

When the fixture cover is open, maximum output voltageis limited to £ 42 V.
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Hazar dous voltage, instrument maximum output voltage may appear at the
High, High Force, High Sense, and Guard terminalsif the fixture cover is
closed.

Make surethat the cover is closed properly before starting measurement. Do
not perform the measurement when awireisprotruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la
mesure. Ne pas effectuer la mesurelorsqu’un cable dépasse du couvercle de
I'appareil.

A 5. Thermal Plate connector

This connector is used to connect the cable from the Thermal Plate. For the
Thermal Plate, contact inTEST Corporation.

A 6. Thermocouple terminals

For connecting thermocouple to measure temperature around a DUT.
Temperaturerangeis - 50 °C to 300 °C.

7. Statusindicator
Power LED turns yellow when the AC power is applied to the test fixture.
Power LED turns green when the test fixture is ready to use.
IV LED lights when the B1506A isin the IV measurement condition.
CV LED lights when the B1506A isin the capacitance measurement condition.

A 8. Hazardous voltage status indicator

WARNING

A

This red LED lights when a measurement resource applies dangerous voltage.
Thisindicator is connected to the mainframe via the Interlock terminal and
works with the High Voltage indicator on the mainframe front panel.

Warming labels written in French, German, and Japanese are furnished. Attach
the label to the front panel of the fixture if you need.
Thered light indicatesthat hazardous voltage (maximum + 3000 VVdc) may
appear at measurement terminals. Check thisindicator before accessing.

Letémoin rouge indique qu'une tension dangereuse (+ 3000 V Max) risque
d’apparaitre au niveau des bornes de mesure. Vérifiez cet indicateur avant
d’ accéder.

9. Thermal Plate
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Contact inTEST Corporation.
10. Temperature controller of Thermal Plate

Contact inTEST Corporation.

A M easurement Terminals

WARNING

WARNING

A

CAUTION

NOTE

Set theinstrument output off before connecting or disconnecting connection
wire.

Press the mainframe front panel stop key to set the sour ce output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

Do not connect or disconnect your device under test (DUT) while Keysight
B1506A isapplying voltage or current. Otherwise, the DUT may be damaged.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use gloveand
any tool. Also have enough time for discharge and radiation.

Pour éviter toute électrocution et tout risque d'endommagement del'appareil,
neretirez pas les cables pendant le fonctionnement.

Lorsgue voustouchez le M ST aprésla mesure, élaborez une contre-mesure de
lachargerésiduelle et du chauffage afin d'éviter tout choc électrique et toute

bralure. Utilisez des gants et des outils. Prévoyez également du temps pour la
décharge et laradiation.

Never connect the High, High Force, High Sense, or Guard terminal to any output,
including circuit common and chassis ground. Connecting other output may damage
the connected one.

= A:ﬂase/Gate - AE{;ILe\;:t(;’Ir/Dram % AUX
£100 V = Max 430 V= Max
Force Sense Guard Force Sense

1
5

Force Sense

+100 V= Max
e /\ Emitter/Source

To use the 3-pin Inline Package Socket Module, attach it to the Base/Gate,
Collector/Drain, and Emitter/Source terminals. Then do not use the Guard terminal.
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To use the Gate Charge Socket Adapter, attach it to the Base/Gate, Collector/Drain,
Emitter/Source, and AUX Force terminals. Then do not use the AUX Sense
terminals.

If you do not use the 3-pin Inline Package Socket Module or the Gate Charge Socket
Adapter, connect your device under test (DUT) to the terminals by using connection
wire, clip, adapter, and so on. Then set the Blank Silicon Plate on the DUT stage.

1. Base/Gate High and Low terminals
Connect High to the gate or base terminal of DUT.
Connect Low to the source or emitter terminal of DUT.
2. Collector/Drain High Force and Sense terminals
Connect Force and Sense to the drain or collector terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making
the Kelvin connection.

3. Collector/Drain Guard terminal

Guard of Collector/Drain High. The guard has the same potential as the
Collector/Drain High. You may extend the guard as close as possible to the drain
or collector terminal of DUT to reduce the leakage current caused by the cable.
Open the guard at the end of the cable. Never connect it to anything.

4. Emitter/Source Low Force and Sense terminals
Connect Force and Sense to the source or emitter terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making
the Kelvin connection.

5. Chassis common terminal
Use for grounding or shielding.
6. AUX High Force and Sense terminals and Low Force and Sense terminals

Output terminals internally connected to the AUX input connectors. The
measurement resource isthe SMU3 (MCSMU) installed in the mainframe.

Connect High Force and Sense to the high terminal of DUT.
Connect Low Force and Sense to the low terminal of DUT.

Force and Sense must be connected together at the terminal of DUT for making
the Kelvin connection.
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Test Fixture Rear View

WARNING A To avoid electrical shock and instrument damage, turn the all instruments off
before connecting or disconnecting measurement cable.

Mettez la machine hor stension pour fixer le connecteur ou pour retirer le
connecteur del’unité centrale.

This section describes the rear view of thetest fixture. For connecting the cables, see
“To Connect Test Fixture” on page 2-11.

1. Power switch
Turns on/off the test fixture.
2. LINE input receptacle
AC power cable is connected to this receptacle.
3. Option number label
4. Seria number label

You need this serial number when using Keysight Technol ogies telephone
assistance program.

A 5. Connectors for connecting the system cable
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The following measurement resources in the mainframe are connected by using

the system cable.

e HVSMU

e HCSMU for B1506A-H21
« MCSMU

e MPSMU

« GNDU

A 6. Connectors for connecting the CMU cable

The connectors are used to connect the CMU cable from the MFCMU in the
mainframe.

7. Digital I/O terminal

Thisterminal isused to connect the Digital I/O cable from the mainframe
Digital 1/0 terminal.

A 8. Earthtermina

Screw terminal for earthing.

WARNING

A Connect awirefrom an electrical ground (safety ground) to thisterminal.

Connecter un fil depuisunemisealaterre électrique (misealaterrede
sécurité) alabornedeterre.

A 9. Interlock terminal

Thisterminal is used to connect the interlock cable from the mainframe
Interlock terminal. The interlock cable isincluded in the system cable.

WARNING

Potentially hazar dous voltage may be present at the High, Force, Sense, and
Guard terminalswhen theinterlock terminalsare shorted on test fixture,
prober station, and such.

A 10. Thermal Plate connector

This connector is used to connect the cable from the temperature controller of
the Thermal Plate. For the Thermal Plate, contact inTEST Corporation.
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Software

Keysight B1506A realizes easy and effective measurement and analysis on the
Windows environment using an intuitive graphical user interface, touch screen
LCD, stylus pen, keyboard, and mouse. The following software is previously
installed or stored in the mainframe.

» “Easy Test Navigator Software”
» “EasyEXPERT Software”
o “Utility Software”

Easy Test Navigator Software

The Easy Test Navigator software provides measurement control software for power
device characterization. It supports various types of measurement task with
ease-of-use and simple operation. Some of the functions are listed below. For more
information on the Easy Test Navigator software, see Chapters 3 and 4.

» Software included:

» Datasheet characterization software
e 1/V measurement software

» Capacitance measurement software
» Gate charge measurement software
» Power loss calculation software

e Thermal monitor/control software

» Ready-to-use measurement templates for typical power device characteristics
measurements

» Ability to automatically accumulate measurement data on the HDD in
exportable formats

» Oscilloscope view for a pulsed sweep measurement point
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EasyEXPERT Software

The EasyEXPERT software is an application program for controlling Keysight
B1500 series. Some of the functions are listed below. For more information, see
Keysight EasyEXPERT User’s Guide.

* Single measurement, repeat measurement, and append measurement

* Module selector control

» Measurement/setup data management by workspace

» Graph display and analysis with markers, cursors, and lines; and auto analysis

» Dataimport/export capability, data output by CSV/XML format, and graph
output by EMF/BMP/GIF/PNG format

* Maintenance; self-test and self-calibration

* Remote control function from an external computer

The EasyEXPERT has the following measurement execution environments.
» Application test

* Classic test

» Tracer test

*  Quick test

Application Library

The EasyEXPERT contains an application library that is a set of test definitions. The
application test can be performed by selecting a test definition and setting the test
condition for the actual DUT (device under test).

All test definitions are just sample. If the samples damage your devices, Keysight
Technologiesis NOT LIABLE for the damage.

Utility Software

Followings are the utility software available for the B1506A. For more information
on the utility software, see Keysight EasyEXPERT User’s Guide \ol. 2.

» Desktop EasyEXPERT software
EasyEXPERT software runs on an external Windows PC. Not installed.
»  4155/4156 setup file converter
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Program for converting the 4155/4156 measurement setup files (file extension
MES or DAT) into EasyEXPERT classic test setup files. This program is stored
in the following folder.

<program folder>\Agilent\B1500\EasyEX PERT\415xC\Conversion\
* MDM file converter

Program for converting EasyEXPERT datafiles (file extension XTR or ZTR)
into Keysight IC-CAP MDM files. This program is stored in the following
folder.

<program folder>\Agilent\B1500\EasyEX PERT\I C-CAP Support\M DM\
» Prober control programs

Execution files for controlling the probers listed below. The files are stored in
the following folder.

<program folder>\Agilent\B1500\EasyEX PERT\Utilities\
Probers supported:

» Cascade Microtech Summit 12K or S300

e SUSS MicroTec PA200 or PA300

* Vector Semiconductor VX-2000 or V X-3000
» dleep.exe program

Execution file for inserting await time in the test execution flow of an
EasyEXPERT application test. Thisfile is stored in the following folder.

<program folder>\Agilent\B1500\EasyEX PERT\Utilities\

Notations

<program folder> is as follows. Then, <system drive> isthe drive the B1506A
control software has been installed.

For Windows 7 64 bit version, <system drive>:\Program Files (x86)
For Windows 7 32 bit version, Vista, or XP, <system drive>:\Program Files
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Accessories

Furnished accessories and the avail able accessories for Keysight B1506A are listed

in Tables 1-1 and 1-2.

Furnished Accessories

Description

Quantity

System cable

CMU cable

Digital 1/0 cable

Blank silicon plate

3-pin inline package socket module

Gate charge socket adapter

Universal socket module kit

Thermocouple (high temperature resistant, 75 cm)

Connection wire with mini alligator clip, 200 mm

Connection wire with mini alligator clip, 300 mm

High current connection wire, 200 mm

High current connection wire, 300 mm

Clip for high current connection wire, large alligator

AN/ o|lo|NMRIRP|R|RIRPR|[R]|R

Banana pin adapter for connection wire

Spare clip, mini alligator

USB keyboard

USB mouse

Keysight B1506A User’s Guide, Edition 2
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Description Quantity
Stylus pen 1
Power cable 2
Product Reference CD-ROM 1
Table 1-2 Available Accessories

M odel . L
Number Option Item Description

16444A Accessories for B1500 series

16444A-001 | USB keyboard

16444A-002 USB mouse

16444A-003 | Styluspen

16493G Digital 1/0 connection cable

16493G-001 | 1.5mlength

16493G-002 | 3 mlength

N1300A CMU connection cable

N1300A-001 | 1.5mlength

N1300A-002 | 3mlength
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Options
Options available for Keysight B1506A are listed in Table 1-3.
Table 1-3 Options
Option Item Description

Power Device Analyzer for Circuit Design

B1506A-H21 | 20 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

B1506A-H51 | 500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

B1506A-H71 | 1500 A/3 kV/C-V/Gate Charge/Thermal Fixture Package

Thermal enclosure

B1506A-T01 | Thermal Test Enclosure (Thermostream Compatible)

Cdlibration

B1506A-A6J | ANSI Z540-1-1994 Calibration

B1506A-UK6 | Commercial calibration certificate with test data

Documentation

B1506A-ABA | User's Guide, English

B1506A-ABJ | User's Guide, Japanese

Drive option

B1506A-DR1 | Replace abuilt-in DVD-R drive with aread-only DVD drive
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M easurement Resour ces

Keysight B1506A is equipped with the following measurement resources.
* “GNDU - Ground Unit”
+ “MPSMU - Medium Power SMU”

e “HVSMU - High Voltage SMU”

* “MCSMU - Medium Current SMU”
e “HCSMU - High Current SMU”

» “UHCU - UltraHigh Current Unit”
 “MFCMU - Multi Frequency CMU”

See Keysight EasyEXPERT User’s Guide Vol. 1 for the functions available for the
EasyEXPERT software. See Programming Guide for the functions available for the
GPIB remote mode.

GNDU - Ground Unit

The ground unit (GNDU) isa0 V constant voltage source, and used for the
reference of measurement ground. Also the GNDU can sink upto #4.2 A, soitis
effectivefor using MPSMU or HV SMU. When the HCSMU, MCSMU, or UHCU is
used, the GNDU must be connected to the Low terminal side to apply the reference
zero voltage. Figure 1-1 isasimplified circuit diagram of GNDU.

Simplified GNDU Circuit Diagram

ov
/| GNDU
I | Force

Common
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About SMU

Source/monitor unit (SMU) can apply DC voltage or current, and can measure DC
current or voltage. Figure 1-2 isasimplified SMU circuit diagram.

The MPSMU can perform the following operations:

» Apply voltage and measures current or voltage

» Apply current and measures current or voltage

The HCSMU, MCSMU, and HV SMU can perform the following operations:
» Apply voltage and measures current and/or voltage

* Apply current and measures current and/or voltage

To select the SMU operation mode in the GPIB remote condition, enter the CMM
command.

Simplified SMU Circuit Diagram

SMU
Force

Compliance

The SMU has a compliance feature that limits output voltage or current to prevent
damage to the device under test. When the SMU applies voltage, you can specify
current compliance. When the SMU applies current, you can specify voltage
compliance. For details on the compliance, see Keysight EasyEXPERT User’s
Guide \al. 1.
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MPSMU - Medium Power SMU

This section describes typical specification of the medium power source/monitor
unit (MPSMU).

e Maximum voltage, current, output power: £ 100V, £ 100 mA, 2 W
e Minimumrange: 0.5V, 1 nA

»  Output/measurement value and resolution: see Table 1-4 to Table 1-7.

Figure1-3 MPSMU Output and M easurement Ranges

Current (mA)
A

100

| | | | > Voltage (V)

-100 100

-100
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MPSMU Output Voltage Ranges and Resolutions

R | oupivaie | S| e
05V 0< [V| < 05V 25 Vv + 100 mA
2V 0< [V|< 2V 100 pV + 100 mA
5V 0< [V|< 5V 250 v + 100 mA
20V 0< |V 20V 1mVvV + 100 mA
40V 0< V[ 20V 2mv + 100 mA
20V < V| £ 40V 2mv +50 mA

100V 0< |V 20V 5mv + 100 mA
20V < V| < 40V 5mvV +50 mA

40V < V| £ 100V 5mv +20mA

MPSMU Output Current Ranges and Resolutions
Range Output Value Rzm% n M\?;i[rg;em
1nA 0< |I| £ 115nA 50 fA +100V
10 nA 0< || £ 115nA 500 fA +100V
100 nA 0< |I| £ 115nA 5pA +100V
1pA 0< |I| < 1L15pA 50 pA +100V
10 pA 0< |I| £ 115pA 500 pA +100V
100 LA 0< |I| £ 115uA 5nA +100V
1mA 0< || < 115mA 50 nA +100V
10 mA 0< || £ 115mA 500 nA +100V
100 mA 0< Il < 20mA 5pA +100V
20mA < |I| £ 50 mA 5uA +40V
50mA < [I| < 100 mA 5uA +20V
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Table 1-6 MPSMU M easurement Voltage Values and Resolutions
Range M easur ement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC
05V | 0< |V|]< 055V 25 puV 0.5 uv
2V 0< V| < 22V 100 pV 2 uv
5V 0< V| < 55V 250 pV 5uV
20V 0< V< 22V 1mv 20 uv
40V 0< V| < 44V 2mv 40 pv
100V | 0< V| < 100V 5mV 100 pV
Table 1-7 MPSMU M easurement Current Values and Resolutions
Range M easurement M easurement Resolutions
Value® High Speed ADC | High Resolution ADC

1nA 0< || <115nA 50 fA 10 fA
10nA 0< | £ 115nA 500 fA 10fA

100nA | 0 < |I| < 115nA 5pA 100 fA
1pA | 0< Il £ 1.15pA 50 pA 1pA
10pA | 0 < |I| £ 115pA 500 pA 10 pA

100pA | 0 < |I| £ 115pA 5nA 100 pA
1mA | 0< || £ 1.15mA 50 nA 1nA

10 mA 0< Il £ 115mA 500 nA 10 nA

100mA | 0 < |I| £ 100 mA 5uA 100 nA

a. Thiscolumn is applied to the auto ranging or the limited auto ranging.
For fixed ranging, maximum measurement value is Range column value.
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HVSMU - High Voltage SMU

This section describes typical specification of the high voltage source/monitor unit
(HVSMU).

e Maximum voltage/current: 3000 V/4 mA, - 3000 V/- 4 mA, 1500 V/8 mA, or
- 1500 V/- 8 mA

e Maximum output power: 12 W

e Minimum range: 200V, 1 nA

»  Output/measurement value and resol ution: see Table 1-8 and Table 1-9.
Never connect the HVY SMU Force and Guard terminals to any output, including

circuit common, chassis ground, or any other measurement resource such as SMU.
Connecting other measurement resource may damage the connected one.

HVSMU Output and M easurement Ranges

Current (mA)
A
8
4 .
1
-3000 —15‘00 | > Voltage (V)
: 1500 3000
T-4
-8
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HVSMU Voltage Ranges and Resolutions

Output Value and Setting/ Maximum Current
Range M easurement

M easurement Value . [lmax|

Resolution

200V 0< V] £ 200V 200 pVv 8 mA
500V 0 < V] £ 500V 500 uVv 8 mA
1500V 0 < V] £ 1500V 1.5mv 8 mA
3000V 0 < V| £ 3000V 3mv 4 mA

HVSMU Current Ranges and Resolutions

Range Output Value and Measgjtrigrgzent Maximum Voltage
M easurement Value Resolution [Vmax|
1nA2 0< | £ 115nA 10 fA 3000 V
10 nA 0< | £ 115nA 100 fA 3000 V
100 nA 0< || £ 115nA 100 fA 3000 V
1 pA 0< |I] £ 115pA 1pA 3000 V
10 pA 0< |I| £ 115pA 10 pA 3000 V
100 pA 0< || £ 115uA 100 pA 3000 V
1mA 0< |l £ 1L15mA 1nA 3000 V
10 mA 0< I £ 8mA 10nA 1500V
0< Il £ 4mA 3000 V
a. DConly
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MCSMU - Medium Current SMU

This section describes typical specification of the medium current source/monitor
unit (MCSMU).

e Maximum current: + 1 A (pulse), £ 0.1 A (DC)

e Maximum voltage: £ 30V

*  Maximum output power: 30 W (pulse), 3W (DC)
e Minimum range: 0.2V, 10 pA

e Minimum pulse width: 10 ps

*  Output/measurement value and resol ution: see Table 1-10 and Table 1-11.

Figure 1-5 MCSMU Output and M easurement Ranges
Current (A)

A

Pulse mode only

0.1

30 5 Voltage (V)

-30

-0.1

Pulse mode only
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MCSMU Voltage Ranges and Resolutions

Output Value and Setting/ Maximum Maximum
Range M easur ement PulseBase
M easurement Value : Current
Resolution Value
0.2V 0< |V|< 02V 200 nv 100mA, 1A 2 +0.2V
2V 0< V< 2V 2uVv 2V
20V 0< V< 20V 20 v +20V
0V 0< V[ < 30V 40 puv +30V
a. For pulse.
MCSMU Current Ranges and Resolutions
Output Value and Setting/ Maximum Maximum
Range M easurement PulseBase
M easurement Value ; Voltage
Resolution Value
10 A 0< |I|] < 1A5pA 10 pA +30V + 10 A
100puA | 0 < |I] £ 115pA 100 pA + 100 pA
1 mA 0< Il £ 115mA 1nA +1mA
10mA | 0< I £ 115mA 10nA + 10 mA
100mA | 0 < |I] £ 100mA, 100 nA + 100 mA
0< |l < 115mA?2
1AD 0< Il £ 1A 1uA + 50 mA
a For pulse.

b. For pulse. Maximum pulse width and duty cycle are 100 msand 5 %
respectively.
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This section describes typical specification of the high current source/monitor unit

(HCSMU). The HCSMU is available for the B1506A-H21.

e Maximum current: £ 20 A (pulse), + 1 A (DC)

e Maximum voltage: £ 40V, + 20V only for the pulseover + 1 A

e Maximum output power: 40 W
e Minimum range: 0.2V, 10 pA

e Minimum pulse width: 50 ps

*  Output/measurement value and resolution: see Table 1-12 and Table 1-13.

Do not put any conductor on the HCSMU Low Force and Low Sense terminals,
outer conductor of the coaxial connectors. Putting conductor of circuit common,

chassis ground, or any potential on causes the measurement error.

HCSMU Output and M easurement Ranges

Current (A)
A

20

40 > Voltage (V)

o

-40

RS S —— )
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Table 1-12 HCSMU Voltage Ranges and Resolutions
Range Output Value and Setting/Meas.urement Maximum Maximum Pulse
Measurement Value Resolution Current Base Value
0.2V 0< V| < 02V 200 nVv +20A/+40A +02V
2V 0< V| < 2V 2V +20A/+40A +2V
20V 0< V| 20V 20 pwv +20A/+40A +20V
40V 0< |V|< 40V 40 uv +1A/+2A +40V
Table 1-13 HCSMU Current Ranges and Resolutions
Range Output Value and Setting/M eas.urement Maximum Maximum Pulse
M easurement Value Resolution Voltage Base Value
10 pA 0< || < 115pA 10 pA +40V +10 pA
100pA | 0 < |I| £ 115pA 100 pA +40V + 100 pA
1mA 0< Il £ 1L15mA 1nA +40V +1mA
10 mA 0< |I] £ 125mA 10 nA +40V +10mA
100 mA 0< I £ 115mA 100 nA +40V + 100 mA
1A 0< |I| £ 1L15A% 1pA +40V 1A
20A 0< |l < 20A 20 pA +20V + 100 mA

a. Maximum valueis 1 A for DC output or measurement.
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UHCU - Ultra High Current Unit

This section describes typical specification of the ultra high current unit (UHCU).
The UHCU isavailable for the B1506A-H51/H71.

e Output; voltage pulse or current pulse

» Measurement: current or voltage

e Maximum current: + 500 A (B1506A-H51) or + 1500 A (B1506A-H71)
* Maximum voltage: £ 60 V

*  Maximum power: 7.5 kW for 500 A range, or 22.5 kW for 2000 A range
e Minimum pulse width: 10 ps

*  Maximum pulse duty: 0.4 % for 500 A range, or 0.1 % for 2000 A range

*  Output/measurement value and resolution: see Table 1-14 and Table 1-15.

Figure1-7 UHCU Output and M easurement Ranges

Current (A)
1500}
500

~60 > Voltage (V)
60
- =500
-1500
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Table 1-14 UHCU Voltage Ranges and Resolutions
Range Output Value M easur ement Setting Measurement | Maximum
9 P Value Resolution Resolution Current
100V 0< V| < 60V2 0< V| 60V 200 uv 100 pv + 500 A,
+1500A P
a. Pulse basevalueisawaysO V.
b. Only for the B1506A-H71.
Table 1-15 UHCU Current Ranges and Resolutions
M easur ement Setting Measurement | Maximum
Range Output Value Value Resolution Resolution Voltage
500 A 0< |I|] < 500A2 0< |I] < 500A 1mA 500 pA +63Vv D
2000AC| O0< |I] < 1500A | 0 < [l £ 1500A 4 mA 2mA

a. PulsebasevalueisawaysOA.
b. Thisisthe maximum voltage compliance value.
c. Only for the B1506A-H71. Pulse base valueis always 0 A.
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MFCMU - Multi Frequency CMU

This section describes typical specification of the multi frequency capacitance
measurement unit (CMU). The CMU performs the impedance measurement and
returns the specified measurement data such as Cp-G.

e Measurement parameters: See Table 1-16.
» ACsignal, output frequency:
1kHzto5MHz

Setting resolution: 1 mHz (1 kHz to), 10 mHz (10 kHz to), 0.1 Hz (100 kHz to),
or 1Hz (1 MHzto 5 MH2)

» ACsignal, output level:

10 mVrmsto 250 mVrms, 1 mV resolution
* DChias:

0to £ 25V, using MFCMU internal DC bias

0to £ 3000 V, using HV SMU and high voltage bias-tee
e Measurement range:

For the fixed ranging mode, measurement range (impedance range) must be
specified to perform measurement. Table 1-17 shows the available measurement
ranges and the corresponding impedance value. And Figure 1-8 shows the
calculation example of the impedance vs frequency characteristics of a
capacitive load. Use these information to decide the measurement range.

Impedance Z is calculated by the following formula.
Z=1/(2nfC)
where f isfrequency (Hz) and C is capacitance (F).
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M easurement Parameters

Primary Parameter

Secondary Parameter

R (resistance, Q)

X (reactance, Q)

G (conductance, S)

B (susceptance, S)

Z (impedance, Q)

0 (phase, radian)

Z (impedance, Q)

0 (phase, degree)

Y (admittance, S)

0 (phase, radian)

Y (admittance, S)

0 (phase, degree)

Cp (parallel capacitance, F)

G (conductance, S)

Cp (parallel capacitance, F)

D (dissipation factor)

Cp (parallel capacitance, F)

Q (quality factor)

Cp (parallel capacitance, F)

Rp (parallel resistance, Q)

Cs (series capacitance, F)

Rs (series resistance, Q)

Cs (series capacitance, F)

D (dissipation factor)

Cs (series capacitance, F)

Q (quality factor)

Lp (paralé inductance, H)

G (conductance, S)

Lp (paralé inductance, H)

D (dissipation factor)

Lp (pardlé inductance, H)

Q (quality factor)

Lp (paralé inductance, H)

Rp (parallel resistance, Q)

Ls (seriesinductance, H)

Rs (series resistance, Q)

Ls (seriesinductance, H)

D (dissipation factor)

Ls (seriesinductance, H)

Q (quality factor)
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Table 1-17 Measurement Range for Fixed Ranging Mode
M easurement range (impedance range)
Impedance Z
1kHz< f<200kHz | 200kHz<f<2MHz | 2MHz<f<5MHz
0< Z<100Q 50Q 50Q 500
100Q< Z<300Q 100Q 100 Q 100 Q
300Q< Z2<1kQ 300 Q 300 Q 300 Q
1kQ< Z<3kQ 1kQ 1kQ 1kQ
3kQ< Z<10kQ 3kQ 3kQ 3kQ
10kQ < Z<30kQ 10kQ 10kQ
30kQ < Z <100 kQ 30kQ 30 kQ
100 kQ < Z <300 kQ 100 kQ
300kQ< Z 300 kQ
Figure 1-8 Impedance vs Frequency Characteristics of Capacitive Load, Calculation
Example
10TQ
17Q ] 300 k< range 3 kQ
100 GQ 1] 1
10 6Q R B = AR B o= range
16Q eSS muaRll T ] ]
100 MQ S Rl T T [ 1004F
10 MQ T T T R
IMQ Pl | [Tt | Tl | T ——= 101F
100 kQ T T T \\j ”]10 fE
N 10 ke — -:—-? — | ::—? — e | -:-? -y 10 pF
g 1kQ R &S REE | P
8 ]| 1] L] [T 100 pF
% 100 Q \\.“‘ 3 —\\\.‘ H ——T 1] H — 1nE
2 100 - T A S "
E 10 e s e - 10 nF
100 mQ T S S mRaE S Rl [T 100 0F
10 mQ Tt 1:] ﬁi
1 mQ T T
100 pQ T Tt ] 1000F
10O — L] L Eaa 1 mF
l,L 1 | 1 | —
1 H.Q Wmeec —] | Bmns \\\i 10 mF
100 O 50 Q range iy \5100 mF
10nQ 1F
1 kHz 10 kHz 100 kHz 1 MHz 5 MHz
Frequency f
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Installation

This chapter describes how to install Keysight B1506A.
*  “Requirements’

» “Inspection and Installation”

» “Connecting Accessories’

* “Maintenance”

» “Before Shipping to Service Center”

WARNING A To avoid electrical shock and instrument damage, turn the all instruments off
before connecting or disconnecting measurement cable.

Mettez la machine horstension pour fixer le connecteur ou pour retirer le
connecteur del’unité centrale.

WARNING A Themainframe and the test fixture are heavy and require a two person lift.

Lechassisprincipaleet I'équipement detest sont lourds et nécessitent un levage
par deux personnes.

CAUTION Do not grab the fixture cover when lifting the test fixture.
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A

Installation

There are potentially hazar dous voltages (+ 3000 Vdc for HYSMU and + 100
Vdc for MPSMU) present at the High, Force, Guard, and Sense terminals of

theinstruments. To prevent electrical shock, the following safety precautions
must be observed during the use of instruments.

» Connect theinstrument to an electrical ground (safety ground) by using
three-conductor AC power cable.

» Connect the mainframe Interlock terminal to thetest fixture Interlock
terminal by using an interlock cable.

» Confirm periodically that the interlock function worksnormally.

» Beforetouching the connections on the High, Force, Guard, and Sense
terminalsin thetest fixture or the shielding box, turn theinstruments off
and discharge any capacitors. If you do not turn the instruments off,
complete all of the following items, regar dless of the instrument settings.

e Pressthefront panel stop key to set the source output off.
e Confirm that thefront panel High Voltage indicator isnot lit.

e Openthelnterlock terminal (open thefixture cover or the shielding box
access door).

« Discharge any capacitor s connected to a measurement resource.

» Warn personsworking around the instruments about danger ous
conditions.
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Requirements

This section describes the requirements for the environment this instrument is used.

* “Power Requirements’

*  “Operating Environment”

e “Storaging/Shipping Environment”
» “Instalation Requirements’

*  “Power Cable’

Power Requirements

Thisinstrument can operate from any single-phase AC power source supplying 100/
240V (10 %) at 50/60 Hz. The maximum power consumption is shown below.

e Mainframe: 900 VA
* Test fixture of B1506A-H21: 130 VA
o Test fixture of B1506A-H51/H71: 470 VA

Operating Environment
This instrument must be operated within the following environmental conditions:

Temperature: +5°Cto +40 °C, +5 °C to +30 °C if Thermal plateis used, or
+20 °Cto +30 °C if Thermostreamis used

Humidity: 20 % to 70 % RH or 20 % to 50 % RH if the Thermostream
setting temperatureis +20 °C or below. No condensation.
Altitude: 0to 2,000 m (6,561 ft.)

Soraging/Shipping Environment

This instrument must be stored/shipped within the following environmental
conditions:

Temperature: -20°Cto+60°C
Humidity: 10 % to 90 % RH, no condensation
Altitude: 0to 4,600 m (15,092 ft.)
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Installation Requirements

WARNING A Do not operate theinstrument in dusty environment, or in the presence of
flammable gasses, corrosive gasses, or fumes.

Ne pas utiliser I'appareil dans un endroit poussiéreux, ou en présence de gaz
inflammables, corrosifs ou de fumée.

Environmental conditions for this instrument are documented in the previous
page. In principle, thisinstrument should only be operated indoorsin a
controlled environment.

Install the instrument horizontal place then face the roof up.

The dimensions of thisinstrument are shown below. Fan coolsthe instrument by
drawing air through the sides and exhausting it out the back. The instrument
must be installed in alocation that allows sufficient space at the sides and back
of the instrument for adequate air circulation.

e Mainframe: 420 mm (W) x 575 mm (D) x 330 mm (H)
e Test fixture: 420 mm (W) x 575 mm (D) x 360 mm (H)

If the airflow isrestricted, the internal operating temperature will be higher. This
may reduce the instrument’s reliability, or cause the thermal-protection circuits
to turn the instrument off.

Make sure that there is enough space for connecting/di sconnecting the power
cable easily.
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Power Cable

FIRE HAZARD: Useonly the power cable supplied with your instrument.
Using other types of power cable may cause over heating of the power cable,
resultingin fire.

SHOCK HAZARD: The power cable providesthe chassis ground through a
third conductor. Be sureto connect to a three-conductor type power outlet with
the correct pin grounded.

RISQUE D’INCENDIE : utilisez uniquement le cable d'alimentation four ni
avec votre appareil. L’ utilisation d’autrestypes de cable d’ alimentation peut
provoquer une surchauffe du cable d’alimentation et provoquer un incendie.

RISQUE DE CHOC ELECTRIQUE: le cable d’alimentation fournit la masse
du chassis par lebiaisd’un troisiéme conducteur. Assurez-vous de connecter la
prised'alimentation detypetroisconducteursavec la broche correcte miseala
terre.

The detachable power cable may be used as an emergency disconnecting device.
Removing the power cable will disconnect AC input power to the instrument.

Connect the power cable to the IEC 320 connector on the rear of the instrument. If
the wrong power cable was shipped with your instrument, contact your nearest
Keysight Sales and Support Office.

The AC input on the back of your instrument isauniversal AC input. It accepts
nominal line voltages in the range of 100 to 240 VAC.
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Option 900

7

¢ Plug: BS 1363/A,

Option 901

Plug: AS/INZS 3112,

Option 902

* Plug: IEC 60277-1,

250V, 10A

Option 903

e Plug: NEMA 5-15P,
125V, 10 A

250V, 10 A 250V, 10 A
.« PN 8120-4420 . PN: 81204419 . PN:8121-1226 . PN: 8120-6825
Option 904 Option 906 Option 912 Option 917

Lot
&

e Plug: NEMA 6-15P,
250V, 10A
*  PN: 8120-3996

-

<

e Plug: SEV 1011,
250V, 10A
e PN:8120-4416

e Pug: SB 107-2-D1,
250V, 10A
* PN: 8121-1655

AR
D

¢ Plug: 1S1293 and
1S 6538, 250 V, 10 A
« PN: 8121-1690

Option 918

e Plug: JSC 8303,
125V, 12 A
* PN: 8121-0743

Option 919

e Plug: Isradl SI 32,
250V, 10A
e PN:8121-0724

Option 920

¢ Pug: IRAM 2073,
250V, 10A
e PN: 8121-0725

Option 921

o

o

e Plug: CEl 23-16,
250V, 10A
e PN: 8121-0722

Option 930

Option 922

e Plug: GB 1002
figure 3,250V, 10 A

Option 923

\)\\)
*  Plug: SANS 164-1,
250V, 10 A

Option 927

Plug: NEMA WD-6,
250V, 10 A
«  PN: 8120-0674

+  Plug: NBR 14136,
250V, 10 A
+  PN:8121-1809

* PN: 8121-1635

« PN: 8120-8376 « PN:8121-0564
Option 931 Option 932
¢ Plug: CNS10917-2, «  Plug: CS0017,
125V, 10A 250V, 10 A

» PN: 8121-1638
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Inspection and Installation

I nspection and I nstallation
Do the following when this instrument arrived.
* “To Inspect Shipment”

* “ToPerform Initial Setup”

* “To Connect Test Fixture”

* “To Check Operation of Test Fixture”

Do the following setup if you need.

e “To Change Windows Logon Setting”

e “To Change GPIB Address’

e “To Enable System Controller”

To Inspect Shipment

1. Before unpacking any components, inspect all boxes for any signs of damage
that might have occurred during shipment, such as:

¢ dents
e scratches
e cuts

o water marks
If you suspect any damage, contact Keysight Technologies.

2. When you open the boxes that contain the instrument and accessories, check the
components against the contents lists attached to the boxes.

If anything is missing, contact Keysight Technologies.

After theinspection, move theinstrument and accessories to the installation site. For
the requirements for the installation site, see “Requirements” on page 2-4.
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To Perform Initial Setup

1. Place the mainframe at the installation site.
2. Make sure that the Standby switch is set to off.

3. Ontherear panel, connect the Circuit Common terminal to the frame ground
terminal by using a shorting-bar.

4. |f you usethe furnished USB keyboard and/or USB mouse, connect it to an USB
port of the mainframe.

5. Connect the power cable from the mainframeto an AC power outlet.

6. Open the measurement terminals and press the Standby switch to turn on the
mainframe.

If the mainframe is operating correctly, the power-on self-test is automatically
performed. If problems arise, contact Keysight Technologies.

7. Follow the Windows setup wizard and complete theinitial setup.

a. Set the system display language to English. Thelanguage must be English. If
you set another language, you must perform the system recovery of the
B1506A. See Keysight EasyEXPERT User’s Guide Vol. 2 for the system
recovery.

b. Set Country or region, Time and currency, and Keyboard layout.

If you use the furnished USB keyboard, the Keyboard layout must be US.
c. Accept the End User License Agreement.
d. Set Time zone, date and time,

If the mainframe has been already connected to your site LAN, you can proceed the
network connection setup. If you connect the mainframe to the network, take care to
protect it from computer virus.

Other Windows setup

You can set other setup of Windows after the initial setup. It isyour responsibility.

Keysight Technologies cannot guarantee the performance and provide compatibility
information for all B1506As under several conditions. If problems arise, perform
Keysight B1506A system recovery.

To perform recovery, see Keysight EasyEXPERT User’s Guide \ol. 2.
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Userslisted in Table 2-1 are available just after the initial setup.
Table 2-1 Users Available Just After the I nitial Setup

User Account Description

Keysight B1500 User | Account for automatic logon. Password is not set to this
account.

KeysightOnly Account for Keysight service personnel. Do not delete
this account. This account is password protected.

Administrator Administrator. Password is not set to this account.

You can add users after the initid setup. Add users as you need.
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WARNING

A

Figure 2-1

Installation
Inspection and Installation

To Connect Test Fixture

To avoid electrical shock and instrument damage, turn the all instruments off
before connecting or disconnecting measurement cable.

Mettez la machine horstension pour fixer le connecteur ou pour retirer le
connecteur del’unité centrale.

B1506A Rear View

M
.
1
I
I
.

"
|
G

T
[T
W el

L]
e

CMU cable System cable

Digital 1/0 cable

Connect the system cables between the mainframe and the test fixture as shown in
Figure 2-1.

See Table 2-2 for B1506A-H21.
See Table 2-3 for B1506A-H51 or B1506A-H71.
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Installation
Inspection and Installation

1. Connect the Digital 1/0 cable.

2. Connect the CMU cable.

3. Connect the System cable in order of the label number.
B1506A-H21 System Cable Connections

Test Fixture Label of Cable Mainframe
Digital 1/0 Cable
Digital 1/0 none none Digital 1/0
CMU Cable
MFCMU Lcur (LC) LC Lcur MFCMU
Lpot (LP) LP L pot
Hcur (HC) HC Hcur
Hpot (HP) HP Hpot
System Cable
MPSMU Force (1F) 1F 1F Force SMU1
SMU1
Sense (19) 1S 1S Sense
Gate Force (2F) 2F 2F Force SMU2
Control
SMU?2 Sense (29) 2S 2S Sense
AUX Force (3F) 3F 3F Force SMU3
SMU3
Sense (39) 3S 3s Sense
HCSMU Force (4F) aF aF Force SMU4
SMU4
Sense (49) 4S 4S Sense
HVSMU Force (5F) 5F 5F Force SMU5
SMU5
GNDU GNDU GNDU GNDU
Interlock none none Interlock
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Table 2-3

B1506A-H51/H71 System Cable Connections

Installation

Inspection and Installation

Test Fixture Label of Cable Mainframe
Digital 1/0 Cable
Digital 1/0 none none Digital 1/0
CMU Cable
MFCMU Lcur (LC) LC Lcur MFCMU
Lpot (LP) LP L pot
Hcur (HC) HC Hcur
Hpot (HP) HP Hpot
System Cable
MPSMU Force (1F) 1F 1F Force SMU1
SMU1
Sense (19) 1S 1S Sense
Gate Force (2F) 2F 2F Force SMU2
Control
SMU?2 Sense (29) 2S 2s Sense
AUX Force (3F) 3F 3F Force SMU3
SMU3
Sense (39) 3S 3s Sense
V Control Force (4F) aF aF Force SMU4
SMuU4
Sense (49) 4S 4S Sense
| Control Force (5F) 5F 5F Force SMU5
SMU5
Sense (59) 5S 55 Sense
HVSMU Force (6F) 6F 6F Force SMU6
SMU6
GNDU GNDU GNDU GNDU
Interlock none none Interlock
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To Check Operation of Test Fixture

After completing the cable connections described in “ To Connect Test Fixture” on
page 2-11, perform the following procedure.

Open the measurement terminals of the test fixture and close the fixture cover.
Connect the power cable from the test fixture to an AC power outlet.

Connect the power cable from the mainframeto an AC power outlet.

Set the test fixture power switch to the ON position to turn on the test fixture.
Press the mainframe Standby switch to turn on the mainframe.

After boot up, launch the Capacitance Measurement software.

N o g &~ w NP

Click the Configuration > Module menu to display the Module Configuration
dialog box.

8. Usethe Module Configuration dialog box and perform diagnosis of the selector
installed in the test fixture. If problems arise, contact Keysight Technologies.

To Change Windows L ogon Setting

Windows automatic logon has been enabled initially. If you want to change this
setting, select All Programs > Control Auto Logon from the Start menu. Control
Auto Logon is displayed on the browser. Then click one of the following buttons on
the browser and follow the setup script.

e Enable Auto Logon
» Disable Auto Logon

NOTE If you set a password for the user account Keysight B1500 User, disable the
automatic logon.
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To Change GPIB Address

When this instrument is shipped from the factory, the GPIB addressis set to 17. To
change the GPIB address, perform the following procedure.

1

If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.
b. Click [x] at the upper right corner of the Start EasyEXPERT button.

Select All Programs > Keysight 10 Libraries Suite > Keysight Connection
Expert from the Start menu. Keysight Connection Expert window appears.

At the Instrument 1/0O on this PC area, select GPIBO, and click the Change
Properties... button. Keysight 82350 PCI GPIB Interface - GPIBO window

appears.
Change the GPIB Address value.

Remove the check from the Auto-discover instruments connected to this
interface box.

Click the OK button on Keysight 82350 PCI GPIB Interface - GPIBO window.

On the Reboot Required dialog box, click the Reboot Now button, and reboot
the mainframe.
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To Enable System Controller

To allow thisinstrument to control external GPIB devices, perform the following
procedure. After the procedure, you cannot control the instrument from an external
computer.

1

If the EasyEXPERT software is running, terminate it as shown below:

a. Select the menu function File > Exit on the EasyEXPERT main screen.
b. Click [x] at the upper right corner of the Start EasyEXPERT button.

Select All Programs > Keysight 10 Libraries Suite > Keysight Connection
Expert from the Start menu. Keysight Connection Expert window appears.

At the Instrument 1/0O on this PC area, select GPIBO, and click the Change
Properties... button. Keysight 82350 PCI GPIB Interface - GPIBO window

appears.

Set the GPIB Address value to 21 that isthe typical address number for the
system controller.

Check the System Controller box.

Remove the check from the Auto-discover instruments connected to this
interface box.

This disables the automatic device detection. So the Connection Expert cannot
detect the instruments connected to the GPIB interface by itself.

Click the OK button on Keysight 82350 PCI GPIB Interface - GPIBO window.

On the Reboot Required dialog box, click the Reboot Now button, and reboot
the mainframe.

To Disable System Controller

To disable the system controller, change the steps 4 and 5 for setting the GPIB
Address value to not 21 and removing the check from the System Controller box,
and perform the procedure to the step 8.
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Connecting Accessories

The test fixture is used to connect your device under test (DUT). The B1506A is
furnished with the following accessories.

» “3-pin Inline Package Socket Module”
* “Universal Socket Module Kit”

» “Gate Charge Socket Adapter”

» “Accessoriesfor Connecting aDUT”

» “Thermocouple”

Also, the following equipment can be used with the B1506A for controlling
temperature of DUT. Contact inTEST Corporation for the equipment.

e  “Thermal Plate’

e “Thermostream”

Set theinstrument output off before connecting or disconnecting connection
wire.

Press the mainframe front panel stop key to set the source output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

To prevent electrical shock and DUT damage, do not connect or disconnect the
DUT whiletheinstrument isapplying voltage or current.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use glove and
any tool. Also have enough time for discharge and radiation.

Pour éviter toute électrocution et tout risque d'endommagement de|'appareil,
neretirez pasles cables pendant le fonctionnement.

L orsque vous touchez le M ST apreésla mesure, élaborez une contre-mesure de
lachargerésiduelle et du chauffage afin d'éviter tout choc électrique et toute

brdlure. Utilisez des gants et des outils. Prévoyez également du temps pour la

décharge et laradiation.
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/\ 3-pin Inline Package Socket Module

Use the socket module to connect athree-terminal inline packaged device. See the

following simple instruction.

¢ 3-pininline package socket module

e DUT

1. Attach the socket module directly to the Base/Gate, Collector/Drain, and
Emitter/Source terminals of the test fixture.

2. Set your DUT on the socket.

3. Closethe fixture cover and perform measurement.

DUT

Socket module

Hazar dous voltage, instrument maximum output voltage may appear at the
measurement terminalsif the fixture cover is closed.

Open the Guard terminal of the test fixture. Do not connect anything toit.
Use the socket module within the temperature range of 0 °C to +100 °C.

Short plate is furnished with the socket module. It is used for performing the short
correction before the capacitance measurement. Set it on the socket before the short
correction and remove it after the correction.
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A Universal Socket Module Kit

Thisisablank module, kind of ado-it-yourself kit for supporting variety of
packaged devices. Using this module kit, you can make one of the following socket
modules.

e Curve Tracer Test Adapter Socket Module

This is a handmade socket modul e available for connecting a test adapter
designed for connecting to Tektronix 370B/371B curve tracers. For how to make
this, see “Making the Curve Tracer Test Adapter Socket Module”.

» Universa Socket Module

This is a handmade socket module available for connecting your test devices.
For how to make this, see “Making the Universal Socket Module”. You need to
prepare a socket capable of dealing with your device package separately.

The contents of this kit are shown in Figure 2-2 and Table 2-4.
You can use their handmade socket modules with the same manner as the 3-pin
Inline Package Socket Module. See “3-pin Inline Package Socket Module”.

Figure 2-2 Universal Socket ModuleKit
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Parts of Universal Socket ModuleKit

No. Parts Description Qty
1 Blank Module Base of the socket module lea
2 Dummy Board Thisis pre-assembled to the blank lea

module. You can aso make a socket
board using this board, instead of a new

blank board.
3 Curve Tracer Test Thisisasocket board that isattachedto | 1 ea
Adapter Socket Board | the blank module. This has a socket for
connecting atest adapter designed for
connecting Tektronix 370B/371B curve
tracers.
4 Wire For internal connections 2m
5 Lug Terminal For internal connections 20 ea
6 Wire for High Current | For internal connections 2m
7 Lug Terminal for For internal connections 6 ea

High Current

Making the Curve Tracer Test Adapter Socket Module

T10 Torx screwdriver

T15 Torx screwdriver

7 mmwrench, 2 ea

9 mm wrench

Caulking tool for lug terminals, 2.0sg

Caulking tool for high current lug terminals, 5.55q

Remove the dummy board from the blank module using a T15 Torx screwdriver.

Fix the curve tracer test adapter socket board to the blank module using the
screws and tooth washers you kept when removing the dummy board.

Remove the bottom cover of the blank module using a T10 Torx screwdriver.

Assemble cables using the wire and lug terminals.
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Cut the appropriate length of the wire, tear off the coating of wire ends, and then

secure the lug terminals to the wire ends using a caulking tool.

Assemble the necessary cables with referring to the figure below.

WARNING

terminals of the Collector/Drain and Emitter/Source.

|@|Emitter/80urce

Blank Module
(Wiring side view)

e \\/ire

-0 0

00

Sense Force

HeYeo

Sense

Force || G

O

uard Sense

O

When the measurement uses higher range than 500A range, use thewire for
high current and lug terminalsfor high current for connecting the Force

AUX

Collector/Drain

Base/Gate

I : \Vire for High Current

Collector/
Drain Force

C Base/Gate Force

Emitter/Source Force

Curve Tracer Test Adapter
Socket Board
(Wiring side view)

Collector/Drain Sense ¢

Base/Gate Sense O
Emitter/Source Sense C

5. Connect one ends of all cables to the inside terminals on the blank module.

Remove screws and tooth washers from the terminals, and fix the lug terminal of
the cable end in order of awasher, alug terminal, a tooth washer, and a screw.
When fixing the lug terminal, secure a screw by a T15 Torx screwdriver with
fixing the bottom nut by a 9 mm wrench.

There is no sense terminal for the Base/Gate lines from the test fixture.

Connect the other ends of the cables to the terminals on the back side of the
socket board.

Remove nuts and tooth washers from the terminals, and fix the lug terminal of
the cable end in order of alug terminal, a tooth washer, and a nut. When fixing
the lug terminal, secure the top nut by a 7 mm wrench with fixing the bottom nut
by another 7 mm wrench.
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7.

Ensure the terminal position of the blank module and the socket board, and
connect the cables correctly.

Connect the Base/Gate Low terminal of the blank module to the Emitter/Source
Sense terminal on the back side of the socket board.

Fix the bottom cover to the blank module using a T10 Torx screwdriver.

Making the Universal Socket M odule

T10 Torx screwdriver

T15 Torx screwdriver

9 mm wrench

Caulking tool for lug terminals, 2.0sg

Caulking tool for high current lug terminals, 5.55q

Prepare a socket for your test devices, a blank board, tools for mounting the socket,
screws and nut for socket terminals, and so on separately.

For the dimensions and screw holes of a blank board, see Figure 2-3.

Dimensions and Screw Holes of Blank Board

100

Thickness: 1.5 mm

o @ @ @ ©

90

?3.4

75 55 55 55 7.5

180
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Remove the dummy board from the blank module using a T15 Torx screwdriver.

Make a socket board by process a blank board or the dummy board and mount
your device socket onto the board.

Make enough space between the socket terminal and the shield/chassis, for
example, about 1 mm for maximum 200 V output and 6 mm for 3000V, to
prevent discharge and any accident.

3.

Fix the socket board to the blank module using the screws and tooth washersyou
kept when removing the dummy board.

Remove the bottom cover of the blank module using a T10 Torx screwdriver.
Assemble cables using the wire and lug terminals.

Cut the appropriate length of the wire, tear off the coating of wire ends, and then
secure the lug terminals to the wire ends using a caulking tool.

When the measurement uses higher range than 500A range, use thewire for
high current and lug terminalsfor high current for connecting the Force
terminals of the Collector/Drain and Emitter/Source.

6. Connect one ends of all cables to the inside terminals on the blank module.

Remove screws and tooth washers from the terminals, and fix the lug terminal of
the cable end in order of awasher, alug terminal, atooth washer, and a screw.
When fixing the lug terminal, secure a screw by a T15 Torx screwdriver with
fixing the bottom nut by a 9 mm wrench.

The following shows the positions of the inside terminals in the blank module.

Emitter/Source
Sense Force

e |"O 0010 OO~
+Q O/0 O OO~

Sense Force || Guard Sense Force

AUX Collector/Drain  Base/Gate

7. Connect the other ends of the cables to the terminals on the back side of the

socket board.
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If a socket terminal does not have a screw or nut for securing alug terminal of
the cable, prepare it. Ensure the terminal position of the blank module and the
socket board, and connect the cables correctly.

8. Fix the bottom cover to the blank module using a T10 Torx screwdriver.
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/\ Gate Charge Socket Adapter

This socket adapter is designed for performing the gate charge measurement. The
adapter supports 3-pin inline package device and other type of device.

e “Connecting 3-pin Inline Package Device’

e “Connecting Other Type of Device”

Connecting 3-pin Inline Package Device

» Gate charge socket adapter and Shorting bar (furnished with the adapter)
» DUT (3-pin inline package device)
*  Current control device or Load resistor

The current control device must be an extra 3-pin inline package device which is
expected to have the same characteristics as DUT. If the device is not available, use
aload resistor. The resistor must satisfy the following specifications.

Resistance = Vr/Ir (Vr: rated voltage, Ir: rated current)

Peak power > Vr x Ir x 1 ms

= Slide switch

Socket for (Inline Package position)

current Socket for DUT

control — _

device — Shorting bar

o

Studs for e
load resistor [ 1 [T [_]

1. Attach the socket adapter directly to the Base/Gate, Collector/Drain,
Emitter/Source, and AUX Force terminals of the test fixture.

2. Attach the shorting bar to the Sense terminals on the side panel.
3. Set the dlide switch to the Inline Package position.

4, Set the current control device on the left socket or connect the load resistor
between the studs for the resistor.

5. Set your DUT on the right socket.

6. Closethe fixture cover and perform measurement.
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Hazar dous voltage, instrument maximum output voltage may appear at the
measurement terminalsif the fixture cover isclosed.

Open the AUX Sense terminals of the test fixture. Do not connect anything to them.

Short plate is furnished with the adapter. It is used for performing the short
correction before the gate charge measurement. Set it on “ Socket for DUT” before
the short correction and remove it after the correction.

Connecting Other Type of Device

» Gate charge socket adapter
» Blank silicon plate
» Connection wire, clip, adapter, and so on. Use the furnished accessories.

Banana pin to Large aligator clip wire can be assembled by fixing a banana pin
adapter and a clip to a connection wire using a screw and a nut.

» DUT (other than 3-pin inline package device)
e Current control device or Load resistor

The current control device must be an extra 3-pin inline package device which is
expected to have the same characteristics as DUT. If the device is not available, use
aload resistor. The resistor must satisfy the following specifications.

Resistance = Vr/Ir (Vr: rated voltage, Ir: rated current)

Peak power > Vr x Ir x 1 ms

Socket for rﬁw F@W V‘@W F@W V‘@W Slide switch
current B (External DUT position)
control
device | [ | [—=] | r=c20 - — — — — — _ _
External DUT
Emitter  Collector
Studs for

load resistor (B R N B

Low IEH KM High

Space for External DUT on the silicon plate:

|
|
|
|
|
| Base
|
|
|
180 mm x 180 mm —>
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WARNING
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NOTE

NOTE

Installation
Connecting Accessories

1. Set the blank silicon plate on the DUT stage of the test fixture.

2. Attach the socket adapter directly to the Base/Gate, Collector/Drain,
Emitter/Source, and AUX Force terminals of the test fixture.

3. Remove the shorting bar from the Sense terminals if it is attached.
4. Set the dlide switch to the External DUT position.

5. Set the current control device on the left socket or connect the load resistor
between the studs for the resistor.

6. Put your DUT on the space for the external DUT. The device size should be
smaller than approximately 170 mm (W) x 170 mm (D) x 130 mm (H).

7. Connect your DUT to the side panel terminals by using connection wire, clip,
adapter, and so on.

Force and Sense must be connected together at the terminal of DUT for making
the Kelvin connection.

8. Close the fixture cover and perform measurement.

External DUT

Emitter  Collector

K K3 RE

Base
Low IFM WA High

.
Gate Low is internally
connected to Emitter/Source Sense.

Hazar dous voltage, instrument maximum output voltage may appear at the
measurement terminalsif the fixture cover isclosed.

Base Low is internally
connected to Emitter.

Make surethat the cover is closed properly before starting measurement. Do
not perform the measurement when awireis protruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la
mesure. Ne pas effectuer la mesure lorsqu’un cable dépasse du couvercle de
['appareil.

Open the AUX Sense terminals of the test fixture. Do not connect anything to them.

Open/short correction should be performed before the gate charge measurement.
Open between the Gate/Base terminal and the Emitter/Source terminal for the open
correction and short them for the short correction at the end of the extension cables.
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Accessoriesfor Connectinga DUT

Use the connection wire, clip, adapter, and so on to connect a device that cannot be
connected to any socket modul e or adapter.

Test fixture
Cable assembly —

Thermocouple

Thermal plate

—— T Blank silicon plate

In the above picture, the blank silicon plateis set on the DUT stage, and the Thermal
Plate is placed on the plate and connected to the Thermal Plate connector. Also, the
thermocoupl es are connected to the K Thermocoupl e terminals and put on the places
to monitor temperature. For the Thermal Plate, contact inTEST Corporation.

¢ Blank silicon plate

¢ Connection wire, clip, adapter, and so on. Use the furnished accessories.

Banana pin to Large alligator clip wire can be assembled by fixing a banana pin
adapter and a clip to a connection wire using a screw and a nut.

¢ DUT (other than 3-pin inline package device)

1. Set the blank silicon plate on the DUT stage of the test fixture.

2. Put your DUT on the blank silicon plate. The device size should be smaller than
approximately 330 mm (W) x 170 mm (D) x 130 mm (H).

3. Connect your DUT to the measurement terminals of the test fixture by using
connection wire, clip, adapter, and so on.

Force and Sense must be connected together at the terminal of DUT for making
the Kelvin connection.

External DUT

aaaaaaaaaaaaa
Emitter  Collector

Base

Low IFE P High

Base Low is internally
connected to Emitter.
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Installation
Connecting Accessories

4. Closethe fixture cover and perform measurement.

Hazar dous voltage, instrument maximum output voltage may appear at the
measurement terminalsif the fixture cover isclosed.

Toreduce theleakage current of the extension cable, the Guard terminal may
be extended as close as possible to the drain or collector terminal of DUT.

Then, open the Guard terminal at the end of the extension cable to avoid
electrical shock, instrument damage, or DUT damage. Do not connect anything
to thisterminal which hasthe same potential asthe High Force and High Sense.

Make surethat the cover is closed properly before starting measurement. Do
not perform the measurement when awireis protruding from the fixture cover.

Assurez-vous que le couvercle est fermé correctement avant de commencer la
mesure. Ne pas effectuer la mesurelorsqu’un cable dépasse du couvercle de
['appareil.

Never connect the High, High Force, High Sense, or Guard terminal to any output,
including circuit common and chassis ground. Connecting other output may damage
the connected one.
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Thermocouple

Use thermocouple to monitor temperature. The B1506A is furnished with two
thermocouples. For the setup image, see the previous page.

1
2.

Connect the thermocoupl e to the K Thermocouple terminal.

Fix the end of the thermocouple to the place to monitor temperature.

Thermal Plate

The test fixture can be equipped with the Thermal Plate for controlling temperature
of DUT. For the setup image, see the previous page.

1
2.
3.

8.

Set the blank silicon plate on the DUT stage of the test fixture.
Place the Thermal Plate on the silicon plate.

Connect the cable from the Thermal Plate to the Thermal Plate connector on the
test fixture.

Put your DUT on the Thermal Plate. The device size should be smaller than
approximately 160 mm (W) x 160 mm (D) x 100 mm (H).

Connect your DUT as described in “ Accessories for Connecting aDUT” on
page 2-28. Or see “ Connecting Other Type of Device” on page 2-26 for
performing the gate charge measurement.

Set the thermocoupleif it is used. See “Thermocouple” on page 2-30.

Connect the cable from the temperature controller to the Thermal Plate
connector on the test fixture rear panel.

Close the fixture cover and perform measurement.

For the Thermal Plate, contact inTEST Corporation.

/\ Thermostream

The test fixture can be equipped with the Thermostream for controlling temperature
of DUT. For the setup image, see the following figure.
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The B1506A-T01 thermal test enclosure is needed to set the Thermostream on the
test fixture.

Fixture cover

Enclosure cover

Left side wire——» 3" i< Right side wire

<~— Interlock switch
under the wire head

Interlock switch ——
under the wire head

Thermal test enclosure Test fixture

1. Attach the thermal test enclosure directly to the Base/Gate, Collector/Drain,
Emitter/Source, and AUX Force terminals of the test fixture.

2. Unscrew and remove the enclosure cover.

3. Put your DUT in the enclosure. The device size should be smaller than
approximately 220 mm (W) x 180 mm (D) x 120 mm (H).

If you use the 3-pin inline package socket module, attach it directly to the
Base/Gate, Collector/Drain, and Emitter/Source terminals in the enclosure.

4. Connect your DUT as described in “ Accessories for Connecting aDUT” on
page 2-28. Then use the measurement terminals in the enclosure.

If you use the 3-pin inline package socket module, set your DUT on the socket.
5. Set the thermocouple if it is used. See “ Thermocouple” on page 2-30.

6. Set and fix the enclosure cover by screws so that the openings are not made
between the enclosure body and the cover especially around the slit labeled
“Thermocouple”.

If you use the thermocouple, passit through the dlit. If two thermocouples are
used, adjust them so that they do not overlap together.

7. Set the Thermostream on the enclosure cover.

Adjust the nozzle of the Thermostream so that it fits the cover horizontally and
so that the openings are not made between them.

Keysight B1506A User’s Guide, Edition 2 2-31



WARNING

WARNING

WARNING

CAUTION

CAUTION

WARNING

Installation
Connecting Accessories

Connect the purge air tube from the Thermostream to the Purge air inlet at the
enclosure side back.

8. Settheleft sidewire head inthedlit of thetest fixture interlock switch and ram it
down.

9. Settheright sidewire head in the dlit of the test fixture interlock switch and ram
it down.

10. Leave the fixture cover open and perform measurement.

For the Thermostream, contact inTEST Corporation.

Activating the Ther mostream may cause low or high temperature of - 50 °C to
+250 °C on the enclosure front panel, the cover, and the left and right
protection panels. To prevent yourself from getting injury, confirm that they
arein the safe temperature range before touching the enclosure.

L'activation du flux thermique peut entrainer une basse ou haute température
de- 50 °C a +250 °C sur le panneau de protection avant, le couvercle et les
panneaux de protection a gauche et a droite. Pour éviter de vous blesser,
confirmez qu'ils sont dansla plage detempérature de sécurité avant detoucher
leboitier.

While the enclosure wire heads (To Slit) arerammed down into the dlits of the
test fixtureinterlock switches, hazar dousvoltage, instrument maximum output
voltage may appear at the measurement terminals.

Pendant que lestétesdefil d'enceinte (a fente) sont enfoncés danslesfentesdes
commutateursd'interverrouillage de mélange d'essai, une tension dangereuse,
unetension de sortie maximale d'instrument peut appar aitre aux bor nes de
mesure.

Open the Guard terminal of the test fixture. Do not connect anything toit.

Do not expose the back of the enclosure to the condensation. Wetting the connection
cables or connectors may cause the instrument damage.

If you use the 3-pin inline package socket module, do not set the Thermostream
temperature below 0 °C or over +100 °C. Or €else, the socket module may be
damaged.

Purge air inlet
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To prevent condensation, connect the Thermaostream purge air tube here.
Purgez I'admission d'air

Pour empécher toute formation de condensation, connectez le tube de purge d'air
Thermostreamici.
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Installation
Maintenance

M aintenance

Maintenance should be performed periodically to keep the instrument in good
condition.

Cleaning

Before performing cleaning, turn off the instrument, and disconnect power cable
from the rear panel. Use a dry cloth to clean the external case parts.

To prevent electrical shock, do not perform cleaning when the instrument is turned
on, and do not use awet cloth.

Self-test and Diagnosis

This instrument provides the following functions to check the operation. Perform
the following functions as necessary. Open the measurement terminal s to perform
self-test, self-calibration, or diagnosis.

o Self-test
» Sdf-calibration
» Diagnosis

If problems arise, contact Keysight Technologies.

Interlock Open/Close test and High Voltage LED test

Interlock function limits the maximum output voltageto + 42 VV when the
measurement terminal istouchable. For safety, this function must be checked before
using the instrument after power on at least once a day by performing the diagnosis.

Calibration

Calibration and adjustments must be performed periodically so that the instruments
satisfy the specifications, and keep a good condition. It is recommended to perform
the calibration once ayear at least. For the calibration and adjustments, contact
Keysight Technologies. Trained service personnel will perform the calibration and
adjustments.
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Before Shipping to Service Center

Before shipping this instrument to service center, you have to do following:

* “ToMake Backup”
* “To Check Module Slots’

» “To Collect Equipment and Accessories’

To Make Backup

If theinternal hard disk drive (HDD) isfailed, you will lose al data stored in the
HDD. So it isimportant to make backup constantly.

Before shipping the instrument to the service center, make backup of datain the
HDD. And keep the backup mediain trust. You may need to perform data recovery
of the instrument returned from the service center.

If the HDD isreplaced, theinstrument will be returned with the latest revision of the
software.

To Check Module Slots

Do not remove the plug-in module from the mainframe. The instrument must be
shipped with al modules. The module cannot be repaired or calibrated without the
mainframe.

If amodule is removed and installed, the specifications are not guaranteed. The
specifications are guaranteed after the calibration is performed at Keysight
Technol ogies service center.

To Collect Equipment and Accessories

The mainframe, test fixture, and all connection cables are required for servicing and
must be shipped to the service center. For details, contact the service center.

To prevent electrical shock, turn off theinstrument and remove the power
cable before removing the connection cables.

Mettez la machine horstension pour fixer le connecteur ou pour retirer le
connecteur del’unité centrale.
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How To Perform Measurement

This chapter describes how to measure the power devices by using Keysight
B1506A and Keysight Easy Test Navigator Software, and consists of the following
sections:

How To Perform Datasheet Characterization

This section describes how to perform the measurement using the datasheet
characterization software.

How To Perform |/V Measurement

This section describes how to perform the measurement using the I/V
measurement software.

How To Perform Capacitance M easurement

This section describes how to perform the measurement using the capacitance
measurement software.

How To Perform Gate Charge M easurement

This section describes how to perform the measurement using the gate charge
measurement software.

How To Calcul ate Power Loss

This section describes how to cal cul ate the power loss using the power 1oss
calculation software.

How To Monitor/Control Temperature Under M easurement

This section describes how to monitor/control the temperature using the thermal
monitor/control software.
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How To Perform Datasheet Char acterization

This section describes how to perform measurement on device parameters and
characteristics using the datasheet characterization software.

The datasheet characterization software provides a simple operation environment in
afamiliar datasheet-like format that can specify measurement items and
measurement conditions, perform measurement, and displays measurement results.

This section consists of the following sections:

» Preparing M easurement

» Executing Measurement

Figure 3-1

Datasheet Char acterization Software

I Data Sheet

B

ks o@D

~ Identification Device Type: ~[al

Part Number:

Sample ID:

Description:

Operator:

Measurement Instrument:

A Maximum Ratings

Symbol Parameter
VDSS Drain to Source Voltage
VGSS Gate to Source Voltage Conitnuous
DM Pulsed Drain Current Te=25 °C
1sM Pulsed Body Diode Current Tc=25 °C

~ | Characteristics Parameters

Parameter

Symbol

Drain to Source Breakdown Volt--
Drain Leakage Current

Gate Leakage Current

Gate Leakage Current ()

Gate to Source Threshold Volta--
Gate to Source Threshold Volta--
Drain to Source On Resistance
Drain to Source On VD‘IEQE
Body Diode Forward Voltage
Gate Resistance

Input Capacitance

Output Capacitance

Reverse Transfer Capacitance

Total Gate Charae
~ ) Automatic Data Save Device ID: Devica-1

File Edit View Measurement Setup Configuration H

~ Comment:

elp

JEs = x

Maximum Ratings

Test Conditions

Tj=25°C to 150 °C

Characteristics Parameters

Test Conditions
VGS=0 V, ID=1 mA
VDS=100 V, VGS=0 V
VGS=20 V, VDS=0 V
VGS=-20V, VDS=0 V
ID=1 mA
VDS=10 V, ID=1 mA
VGS=15 V, ID=50 A, PulseWidth=200 ps
VGS=15V, ID=50 A, PulseWidth=200 ps
VGS=0 V, I5=50 A, PulseWidth=200 ps
VGS=0 V, f=100 kHz
VGS=0 V, VDS=30 V, f=100 kHz
VGS=0 V, VDS=30 V, f=100 kHz

VGS=0 V, ¥DS=30 V, f=100 kHz

MASMAMI=15 V Unslaffi=0 v Vrs=30 W TH=
[ pata: [ X | gal| MoSFET-Sample.pda-ds.zip

o o
M=
=
Value Unit Note
v
v
A
A
Min. Act. Max.  Unit Note
100 135 X
359 p op A
350 p 200 n A
-200n  -350p A
2 36 4 v
2 3.44 4 v
7.02m 15m ©ohm
266m 800m v
864 m 2 [
400 m 1 ohm
18.2n 30n E
29n 5n F
900 p in F
Tarm 111 MG o |
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How To Perform Datasheet Characterization

Preparing M easur ement

Set theinstrument output off before connecting or disconnecting connection
wire.

Press the mainframe front panel Sop key to set the source output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

To prevent electrical shock and DUT damage, do not connect or disconnect the
DUT whiletheinstrument isapplying voltage or current.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use glove and
any tool. Also have enough time for discharge and radiation.

Prepare the test fixture and accessories to connect your device under test (DUT).

For more information on the test fixture and its accessories, see the following
sections:

» “To Connect Test Fixture” on page 2-11

» “3-pin Inline Package Socket Module”’ on page 2-18
e “Universal Socket Module Kit” on page 2-19

» “Gate Charge Socket Adapter” on page 2-25

» “Accessoriesfor Connecting aDUT” on page 2-28
Connect the test fixture and other accessories.

For more information, see “ To Connect Test Fixture” on page 2-11

If you would like to monitor/control temperature during measurement, perform the
required connection and operation. See “How To Monitor/Control Temperature
Under Measurement” on page 51.

Turn the instrument on.

Measure the calibration data for capacitance measurement.

The capacitance measurement software keeps the last measured calibration data. If
the connection for the capacitance measurement is same as when the last calibration
data was measured, this step can be skipped.
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1. Connect the 3-pininline package socket module or other accessories to the test
fixture. Don’'t connect DUT at thistime.

2. Onthe software palette, click Capacitance M easurement icon%. The
Capacitance Measurement software (Figure 3-3) opens.

3. Click Start Calibration... button on the toolbar to measure the calibration data.
Follow the instruction on the dial og and measure the open and short calibration data.

Measure the calibration data for gate charge measurement.

The gate charge measurement software keeps the last measured calibration data. If
the connection for the gate charge measurement is same as when the last calibration
data was measured, this step can be skipped.

1. Connect the gate charge socket adapter or other accessories to the test fixture.
Don’t connect DUT at thistime.

2. On the software palette, click Gate Charge Measurement icon 2 . The Gate
Charge Measurement software (Figure 3-4) opens.

3. Click Start Cdlibration... button on the toolbar to measure the calibration data.

Follow the instruction on the dial og and measure the open and short calibration data.

Executing M easurement

Perform the measurement as the following steps:

The following steps show the measurement example that uses the MOSFET as
DUT.

On the software palette, click Datasheet Characterization iconf . The Datasheet
Characterization software (Figure 3-1) opens.

Select the device type of DUT, and load the corresponding template.
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A template is a setup and measurement data file only for this software. Itiscaled as
ETN DSfile.

-’-AJ Identification Device Type:

Part Number: MOSFET
IGET
Sample ID: :
& Ee Diode
Description: Component
Operator:

Measurement Instrument:

1. From the Device Type drop-down list on the upper work area, select the device
type of DUT.

This example selects MOSFET.
2. Click New Datasheet button | 4.

Sep 3. Enter the information for device identification.

» | Identification Device Type: |MOSFI:T v
Part Number:

Sample ID:
Description:

Operator:

Measurement Instrument:

You can enter the following information for device identification of DUT at
| dentification area on upper work area:

Part Number Part number of DUT

Sample|D DeviceID of DUT

Description Device description or any additional information.
Operator Operator information

M easurement

Instrument Measurement instrument information
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Sep 4. Specify the maximum ratings of DUT

- | Maximum Ratings

Symbol
VD55

VGSS
DM
IsM

Maximum Ratings

Parameter Test Conditions Value Unit Note
Drain ta Source Voltage Tj=25 oC to 150 °C v
Gate to Source Voltage Conitnuous A
Pulsed Drain Current Tc=25 °C A
Pulsed Body Diode Current Tc=25 °C A

Confirm the maximum rating parameters and parameter values set in the Maximum
Ratings area, and edit them if needed.

The specified maximum rating values are used to limit the values of measurement
conditions in the Characteristics Parameters area and Characteristics Graphs area.

Symbol

Parameter

Test Condition

Value

Note

Symbol of rating parameter

You can edit this by clicking on the text.
Rating parameter name

You can edit the name by clicking on the text.
Conditions for rating parameter

You can edit the condition by clicking on the text. To close the
expanded editing fields, click the Close button(x] .

Maximum rating value

You can edit the maximum rating value by clicking on the
value. To close the expanded editing fields, click the Close
button(x] .

Note

You can add any text for remarks by clicking the field.

Keysight B1506A User’s Guide, Edition 2 3-7



How To Perform Measurement
How To Perform Datasheet Characterization

Sep 5. Select characteristics measurement items to be measured and enter measurement

conditions

~ | Characteristics Parameters
Symbol Parameter
~ | 1Dss Drain Leakage Current

] 1Gss Gate Leakage Current

1GSS(-)  Gate Leakage Current (-)

| weS(th) Gate to Source Threshold Volta--

VGS(th)  Gate to Source Threshold Volta
RDS(en) Drain to Source On Resistance
~ | vDsS{on) Drain to Source On Voltage
VSD Body Diode Forward Voltage
Rg Gate Resistance

Ciss Input Capacitance

~ | Coss Output Capacitance

Crss Reverse Transfer Capacitance

] Qg Total Gate Charge

Nne Cata kn Sanirca Charna

BVDSS Drain to Source Breakdown Volt--

Characteristics Parameters

Test Conditions Min. Act. Max. Unit Note
VG5=0 V, [D=1 mA 100 135 v
VD5=100 V, VG5=0 V 359p 0y A
VGS=20V, VDS=0V 350p 200 n A
VGS=-20 V, VDS=0 V -200n  -350p A
D=1 mA 2 3.6 4 v
VDS=10 V, ID=1 mA 2 344 4 ¥
VGS=15V, ID=50 A, PulseWidth=200 ps 7.02m 15m ohm
VGS=15V, ID=50 A, PulseWidth=200 ps 366 m 800 m v
VGS=0 ¥, IS=50 A, PulseWidth=200 ps 864 m 2 v
VGS=0V, f=100 kHz 400 m 1 ohm
VGS=0 V, VDS=30 V, f=100 kHz 18.2n 30n B
VGS=0 V, VD5=30 V, f=100 kHz 2.9n 5n F
VGS=0V, VD5=30 ¥, f=100 kHz 900 p in E
Vgs(on)=15 V, Vgs(off)=0 V, Vds=30, Id= 742n ip c

Vimafmml A0V VImnlf a8V AL Vid. AR T L ann - L

Characteristics Parameters area shows the pre-defined characteristics parameters.
Each parameter corresponds to a measurement item.

1. Mark the check box at |eft side of row to select the characteristics parameter to
be measured.

2. Thefollowing column of each characteristics parameter line shows the
following conditions. Confirm the conditions and enter the conditions.

M easurement

Priority

Symbol

Parameter

Click the button on the right-hand side of the check box,
if necessary. You can change the priority of the execution
for the measurement.

[]: 1st priority
: 2nd priority
: 3rd priority

Symbol of characteristics parameter.
You can edit this by clicking on the text.
Name of characteristics parameter.

You can edit the name by clicking on the text.
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Min.

Act.

Max.

Note
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Conditions for characteristics parameter.

You can edit the condition by clicking on the text. To
close the expanded editing fields, click the Close
button(x] .

Lower limit of expected range of characteristics
parameter.

You can enter the value by clicking on the value.
If lower limit is unavailable, the field is not effective.
Measured value of characteristics parameter.

If ameasured valueis out of expected range, which is
from Min. to Max., ameasured value is displayed in red
italics.

Upper limit of expected range of characteristics
parameter.

You can enter the value by clicking on the value.
If upper limit is unavailable, the field is not effective.
Remarks.

You can enter the value by clicking on the field.

To measure same measurement item under the different conditions

If you would like to measure same measurement item under the different conditions,
do asfollowing instruction:

1. To select acharacteristics parameter to be measured, click on the corresponding

line.

2. Click Duplicate button = on thetoolbar.

The aduplicate line of selected characteristics parameter is added under the

selected line.

3. Change the conditions on a duplicate line.
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Sep 6. Select characteristics graph to be measured

~ | Characteristics Graphs
[ =) [V][ ] =
Output Characteristics Transfer Characteristics

200 A |yes gy, 9|V, vGg = 12V, VG5 = 15 V|vGs = 18V

= )
= c
(7] @
el et
= =
3 3
@] @]
c £
o o
(a] (a]

1 Vydiv. 1 Vydiv.

Drain to Source Voltage Gate to Source Voltage

Characteristics Graphs area shows the pre-defined characteristics graphs. Each
characteristics graph corresponds to a measurement item.

1. Mark the check box at upper left of graph to select the characteristics graph to be
measured.

2. Click the button on the right-hand side of the check box, if necessary. You can
change the priority of the execution for the measurement with similar uses asthe
setting of the measurement priority in the Characteristics Parameters area.

3. To change the maximum or minimum value of the X and Y-axis, click on the
value.

If an X or Y-axis corresponds to voltage or current output value, the minimum
and maximum values al so specify the output range on measurement.

4. You can change thetitle of characteristics graph, the labels of X and Y-axis by
clicking on them.

Sep 7. Click the Start Measurement tool button bEI to start measurement.
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The Connection dialog opens. Then, sets up and connect the DUT for the I/V
measurement and the capacitance measurement.

Connection

|

| @ Please make connection for I/V Measurement and Capacitance Measurement.

1. Set the 3-pin inline package socket module and other accessories corresponding
tothe DUT and then set the DUT.

2. Set the DUT on the socket module and other accessories.
3. Closethetest fixture cover.

4. Click the OK button. The marked measurement items related to the 1/V and
capacitance measurement are executed.

For the execution order of the measurement items, see “ Execution Order of
Measurement Items” on page 4-14.

During measurement, you can stop the measurement by clicking the Stop
Measurement tool button B
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During the measurement execution, the measured values of each measurement item
are updated on Act. column of corresponding line at Characteristics Parameters or
on the corresponding characteristics graph at Characteristics Graphs.

Sep 8. After all measurement items by the I/ measurement software and the capacitance
measurement software are finished, the Connection dialog opens. Then, change the
DUT connection setup to that for the gate charge measurement.

e =

@ Please make connection for Gate Charge Measurement.

1. Open the test fixture cover, and disconnect the socket module and other
accessories from the test fixture.

Attach the gate charge socket adapter to the test fixture.
Set the DUT to the gate charge socket adapter.

Close the test fixture cover.

a b~ w N

Click the OK button.The measurement for the selected gate charge measurement
itemsis started.

For the execution order of the measurement items, see “ Execution Order of
Measurement Items” on page 4-14.

Sep 9. After all measurement items are finished, the setup data and the measurement data
are automatically stored in the ETN DSfile. The ETD DSfileis the setup and
measurement data file only for the datasheet characterization software.
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How To Perform 1/VV M easurement

This section describes how to perform a measurement using the I/V measurement
software and consists of the following sub-sections:

» Preparing M easurement

» Executing Measurement

» Monitoring Voltage/Current Waveforms
»  Setting Parameter

I/V Measurement Software

=
&= I/V Measurement

x|

|-F|Ie| Edit View Measurement Configuration Help

o | wn= =
aAEE XdaE, » -
~ Setup Device Type: |MOSFET v| @ ID-VDS ID-VGS VGS(th) RDS-ID VD5-VGS RDS-VGS IDSsS IGSS 15-VSD
General settings Gate / Base Voltage Pulse Step Drain / Collector Voltage Pulse Sweep
[¥] Auto Period Step Modea \LmearSing\e = Sweep Mode |Lineas'5mg\e =
Pulse Period 50m| S Start o | A Start 6| ¥
~ ) Details Stop w0 Vv Stop 30V
« | Details « | ¥ Voltage Compliance 20V
Characteristics [ Connections
v @ Line @ Dot ) Line & Dot \E E\ 5 |7| <

MARKER: NaN Vv

~ ) Automatic Data Save Device ID: Device-1

Oscilloscope View

10 V/div.
VDS

+ Comment: (1] pata: [X || MosFET123 10 VDS
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Preparing M easur ement
Set theinstrument output off before connecting or disconnecting connection
wire.

Pressthe mainframe front panel Sop key to set the source output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

To prevent electrical shock and DUT damage, do not connect or disconnect the
DUT whiletheinstrument isapplying voltage or current.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use gloveand
any tool. Also have enough time for discharge and radiation.

Prepare the test fixture and accessories to connect your device under test (DUT).
And, connect the test fixture and, 3-pin inline package socket module or other
accessories that is adequate for your DUT.

For more information on the test fixture and its accessories, see the following
sections:

e “To Connect Test Fixture” on page 2-11

» “3-pin Inline Package Socket Module”’ on page 2-18

» “Universal Socket Module Kit” on page 2-19

e “Accessoriesfor Connecting aDUT” on page 2-28

Turn the instrument on and then connect your DUT to the test fixture.

If your DUT is diode, connect a cathode terminal of your DUT to the
Collector/Drain terminal of test fixture and aanode terminal of your DUT to the
Emitter/Source terminal of test fixture.

If you would like to monitor/control temperature during measurement, perform the
required connection and operation. See “How To Monitor/Control Temperature
Under Measurement” on page 3-51.
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[¥] Auto Period
Pulse Period
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Executing M easurement

This section explains the procedure using an example that selects MOSFET as a
device type of DUT and ID-VDS as a measurement item.

Execute a measurement as follows:

On the software palette, click the |/V Measurement iconE . Thel/V Measurement
Software (Figure 3-2) opens.

At the Setup areain work area, select a device type and measurement item to be
measured.

@ ID-VD5 ) ID-VG5S (7 VG5(th) @ RD5-ID VD5-VGS RDS-VGES

MOSFET Gate / Base Voltage Pulse Step [
IGET StF'_Fr Mode | |_:jﬂear5ing||:_| ==
Diode S0m| S Start 0 V
Generic
Stop 10
~ | Details

» Device Type
From the Device Type drop-down list, select a device type.
This example selects MOSFET.

* Measurement Item

From the radio buttons located on the right of a Device Type selection, which is
MOSFET in this example, select a measurement item to be measured.

This example selects ID-VDS.

For information on the available device types and measurement items, see Table 3-1
on page 3-23

By selecting a device type and measurement item, the setup items displayed in the
Setup area are automatically switched.
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Sep 3. Enter or select the setup conditions for the gate of MOSFET in Gate/Base Voltage
Pulse Step at the center of Setup area.

zate / Base Voltage Pulse Step

Step Mode LinearSingle -
Start n v
Stop b7 )
~ | Details

» Selecting Step Mode

From the Step Mode drop-down list, select a step mode of pulse voltage output.

Linear Single Outputs voltage level changes from the Start value to the
Stop value at equal intervals.

ListSingle Specify the output voltages of each step in the List.
Each step voltagein the List will be output in order from top
to bottom.

This example selects the ListSingle.

Gate / Base Voltage Pulse Step
Step Mode

List

w | Details

» Tochange step values

Click the value in the List and you can change it to new value.
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e Toinsert new step value

Select the step value immediately after where you want to insert new step value

and click the Insert button [
» To change an output order of step values

Click the Move Down and the Move Up buttons]]?] to move down or up an
order of the selected step value.

» Todeleteastep vaue

Click the Delete button [X] to delete the selected step value.
By clicking the Details button, the area expands to set more detail conditions.
For more information on setting items, see “ Setup” on page 4-45.

Sep 4. Enter or select the setup conditions for the drain of MOSFET in Drain/Collector
Voltage Pulse Sweep at the right side of Setup area.

Drain / Collector Violtage Pulse Sweep

Sweep Mode | Linearsingle -
Start 0
Stop 20
« | Voltage Compliance ag | V

Select or specify a sweep mode, a sweep start value, a sweep stop value, and a
voltage compliance.

*  Sweep Mode
Select a sweep mode from the Sweep Mode drop-down list.

Linear Single One-way linear sweep from the Start (sweep start value) to
the Stop (sweep stop value).

LogSingle One-way logarithmic sweep from the Start (sweep start
value) to the Stop (sweep stop value).

Linear Double Linear-sweep from the Start (sweep start value) to the Stop
(sweep stop value) and then return linear-sweep from the
Stop to the Start.
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LogDouble L ogarithmic-sweep from the Start (sweep start value) to the
Stop (sweep stop value) and then return logarithmic-sweep
from the Stop to the Start.

o« Start, Stop

Enter the sweep start value in the Start and the sweep stop value in the Stop.
» Voltage Compliance
Enter the voltage compliance value in the Voltage Compliance.

If the output voltage of measurement unit connected to adrain terminal is more
than this value, a measurement unit stops the output.

By clicking the Details button, the area expands to set more detail conditions.
For more information on setting items, see “ Setup” on page 4-45.

Enter the setup conditions for the pulse output in General settings at the left side of
Setup area.

Ganeral settings
[¥] Aute Period

Pulse Period s50m| S
w | Details
Auto Period Automatic adjustment for the pulse period.
To enable this function, mark the check box.
Pulse Period Pulse period.

However, if the Auto Period function is enabled, the pulse
period is automatically adjusted to a minimum period
corresponding to the pulse width.
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Sep 6. Click the Connectionstab to display Connections area.

Chamesaristics | Connections

L Rase [ Gata 7 Collector / Drain 3 Emitter f Source 4 Guard

Base / Gate Resistor 10 | ohm Collector / Drain Resistar 0 = | chm

At Connections area, you can confirm a measurement circuit.

Also, you can select a gate resistor/drain resistor that may be effective to suppress a
device oscillation during measurement.

» Base/Gate Resistor
You can select agate resistor from this drop-down list.

A gate resistor may be effective to suppress a device oscillation during large
current measurement.

NOTE You can select agate resistor only if ameasurement resourceis MCSMU.

In this example, which selects MOSFET asadevicetypeand ID-VDSasa
measurement item, the default measurement resourceis MCSMU and you can select
agateresistor.

» Collector/Drain Resistor
You can select adrain resistor from this drop-down list.

A drain resistor may be effective to suppress aover current during a break-down
measurement.

NOTE You can select adrain resistor only if ameasurement resource is HVSMU.

Keysight B1506A User’s Guide, Edition 2 3-19



How To Perform Measurement
How To Perform I/V Measurement

In this example, which selects MOSFET asadevicetypeand ID-VDSasa
measurement item, the default measurement resource is UHCU and a drain resistor
isfixedto 0 Q.

Sep 7. Click the Start Measurement tool button [B= to start a measurement.
Or, click the Repeat Measurement tool button to repeat a measurement.

After starting a measurement, you can stop a measurement by clicking the Stop
Measurement tool button [ .

Sep 8. Click the Characteristics tab to display the Characteristics area.

After ameasurement isfinished, ameasured |/V characteristics curve is displayed
on the Characteristics area. This example shows an ID-V DS characteristics curve.

Characteristics | Connections |

MARKER: 1.9151 V

-~

EVGS =4V EVGS =5V EVGS =6V
FVGs =7V EVGs =8V EVGsS =0V
300 A gves =12y [ EVGSLisV ' FIVGS =18V | 204.61A

Oscilloscope View

2 v/div.

VDS .

For the operation on the graph display, see “Displaying and Operating Graph” on
page 3-57.
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Monitoring Voltage/Current Waveforms

he I/V measurement software can monitor both voltage and current waveforms for
the measurement channels at the specified measurement point on the characteristic
trace when the measurement is in the pul se mode operation.

Click the Characteristics tab to display the Characteristics area.

Click the Oscilloscope View <! button to display the Oscilloscope View area.

Execute the I/V measurement according to the steps described in “Executing
Measurement” on page 3-15.

. Move the trace marker on the Characteristics graph to specify the observation point.

Click the Start Measurement tool button B to start a measurement.

Or, click the Repeat M easurement tool button to repeat a measurement.

After starting a measurement, you can stop a measurement by clicking the Stop
Measurement tool button ] .
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After measuring the specified point, the observation point on the characteristics
graph isidentified by a monitor marker (green frame), and the time domain
waveform(s) is displayed on this area.

Characteristics | Connections y

~) ® Line @ Dot @ Line & Dot \E|\$|\7| @ Line ¢ Dot ©) Line & Dot

MARKER: 11.113 1 7a):300ps I MARKER(B):

100 p s/div.
300 A

[120 m |A/div 2

5 Vv/div.
VDS 3 5 [ 100 p s/div 300 p s] ko 4=

In the case of the repeat measurement, you can move the trace marker to change the
observation point during the measurement. After measuring the changed point, the
monitor maker moves to the point and the waveforms are updated.

Sep 6. Mark the check boxes for the voltage or current data names the measurement
channels that you want to monitor.
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Setting Parameter

Table 3-1 Available Device Types and Measurement Items
Device Type Measurement Description
[tem

MOSFET ID-VDS ID-VDS output characteristics
ID-VGS ID-VGS transmission characteristics
RDSID RDS (Drain to Source resistance) - 1D characteristics
VGS(th) Gate to Source Threshold voltage
VDSVGS VDS-VGS characteristics
RDS-VGS RDS (Drain to Source resistance) - VGS characteristics
IDSS Drain leak current - VDS characteristics
IGSS Gate leak current - VGS characteristics
ISVSD Forward current of body diode - VSD characteristics

IGBT IC-VCE IC-V CE output characteristics
IC-VGE IC-VGE transmission characteristics
V GE(th) Gate to Emitter Threshold voltage
VCE-VGE VCE-VGE characteristics
V CE(sat) V CE(sat) (Collector to Emitter saturation voltage) - IC

characteristics

ICES Collector leak current - VCE characteristics
IGES Gate leak current - VGE characteristics
IF-VF Forward characteristics of free wheel diode

Diode IF-VF Forward bias current - voltage characteristics
IR-VR Reverse bias current - voltage characteristics
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Device Type M eaIsE[Jer';eqment Description
Generic2T Conduction Conduction resistance characteristics
Isolation Isolation characteristics
Generic

Free setup on the measurement units connection and
measurement conditions.
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How To Perform Capacitance M easurement

This section describes how to perform a measurement using the capacitance
measurement software and consists of the following sub-sections:

» Preparing M easurement
» Executing Measurement

»  Setting Parameter

Figure 3-3 Capacitance M easurement Software

ﬁ Device Capacitance Measurement e

|’Fi\e|Ed\t View Calibration Measurement Configuration Help

ﬁ H xi r}-’é D-] [ﬁ b - Start Calibration... Select Calibration Data...

~)Setup Device Type: |MOSFET »| @ Ciss, Coss, Crss () Ciss () Coss () Crss ) Cgs, Cds, Cgd ©Cgs @ Cds € Cgd @ Rg () Cox

General settings Base / Gate Voltage Bias Collector / Drain Voltage Sweep
Frequency 100k Hz Bias o V Start w00m V
| Details Stop 100 V
Sweep Mode ‘Lugs,ﬂgT
v ) Details

Characteristics | Connections

~) @ Line © Dot © Line & Dot [ ;‘[E“*\
MARKER: NaN V

Capacitance
decade/div.

decade/div.

v Automatic Data Save Device ID: Device-1 » Comment:
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Preparing M easur ement
Set theinstrument output off before connecting or disconnecting connection
wire.

Press the mainframe front panel Sop key to set the source output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

To prevent electrical shock and DUT damage, do not connect or disconnect the
DUT whiletheinstrument isapplying voltage or current.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use glove and
any tool. Also have enough time for discharge and radiation.

Prepare the test fixture and accessories to connect your device under test (DUT).
And, connect the test fixture and 3-pin inline package socket module or other
accessories that is adequate for your DUT.

For more information on the test fixture and its accessories, see the following
sections:

* “To Connect Test Fixture” on page 2-11

» “3-pin Inline Package Socket Module”’ on page 2-18
e “Universal Socket Module Kit” on page 2-19

» “Accessoriesfor Connecting aDUT” on page 2-28

Turn the instrument on.
Don't connect your DUT to the test fixture at thistime.

If you would like to monitor/control temperature during measurement, perform the
required connection and operation. For more information, see “How To
Monitor/Control Temperature Under Measurement” on page 3-51.
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Executing M easurement

This section explains the procedure using an example that selects MOSFET as a
device type of DUT and Ciss, Coss, Crss as a measurement item.

Execute a measurement as follows:

On the software palette, click the Capacitance Measurement icon f . The

Capacitance Measurement software (Figure 3-3) opens.

At the Setup areain work area, select adevice type of your DUT and a measurement
item to be measured.

.;’_I;‘J Setup Device Type: |MOSFET « | i@ Ciss, Coss, Crss Ciss Coss Crss ) Cgs, Cds, Cgd @ Cgs

General settings

~ | Dietails

Frequency

MOSFET Base / Gate Voltage Bias
ook Hz Bias 0|

e Device Type
Select a device type from the Device Type drop-down list.
This example selects MOSFET.

* Measurement Item

From the radio buttons located on the right of a Device Type selection, which is
MOSFET in this example, select a measurement item to be measured.

This example selects Ciss, Coss, Crss.

For information on the available device types and measurement items, see Table 3-2
on page 3-31

By selecting a device type and measurement item, the setup items displayed in the
Setup area are automatically switched.
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Enter the measurement frequency in the Frequency of General settingslocated at the
left part of Setup area.

General settings
Frequency 100k HZ

« | Details

By clicking the Details button, the area expands to set more detail conditions.

For more information on setting items, see “ Setup” on page 4-77.

Enter the bias voltage value in the Bias of Base/Gate Voltage Bias at the center of
Setup area.

Base / Gate Voltage Bias
Bias o v

Enter or select the voltage sweep conditionsin the Collector/Drain Voltage Sweep at
the right of Setup area.

Collector / Drain Voltage Sweep

Start iwom V
Stop 100 V
Sweep Mode | LogSingle >
v | Details
Sart Enter a start voltage value of sweep.
Sop Enter a stop voltage value of sweep.

Sweep Mode Select a sweep mode.

Linear Single One-way linear sweep from the Start to the
Stop.

LogSingle One-way logarithmic sweep from the Start
to the Stop.

Linear Double Linear-sweep from the Start to the Stop and
then return linear-sweep from the Stop to
the Start.

LogDouble L ogarithmic-sweep from the Start to the
Stop and then return logarithmic-sweep
from the Stop to the Start.

By clicking the Details button, the area expands to set more detail conditions.
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For more information on setting items, see “ Setup” on page 4-77.

Click the Start Calibration... button in the toolbar to measure the calibration data of
measurement path.

Follow the instruction displayed on the dialog to measure the open and short
calibration data.

If you have measured and saved the calibration data of measurement path, click the
Select Calibration Data... button in the toolbar to select and load the stored
calibration data.

Set your DUT on the test fixture and click the Start Measurement button = to
start a measurement.

You can stop the measurement by clicking the Stop Measurement button [
during a measurement execution.

If your DUT isdiode, connect the cathode of your DUT to the Collector/Drain
terminal of the test fixture and the anode of your DUT to the Emitter/Source
terminal of the test fixture.

Click the Characteristics tab to display the Characteristics area.

After a measurement is finished, a measured capacitance characteristics curveis
displayed on the Characteristics area. This example shows the Ciss, Coss, and Crss,
characteristics curves.
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Characteristics | Connections |

w | @ Line ) Dot @ Line & Dot \E||$|[£]|_|

MARKER: 96.754 V

Ciss 155 Crss

100nF

Capacitance

For the operation on the graph display, see “Displaying and Operating Graph” on
page 3-57.
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Setting Parameters

Table 3-2 Available Device Types and Measurement Items
Device Type Measurement Description
[tem
MOSFET Ciss Ciss (Input capacitance) - VVds characteristics
Coss Coss (Output capacitance) - Vds characteristics
Crss Crss (Feedback capacitance) - Vds characteristics
Ciss, Coss, Crss | Ciss, Coss, and Crss characteristics
Cgs Cgs (Gate to Source capacitance) - Vds characteristics
Cds Cds (Drain to Source capacitance) - Vds characteristics
Cad Cgd (Gate to Drain capacitance) - Vds characteristics
Cgs, Cds, Cgd Cgs, Cds, and Cgd characteristics
Rg Rg (Gate resistance) - Vgs characteristics
Cox Cox (Gate oxide film capacitance) - VVgs characteristics
IGBT Cies Cies (Input capacitance) - Vce characteristics

Coes Coes (Output capacitance) - V ce characteristics
Cres Cres (Feedback capacitance) - Vce characteristics
Cies, Coes, Cres | Cies, Coes, and Cres characteristics
Cge Cge (Gate to Emitter capacitance) - V ce characteristics
Cce Cce (Collector to Emitter capacitance) - V ce characteristics
Cgc Cgc (Gate to Collector capacitance) - Vce characteristics
Cge, Cce, Cgc Cge, Cce, and Cgc characteristics
Rg Rg (Gate resistance) - Vge characteristics
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Device Type Meaijermemmt Description
Diode CT Total capacitance at reverse biasto bias voltage
characteristics

Generic Sweep Voltage Cp-G model capacitance between Collector/Drain terminal
Between and Emitter/Source terminal to V ce/Vds characteristics
Terminal 2-3
Sweep Voltage Cs-Rs model capacitance between Base/Gate terminal and
Between Emitter/Source terminal to Vbe/\V gs characteristics
Terminal 1-3
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How To Perform Gate Charge M easurement

This section describes how to perform a measurement using the gate charge
measurement software and consists of the following sub-sections:

» Preparing M easurement

» Executing Measurement

Figure 3-4 Gate Charge M easurement Software
=4 Gate Charge Measurement o B e
File Edit i'View‘ Calibration Measurement Configuration Help
m H xi L}é |j-| E‘Iﬁ =l [ 23 Start Calibration... Select Calibration Data...
~ ) Conditions
Drain Gate ¥ Current Load
Vds(off) 60 V Vgs(off) o 4 LoadVgs(off) gV
Id{on) 10- | A Vgs(on) 15| Loadvgs(on) 15 vV
Ig 20m A

Gate Charge Characteristics .Swztching ‘Waveform

v @ Line > Dot © Line & Dot vgs{on) —-
A

MARKER(A): 0 C W MARKER(B): 0 C (a):0C

vgs(pl) —|-
vgs(th) ---{-
3 v

Parameters [+

Vgs{off) ---1-

Qgth) -

Qgs —w | :

Qgd —— -
Qalor) —»f i1 i -

Derived | High Current | High Voltage

[ symbal value Unit Description

Vgs, Gate to Source Voltage

200 n C/div.

Qg, Gate Charge

+ | Automatic Data Save Device ID: Device-1 ~ Comment: \EI Data: |;|{H Qag.pda-gg.bxt
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Preparing M easur ement
Set theinstrument output off before connecting or disconnecting connection
wire.

Pressthe mainframe front panel Sop key to set the source output off. And
confirm that the mainframe front panel High Voltage indicator isnot lit.

To prevent electrical shock and DUT damage, do not connect or disconnect the
DUT whiletheinstrument isapplying voltage or current.

When you touch the DUT after measurement, devise a counter measur e of
residual charge and heat to prevent electrical shock and burn. Use gloveand
any tool. Also have enough time for discharge and radiation.

Connect the test fixture and the gate charge socket adapter.
For more information, see the following sections:

e “To Connect Test Fixture” on page 2-11

» “Gate Charge Socket Adapter” on page 2-25

Turn the instrument on.
Don't connect your DUT to the test fixture at thistime.

If you would like to monitor/control temperature during measurement, perform the
required connection and operation. For more information, see “How To
Monitor/Control Temperature Under Measurement” on page 3-51.
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Executing M easurement

Execute a measurement as follows:

On the software palette, click the Gate Charge Measurement icon I . The Gate
Charge Measurement software (Figure 3-4) opens.

Enter the measurement conditions at the Condition area.

60
10

Drain

Gate

Gate [ Curre
\Vigs(off) o V Load’
Vgs({on) 15 |V Load’

Ig 20m A

Specify the drive conditions for the drain of DUT.

Vds(off)

Enter the voltage to force between drain and source of DUT
at the off-state.

Id(on)

Enter the drain current to force to DUT at the on-state if the
constant current load (Current Load) is used.

If the constant current load is not used, the drain current at
the on-state is determined by the Vds(off), the resistance of
resistive load, and the on-state resi stance/saturation voltage.
For the current output range of measurement resource, the
minimum range that includes Id(on) is automatically
selected.

Specify the gate drive conditions of DUT.

Vgs(off)

Enter the gate-source voltage that turns the DUT to the
off-state.

Vgs(on)

Enter the gate-source voltage that turns the DUT to the
complete on-state.
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° |g
Enter the limit value of gate current.

This setting effects the switching time. The larger limit
causes the shorter switching time and the smaller limit
causes the longer switching time.

Current Load Mark the check box if the constant current load is used.

[¥] Current Load

oV LoadVgs(off)
i5 | M LoadVgs(an) 15| W
20m A

Specify the gate drive conditions of the constant current load
transistor so that the constant current load transistor forces the
current as same as Id(on) specified in the Drain.

If you don’t use the constant current load but use the resistive
load, unmark the Current Load check box.

e LoadVgs(off)

Enter the gate-source voltage that turns the constant current
load transistor to the off-state.

« LoadVgs(on)

Enter the gate-source voltage that turns the constant current
load transistor to the compl ete on-state.

Click the Start Calibration... button in the toolbar to measure the calibration data of
measurement path.

Follow the instruction displayed on the dialog to measure the open and short
calibration data.

If you have measured and saved the calibration data of measurement path, click the
Select Calibration Data... button in the toolbar to select and load the stored
calibration data.

Set your DUT on the test fixture and click the Start Measurement button B to
start a measurement.
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You can stop the measurement by clicking the Stop Measurement button [
during a measurement execution.

Sep 5. Click the Gate Charge Characteristics tab to display the Gate Charge Characteristics
area.

After ameasurement is finished, a measured gate charge characteristics curve and
extracted parameters are displayed on the Gate Charge Characteristics area.

Gate Charge Characteristics | Switching Waveform

v @ Line Dot ) Line & Dot |E‘j|

MARKER(A): 400 nC B MARKER(B): 400 nC (a):0C 1,581

L (F W Vgs-Qg (H.C.) u o
] W vdsQg (H.V.) vgs(pl) ---1-
vgs(th) ---1{-

3 v

Parameters (v

s |

Vgs(off) ---1-

Qgith) —» <
Qgs e :
Qgd ——» - ;
Qglam) —» 1} i -
Derived | High Current | High Voltage
'S\.'mbo‘ value Unit Descrip =
vgs(pl) 6.09 V gate plateau voltage
Qgs 97.8n
ggd  227n

C gate-source charge
Qg(th) 48.5n C gate-source thresholq

gate-drain charge

@
o
5]

=
o

=
QO
8
=
]

D
(=]

——
@

3
35}

1G]
W
=]

=

Qg{on) 742n on-state gate-source

4 3 16.1n F Qgs/{vgs(pl)-vgs(off
100 n C/div. 800ncC c2 46.7n F

81 A23m
i

Qg, Gate Charge

+ Automatic Data Save Device ID: Device-1 ~ Comment: |E| Data: |;|5| Qg.pda-qg.txt
The left side shows the measured gate charge characteristics curve and theright side
shows the extracted parameters.
Sep 6. Displaying the gate charge characteristics curve
» To select the gate charge characteristics curve to be displayed

Mark the check box corresponding to the gate charge characteristics to display
the characteristics curve.
You can select the multiple gate charge characteristics.
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JESD24-2 (Derived) | Shows the approximation straight line of gate charge
characteristics that measured under conditions of V ds(off)
and Ig(on) specifiedin “Drain”.

Vgs-Qg (H.C)) Shows the gate charge characteristics that measured under
the condition of Id(on) specified in “Drain”.

Vgs-Qg (H.V.) Shows the gate charge characteristics that measured under
the condition of Vds(off) specified in “Drain”.

JESD24-2 (H.C.) Shows the approximation straight line of Vgs-Qg(H.C.)
gate charge characteristics. The approximation is cal cul ated

on doops (Sy, Sy, and Sy) defined in JEDEC Standard
JESD24-2.

JESD24-2 (H.C.) Shows the approximation straight line of Vgs-Qg(H.V.)
gate charge characteristics. The approximation is calculated
on doops (S;, Sy, and Sy) defined in JEDEC Standard
JESD24-2.

Vds-Qg (H.C.) Shows the rel ationship between the drain-source voltage
and gate charge when the Vgs-Qg(H.C.) is measured.

Vds-Qg (H.V.) Shows the relationship between the drain-source voltage
and gate charge when the Vgs-Qg(H.V.) is measured.

By the radio buttons at the top of graph, you can select the line type of
characteristics curve from Line, Dot, or (Line & Dot).
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e Extracted Parameter Display

Vgs(on) --- ............................:,.»’
c1, 51 :
Vas(pl) ---]-----
vas(th)) 1t oo, 50
29 v §:. H
Vgs(off) ---
Qqlth) &
Qgs = - :
Qgd —+— -
Qglon) i : 2
Derivad | High Current | High Voltage
Symbol  Value  Unit Descripti
Vags(pl) 6.095 W gate plateau voltage
Qgs 98 n C gate-source charge
Qgd 227 n C gate-drain charge
Qg(th) 47 n C gate-source threshold
Qgfon) 742n C on-state gate-source ¢
€1 16.061n F Qgs/{Vgs(pl)-Vgs(off)
C2  46.735n F {Qg(on)-Qgs-Qgd}/{v
S1 62 m slope 1 (V/nC)
S2 21m slope 2 (V/nC)

Enter the threshold voltage of DUT in the Vgs(th) at the upper of parameter
display area.

The gate charge parameter val ues that extracted from the specified threshold
voltage Vgs(th), and JESD24-2(Derived), JESD24-2(H.C.), and
JESD24-2(H.V) are displayed in this area.

To show the gate charge parameters from JESD24-2(Derived), click the Derived
tab.

To show the gate charge parameters from JESD24-2(H.C.), click the High
Current tab.

To show the gate charge parameters from JESD24-2(H.V.), click the High
Voltage tab.

The following gate charge parameters are displayed:
Vgs(pl) Gate plateau voltage
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Qgs Gate - source charge
Gate charge for slope S; defined in JEDEC Standard
JESD24-2.

Qad Gate - drain charge
Gate charge for slope S3 defined in JEDEC Standard
JESD24-2.

Qqg(th) Gate-source charge at threshold
Gate charge from Vgs(off) to Vgs(th).

Qg(on) Gate-source charge in on-state
Gate charge from Vgs(off) to Vgs(on).

C1 Qos{Vgs(pl)-Vgs(off)}

Equivalent capacitance for ope S, defined in JEDEC
Standard JESD24-2

C2 {Qgs(on)-Qgs- Qgd}/{ Vgs(on)-Vgs(pl)}
Equivalent capacitance for slope S, defined in JEDEC
Standard JESD24-2.

S1 Slope S; defined in JEDEC Standard JESD24-2

S2 Slope S, defined in JEDEC Standard JESD24-2

For more information on the operation for graph display, see “Displaying and
Operating Graph” on page 3-57.
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How To Calculate Power Loss

This section describes how to calculate the power loss at a switching device using
the power loss cal culation software and consists of the following sub-sections:

» Calculating Power Loss
» Extracted Parameters By Power Loss Calculation

Power L oss Calculation Software

22 Power Loss Calculation

o[ S

File Edit WView Calculation

" Load Type

@HEE xda@m, > a2

[~ Conditions S

@ Inductive Psw = 1/2*f*Vds*Id*(Rg+Rg(ext))*Qsw={1/(Vgs(on)-Vgs(pl))+1/{Vgs(pl)-Vgs(off))}
Resistive  Psw = 1/6*f*vds*Id*(Rg+Ra(ext))*Qaw*{1/(Vgs(on)-vgs(pl))+1/{vgs(pl)-vgs(off))}

~!Inputs Device Type: |MOSFET = |

[ Drive C.ondltlons ] Device Parameters | "b.utput"CnaractEr\stlcs Gate Resistance | Capacitance [ cate Charge
Sweep “Parametar Symbol valug
[#  Switching Frequency f Start 104
Stop 2M
Sweep Mode |Loq - =
Number of Step 5C
Gate-Source turn on Voltage  Vgs(on) 12
Gate-Source turn off Voltage  Vgs(off) a
Drain Current Id i8
Drain-Source Voltage vds 480
Eyternal Gata Rasistancs Ralayt) o ann " i

| Index f (Hz) Cond. Loss(W) Coss Loss{W) Switch. Loss(W) Drive Loss(W) Total L *

w | Automatic Data Save Device ID: Device-1 ~ Comment: |E‘ Data: ‘;Iﬁl Device-1 Pow

Help

il » vDs

Driving Loss

decade/div.
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The power loss cal culation software cal cul ates the power loss from the drive
conditions and the device characteristics parameters of DUT.

There are the following two ways to specify the parameters for calcul ation:

Specify the parameter values from the datasheet of DUT.

If you want to calculate the power loss of DUT at the different drive conditions
or there are the parameters that are not specified in the datasheet, you may
specify the predicted values.

Measure the switching device by the 1/V measurement software, capacitance
measurement software, and gate charge measurement software at your desired
drive conditions and store the measurement data. Then, the power 1oss
calculation software read the stored measurement data and extract the required
drive conditions and characteristics parameters for power loss calculation.

This section explains the procedure that specify the measurement data file of DUT.

Calculating Power L oss

Prepare the measurement data

The power loss cal culation software uses the following measurement data filesto
calculate the power loss. So, measure the DUT at your desired drive conditions and
save the measured data.

Measurement data file of 1/V measurement software

Prepare a measurement data file that measured either one of the following
measurement item.

For MOSFET device type,
+ ID-VDS

+ RDSID
 VDSVGS

+ RDSVGS

For IGBT device type,
 IC-VCE
o VCE(sat)
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* VCE-VGE
Measurement data file of capacitance measurement software

Prepare the measurement data files that measured the following measurement
items.

For MOSFET device type,

* Ry

e Ciss, Coss, Crss (Coss or Crss)

For IGBT device type,

* Ry

« Cies, Coes, Cres (Coesor Cres)

Measurement data file of gate charge measurement software

Prepare a measurement data file that measured any measurement item.

Sep 2. On the software palette, click the Power Loss Calculation iconE . The Power Loss
Calculation software (Figure 3-5) opens.

Sep 3. Select the assumed load type to calculate the power lossin the Conditions area on
thework area.

{ ») Conditions

Load Type
@ Inductive Psw = 1/2*f*Vds*1d*(Rg+Rg(ext))*Qsw={1/(Vvas{on)-vgs(pl))+1/(Vas(pl}-vas(off))}
| Resistive  Psw = 1/6*f*Vds*Id*(Rg+Rg(ext))*Qsw={1/({Vgs(on)-vgs(pl)}+1/(Vgs(pl)-Vgs{off)) ;

Inductive Inductive load

Resistive Resistive load

Sep 4. Atthelnputsareain work area, select a device type.

() Inputs Device Type:

Drive Conditions | Davi

From the Device Type drop-down list, select a device type.

This example selects MOSFET.

Keysight B1506A User’s Guide, Edition 2 3-43



Sep 5.

How To Perform Measurement
How To Calculate Power Loss

Specify the measurement data files to be used for power loss calculation and load
them.

Output Characteristics | Gate Resistance | Capacitance | Gate Charge

alue = -: |ﬁ|

ann T

+ Loss(w) Tota! L |

1. Specify the measurement datafile of the I/V measurement software to load.

a. Click the Output Characteristics tab at the right of work areato display the
Output Characteristics area.

b. Click the Load Measurement Data button |§| at the upper-1eft corner of the
Output Characteristics area.

After the dialog box opens, specify the measurement data of 1/V
measurement software.

The characteristics graph of the loaded measurement item is displayed.

2. Specify the Rg measurement data file of the capacitance measurement software
to load.

a. Click the Gate Resistance tab to display the Gate Resistance area.

b. Click the Load Measurement Data button |§| at the upper-1eft corner of the
Gate Resistance area.

After the dialog box opens, specify the Rg measurement data of capacitance
measurement software.

The loaded Rg characteristics graph is displayed.
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3. Specify the“Ciss, Coss, Crss’ measurement datafile of the capacitance
measurement software to load.

a. Click the Capacitance tab to display the Capacitance area.

b. Click the Load Measurement Data button lﬁl at the upper-left corner of the
Capacitance area.

After the dialog box opens, specify the“ Ciss, Coss, Crss’ measurement data
of capacitance measurement software.

Theloaded “ Ciss, Coss, Crss’ characteristics graph is displayed.

4. Specify the measurement data file of the gate charge measurement software to
load.

a. Click the Gate Charge tab to display the Gate Charge area.

b. Click the Load Measurement Data button |ﬁ| at the upper-left corner of the
Gate Charge area.

After the dialog box opens, specify the measurement data of gate charge
measurement software.

The gate charge characteristics graph of the loaded measurement item is
displayed.
For the drive conditions and the device parameters for power |oss cal culation that

extracted from the loaded measurement data, see “ Extracted Parameters By Power
Loss Calculation” on page 3-49".

Keysight B1506A User’s Guide, Edition 2 3-45



How To Perform Measurement
How To Calculate Power Loss

You can confirm or change the drive conditions for power loss calculation by
clicking the Drive Conditions tab at the |eft of work area.

Also, you can confirm or change the device parametersfor power |oss calculation by
clicking the Device Parameters tab.

Drive Conditions i-_[JEP_ammeters]
Sweep Parameter Symbol Value Unit ||«
[  Switching Frequency f Start ink Hz I
Stop 2M
Sweep Mode Log -
Mumber of Step 50 -
E] Gate-source turn on Voltage Vgs(on) 15 v
[[] Gate-source turn off Voltage Vgs(off) 0 v
] Drain Current 1d 40 A
] Drain-source Voltage Vds 200 v
[[] External Gate Resistance Rg(ext) 800 m ohm

[ Thday Crndictinn | ase (AN Switehina | ase (WY Dirivina | nes (WY Tatal Brwer | ass (A7

Sep 6. Select adrive condition or device parameter to be swept and specify the sweep
condition.

If you select adrive condition parameter to be swept, click the Drive Condition tab
and mark the check box of the desired drive parameter.

If you select a device parameter to be swept, click the Device Parameters tab and
mark the check box of the desired device parameter.

This example select a switching frequency to be swept.

1. Click the Drive Conditions tab and mark the check box of the Switching
Frequency parameter to select.

2. Specify the sweep condition in the Value column.
Sart Sweep start value
Sop Sweep stop value

Sweep Mode Sweep mode
Log (logarithmic sweep) or Linear (linear sweep)
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Number of
Sep Number of sweep steps

Sep 7. Specify the drive conditions that are not extracted from the loaded measurement
data

1. Click the Drive Conditions tab at the left of work areato display the Drive
Conditions area.

2. Specify the following drive conditions that are not extracted from the
measurement data

Switching
Frequency Switching frequency
In this example, this parameter already specified by Step.4.

Rg(ext) Gate input resistance in the external drive circuit

Irms, D Irms: Effective drain current (the root mean square of the
load current)
D: Duty cycle.

Specify Irmsor D.
The relation between Irms and D is Irms = Id x DY2,

Sep 8. Click the Start button B of toolbar to start the power loss calculation.

Sep 9. After the calculation is completed, the list of calculated values and the trand chart
are displayed as shown below.

| Index f (Hz) Cond. Loss(W) Coss Loss(W) Switch. Loss(W} Drive Loss(W) Total Loss(W) “ Power Loss vs. Switching Frequency
o 10000.000000 22.221208 0.047417 2.060067 0.111158 24.439851
1 11141.913842 22.221208 0.052832 2.293309 0.123851 24.693201 4 600 W oo
2 12414.224406 22.221208 0.038865 2.55741% 0.1379%94 24.975481 EREEE
3 13831.821875 22.221208 0.063587 2.849449 0.153752 25.289995
4 22.221208  0.073076  3.174831 0.171309 25.640424
5 22.221208 0.081421 3.537369 0.190871 26.030869 9 "
6 1. 22.221208 0.030718 3.941306 0.212667 26.465300 3 3
F 21316.631165 22.221208 0.101078 4.391370 0.236952 26.950607 g :
g 23750.806785 22.221208 0.112620 4.892826 0.264010 27.490664 g 2
9 26462.944287 22.221208 0.125480 5.451545 0.294157 28.092390
10 29484.784525 22.221208 0.139809 6.074064 0.327747 28.762829
11 32851.692883  22.221208  0.155774  6.767670 0.365173 29.509825
12 36603.073166 22.221208 0.173562 7.540480 0.406873 30.342122
13 40782.828757 22.221208 0.193381 8.401538 0.453334 31.269461 decade/div. 10 M Hz
14 45439.876424 22.221208 0.215463 9.360921 0.505101 32.302693 =

Switching Frequency
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» List of Calculated Results

The following calculated data are displayed in list format.

Index Index number of sweep step.

Sweep Parameter Sweep parameter and its step values.
In this example, F values are listed as the sweep
parameter.

Conduction L oss Calculated conduction loss

Coss(or Coes) Loss
Calculated output capacitance loss

Switching L oss Calculated switching loss

Driving Loss Calculated driving loss

Total Power L oss Sum total of the conduction loss, switching loss, and
driving loss.

For the calculation formula for each power loss, see “Results’ on page 4-137.
e Trend Chart

The sweep parameter is assigned to X-axis, and the conduction loss, output
capacitance loss, switching loss, and driving loss are assigned to Y-axis and
accumulated in this order.

You can change the minimum and maximum values on the X and Y-axises by
clicking the value.
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Extracted Parameters By Power L oss Calculation

Table 3-3 M easurement Data and Extracted Drive Conditions and Device Parametersfor
Power L oss Calculation (MOSFET)

M easurement Data Extracted Extracted
Drive Device
M easurement Software Measurement Item | Conditions Parameters
I/V Measurement ID-VDS, RDS-ID, Rds(on)?
RDSVGS, or
VDSVGS
Capacitance M easurement Rg Rgb
Crss Qsw®
Gate Charge Measurement Any measurement Vgs(on), Qg(on),
items V gs(off), Qg(off),
Id, Qsw,
Vds Vgs(pl)

a. Extracted from Vgs(on)
b. Extracted from Vgs(off)
c. Extracted from Vgs(off) and Vds(off)
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Table 3-4 M easurement Data and Extracted Drive Conditions and Device Parameter sfor
Power L oss Calculation (IGBT)
M easurement Data Extracted Extracted
Drive Device
M easurement Software M easurement Item Conditions Parameters
[/V Measurement IC-VCE, VCE(sat), Vce(sat)?
or VCE-VGE
Capacitance M easurement Rg Rgb
Cres Qsw®
Gate Charge Measurement Any measurement Vge(on), Qg(on),
items V ge(off), Qg(off),
Ic, Qsw,
Vce Vgs(pl)

a. Extracted from Vge(on)
b. Extracted from V ge(off)
c. Extracted from Vge(off) and V ce(off)
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NOTE

How To Monitor/Control Temperature Under
M easurement

The thermal monitor/control software provides the following functions:

» Therma monitor using the thermocouple
» Thermal control using the inTEST Thermal Plate or ThermoStream
»  Synchronized measurement execution with the thermal conditions

These functions enable the automated measurement execution under the multiple
temperature conditions.

This section describes how to monitor the temperature and execute the measurement
synchronized with the specified thermal conditions using the thermal
monitor/control software and consists of the following sub-sections:

e Preparing the Measurement
e Therma Monitor/Control During Measurement
This section uses the exampl e that monitors the temperature of DUT controlled by

thermal plate and executes the measurement synchronized with the thermal
conditions.
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Figure 3-6 Thermal Monitor/Control Software
2 Temerature Monitor/Control [E=REER)
Eile Edit View Trigger Help

e XoHD P -

~ | Monitor

TriggerStatus Idie
B1506A Ch.1: —- €h.2: Ch.1-2: —
ThermaStream Air: - DUT: ---
) Configuration
B1508A ThermoStream
Thermometer Thermometer GPIB
Reading Time Span 5 s Reading Time Span 5 s VISAAddress: GPIBO::9::INSTR lCUHﬂEEt‘
[# Channel-1 E Air Status: Not connected
¥l channel-2 E our

~ | Optional Commands
) Thermo-Trigger

Preparing the M easurement

Sep 1. Setup the connections of test fixture, thermal plate, thermocouple, and DUT.
For the detail information on connection, see:
» “Accessoriesfor Connecting aDUT” on page 2-28
» “Thermocoupl€” on page 2-30
e “Thermal Plate” on page 2-30

Sep 2. Turn theinstrument on.

Thermal Monitor/Control During M easurement

Step 1. On the software palette, click the Thermal Monitor/Control icon = . The Thermal
Monitor/Control software (Figure 3-6) opens.
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Specify the conditions of thermal monitor at the Thermometer of Configuration area
inthe work area.

This exampl e uses the thermocoupl e connected to the B1506A to monitor the
temperature, so specify at the Thermometer of B1506A.

Reading TimeSpan  Thermal reading interval

Channd 1 Mark the check box if you would like to enable the thermal
monitor for the thermocouple connected to the channel 1
of K Thermocouple terminal on the test fixture.

Channe 2 Mark the check box if you would like to enable the thermal
monitor for the thermocouple connected to the channel 2
of K Thermocouple terminal on the test fixture is enabled.

Specify the conditions of thermo-trigger function

The thermo-trigger function executes the thermo-trigger list, which consists of the
steps for watching on establishment of thermal condition and the steps for thermal
control, sequentially.

If the thermo-trigger function is under execution, the measurement application waits
the establishment of thermal condition and then executes the measurement.

This exampl e set the following thermo-trigger steps:

a  Wait until the temperature of the B1506A thermometer channel 1is25°C+ 1
°C.
If the thermal condition is established, wait for 5 seconds and then output the
measurement trigger to the measurement software.

Wait for the measurement compl etion by the measurement software.
If the measurement is completed, proceed to the next thermo-trigger step.

b. Wait until the temperature of the B1506A thermometer channel 1is30°C+ 1
°C.
If the thermal condition is established, wait for 5 seconds and then output the
measurement trigger to the measurement software.

Wait for the measurement compl etion by the measurement software.
If the measurement is completed, proceed to the next thermo-trigger step.

c. End of the thermo-trigger step.
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Example of Thermo-trigger Steps

# | Thermo-Trigger

Temperature |Channel1 v| Center 25 °oC  Radius 1 oCc  Delay 5 s Action |TRIGGER v|

Temperature |Channel1 v| Center 30 oC Radius 1 |oC Delay 5 s Action |

av|

1. Click the Insert Control button at the bottom of the window.

2. Thelinefor athermo-trigger step isinserted in the Thermo-Trigger.
Specify the condition.

~ | Thermo-Trigger

Temperature |Chanrell v| Center 24 oC  Radius 1 |oc Delay 5 s Action ||

a. Select the target temperature by the drop-down list of second column.
This example selects the Channel 1.
You can selects the followings by this drop-down list:

Channell The temperature monitored by B1506A
thermometer channel 1

Channel2 The temperature monitored by B1506A
thermometer channel 2

Channell 2 Differences between the temperature
monitored by B1506A thermometer channel 1
and channel 2 (Channel 1 - Channel 2)

ThermoStream Air The temperature of air blowing from the
ThermoStream (When using the
ThermoStream)

ThermoSream DUT The temperature monitored by the DUT
thermometer of ThemoStream (When using
the ThermoStream)
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b. Specify the thermal condition.

Center Center value of thermal condition.
This example specified as 25.

Radius Allowable range from the center value for the thermal
condition.
This example specifies as 1.

Delay Delay time after establishment of thermal condition to
execute the specified action.
This example specifiesas 5 (3).

c. Selectsthe action after establishment of thermal condition from the Action
drop-down list.

This example selects the TRIGGER, which outputs the measurement trigger.

You can select the following actions by this drop-down list:

TRIGGER Outputs the measurement trigger.
NOP Does nothing and proceed to the next step.
END Terminates the thermo-trigger list execution.

3. Click the Duplicate button at the bottom of the window to copy the line of
thermo-trigger step and add the copied line to the Thermo-Trigger.

4. Specify the thermal condition of the copied thermo-trigger line.
This example changes the condition of Center to 30 °C.

Opens the measurement software that will synchronized with the thermo-trigger
function and setup the measurement condition on it.

After the measurement setup is completed, leave the software to be opened.

Click the Start button B of the menu bar on the thermal monitor/control software to
start the thermo-trigger function.

The thermal monitor/control software executes the first thermo-trigger step and
waits for the establishment of thermal condition.

Click the Start button B> of the menu bar on the measurement software to start the
measurement.

The measurement software waits for the measurement trigger from the thermal
monitor/control software.
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Control the thermal plate so that the temperature is 25 ° C + 1 °C, which isthefirst
thermal condition.

If the thermal condition is established, the thermal monitor/control software outputs
the measurement trigger to the measurement software.

After receiving the measurement trigger, the measurement software starts the
measurement.

When the measurement is finished, the measurement software outputs the signal of
the measurement compl etion to the therma monitor/control software.

And then, the measurement software waits for the next measurement trigger from
the thermal monitor/control software.

When the thermal monitor/control software receives the signals of measurement
completion, the thermal monitor/control software executes the next thermo-trigger
step and waits for the establishment of thermal condition.

Control the thermal plate so that the temperature is 30 ° C + 1 °C, which isthe next
thermal condition.

If the thermal condition is established, the thermal monitor/control software outputs
the measurement trigger to the measurement software.

After receiving the measurement trigger, the measurement software starts the
measurement under the different thermal condition.
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Displaying and Oper ating Graph

This section describes the common graph operation within the measurement
softwares and consists of the followings:

» How To Select and Display Characteristics Curve

 How To Usethe Marker

How To Select and Display Characteristics Curve

Sep 1. Select the characteristics curvesto display.

Characteristics | Connections

v @ Line ) Dot [ Line & Dot |§| |§|@ |:|

MARKER: 1.9151V

FVGS =6V
FIVGS -9V
FIVGS £ 15V FIVGS =18V | 204.61A

2 v/div.
VDS

The check boxes for the available characteristics are displayed at the upper left on
the graph area.
Mark the check boxes for the desired characteristics to display.

You can select the multiple characteristics to display.

) () (=] (A

Sep 2. Select theline type of curve.
v | @ Line &) Dot ) Line & Dot

&
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By the radio buttons at the top of graph area, you can select the line type of curve
from the Line, Dot, or Line& Dot.

Sep 3. Change the minimum and maximum values of X and Y-axises

If the auto scale mode button |=| is selected, the X and Y-axises of the graph are
automatically changing to fit the measured data during measurement execution.

If the fixed scale mode button [] is selected and the auto-scale button [} is
clicked, the X and Y-axises of the graph are changed to fit the measured data.

Or, you can change the minimum and maximum values of X and Y-axises by
clicking the value.

How To Usethe Marker
You can use the domain marker and/or trace marker to read the value on the curve.

The following table shows the measurement softwares and their furnished marker

function.
Marker Description Applied Software

Domain Marker Vertical line marker. [/V measurement,
Themarker movesinthedirectionof | Capacitance measurement,
X and you can read the X-axisvalue | Gate charge measurement
of the marker and Y-axis val ues of
the intersections of marker and
characteristics curves.

Trace Marker Circle marker. [/V measurement,
The marker moveson a Capacitance measurement,
characteristics curve and you can
read the X and Y-axis values of the
marker.
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Using the domain marker

Step 1. If thetrace marker is displayed, click the trace marker mode button [@] to change to
the domain marker mode L] .

Sep 2. Marker A (Vertical line) is displayed.
Characteristics | Connections

v) @ Line © Dot © Line & Dot |a||E||»_}|E]|_|
MARKER(A): 4.5425V [l MARKER(B): 6 V (8): 1.4575V

FIVGS =4V 85.516 mA I VGS =5V 8.7683A EVGS=6V 57.648 A
FIVGS =7V 151.34A FIVGS =8V NaNA  EVGS =9V NaN A
300 A gvGs=12) NaNA| [JVG5L15V NaNA [ VG5=18V | NaNA

To move the marker, use the rotary nob or mouse.

The MARKER(A): at the upper left of graph area shows the X-axis value of marker A
and the Y-axis value of the intersection of the marker and each characteristics curve
isdisplayed at the right of characteristics curve name.
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Sep 1.

How To Perform Measurement
Displaying and Operating Graph

If the check box at the | eft of the MARKER(B): is marked, the marker B (vertical dot
line) is displayed.
Characteristics '_ Connections ._

v) @ Line © Dot © Line & Dot (@) (L] (] (5] (A
MARKER(A): 1.4437V [J MARKER(B): 1.7534V  (A): 309.77 mV

(A):84.
(

( -
; VGS =18V (A):159.96 A

The following information is displayed at the top of graph area:
MARKER(B): X-axis value of marker B
A) X-axis value of marker B - X-axis value of marker A

The Y-axis values of the intersection of the markers and each characteristics curve,
and the differences of Y-axis values between the mark A interaction and the mark B
interaction (B-A) are displayed at the right of characteristics curve name.

Using the trace marker

If the domain marker is displayed, click the domain marker mode button |E| to
change to the trace marker modg@] .
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Sep 2. Thetrace marker (circle) isdisplayed.

Characteristics | Connections

v @ Line @ Dot (O Line & Dot |a| |*_}|@ |_|

MARKER: 4.5545 V

VGS =4V VGS =5V S 57.649 A
v FvVGsS =8V
300 A mves =12 EVGs £ 15V EVGs =18V

2 v/div.
VDS

You can move the trace marker on the characteristics curve using the rotary nob or
mouse.

The MARKER: at the upper left of graph shows the X-axis value of the marker and
the Y-axisvalueis displayed at the right of the characteristics curve name.
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GUI Reference

Keysight Easy Test Navigator software provides dedicated measurement software
for power device characterization. It supports various types of measurement tasks
with ease-of-use and simple operation.

This chapter describes reference information of the Keysight Easy Test Navigator
software, and covers the following topics.

» “Software Palette”

» “Datasheet Characterization Software”

* “l/V Measurement Software”

» “Capacitance Measurement Software’

» “Gate Charge Measurement Software”

* “Power Loss Calculation Software”

*  “Thermal Monitor/Control Software”

For how to perform the measurements, see Chapter 3.

For the EasyEXPERT software, see EasyEXPERT User’s Guide.
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Softwar e Palette

The Software Palette provides a complete list of the B1506A's measurement
software and also allows this software to be launched. The Software Palette lists
icons with the measurement software names. You can start a measurement software
by clicking an icon or a software name, or by pressing a softkey corresponding to
the software. Seven softkeys are available for this purpose at the right next to the
LCD of thisinstrument.

The Software Pal ette is displayed in full screen mode after powering up the B1506A.
The Software Palette can be minimized to access the Windows desktop.

The following shows the icons and texts displayed on the Software Palette, and
actions by clicking them.

Datasheet Starts the datasheet characterization software. See “ Datasheset
Characterization  Characterization Software” on page 4-5.

E—;—

P I/V Measurement  Startsthe |/V measurement software. See “1/V Measurement Software”
— on page 4-43.
S
\\\___
i

= Capacitance Starts the capacitance measurement software. See “ Capacitance
f— M easurement Measurement Software” on page 4-75.
Gate Charge Starts the gate charge measurement Software. See “ Gate Charge
M easurement Measurement Software” on page 4-104.
Power Loss Starts the power loss cal cul ation software. See “ Power Loss Calculation
Calculation Software” on page 4-127.
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Thermal

M onitor/Control

Minimize

Exit

GUI Reference
Software Palette

Starts the thermal monitor/control software. See “ Thermal
Monitor/Control Software” on page 4-148.

Minimizes the Software Palette. Thisis useful when you access the
Windows desktop. When you click the icon on the taskbar, the Software
Pal ette appears again.

Exits the software pal ette and opened measurement software. This
button is displayed if you move the mouse pointer over the upper right
corner.

When you use the EasyEXPERT software or you update the Easy Test
Navigator software, use this button to exit the Easy Test Navigator
software in advance.

4-4
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Datasheet Characterization Software

The datasheet characterization software measures various characteristics parameters
and graphs of the I/V characteristics, capacitance characteristics, and gate charge
characteristics described on a device datasheet. This software has the following
features.

* A simple operating environment that can measure arange of device parameters
and characteristics using a familiar datasheet-like format

* To enter measurement conditions in a datasheet-like format
« To set sweep output start/stop by using graph minimum/maximum

» Todisplay measured parameters and characteristics in a datasheet-like
format

e Toautomatically compare measurement results with expected values

» Minimal software learning curve for device characterization using the following
templates installed with the software

e MOSFET
« |IGBT
* Diode

e Component

A template is a setup and measurement datafile only for this software. It is
caled asETN DSfile.

» To effectively get the data not covered by the manufacturer's datasheet

For details of the templates furnished with this software, see “Parameters Defined in
Furnished Templates’ on page 4-29. And, for how to create an ETN DSfile to be
fitted to real devices, see " Creating Custom Fil€’ on page 4-41.
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GUI Overview

The GUI (Graphical User Interface) of the datasheet characterization softwareis
comprised of the following areas.

Figure4-1 Datasheet Characterization Software GUI

8 Uata Sheet ey )
3— Elle Edit View Messurement Zetup Configuration Help

GQNESE XdAm wo [FeF - x =
- Identification Dewvlce Type: |Disde  =[ /0

A part numper: 5876-5432 .
g l/.. Y

Sampie I0:

Deseription:

b Maximnm Kaatings

Symbaol Parameter Test Conditions Value Unit Note
VR Reversa Voltage T)=25 °C ta 150 °C !
I Pulsed Forward Current Te=25 *C A

l_ = CNaracienshcs Parameners
c Characteristlcs Parameters
Symbeol Perarne ter Test Conditions Min. Act. Max.  Unit Nalfe

Voo DC Blocking Voltage IR=100 A
VF Farward Voltage IF=30 A, Pulsewidth=200 us 1.51

13 Reverse Current VR

[ Tatal Capacitancs VR=30 V, f=100 kM2

[<l<][<][e]

~ | Charactaristics Graphs

[¥] CI ] =

2— ~ Automatic Data Save Device ID: Device-1 = Comment: 1h) vata: | X |{&]| MosFELpda-ds.a

1. Work Area (Seep. 4-7.)

This area provides the functions to set the measurement conditions and observe
the measurement results. Thisis separated to the following aress.

a. ldentification (Seep. 4-7.)
b. Maximum Ratings (See p. 4-9.)
¢. Characteristics Parameters (See p. 4-10.)
d. Characteristics Graphs (See p. 4-12.)
2. Automatic Data Save (See p. 4-15.)
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a b
~ Identification Device Type: |MOSFET -d|

" Part Number:
- Sample ID:

Q —+~D0Qa0

GUI Reference
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This area provides the functions regarding the automatic saving of the ETN DS
files. The ETN DSfile can have the setup data and measurement data, and it is
only for this software.

3. Operating Tools

e Toolbar (Seep. 4-17.)

This provides the functions that are very frequently used in the button
format.

e Main Menu (Seep. 4-20.)

This provides the functions needed for various operationsin the menu
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes’
on page 4-25.

For the files handled by this software, see “ Summary of Files’ on page 4-26.

Work Area

In this area, set the measurement conditions and observe the measurement results.
Thisis separated to the following areas.

Identification (See p. 4-7.)

Maximum Ratings (See p. 4-9.)
Characteristics Parameters (See p. 4-10.)
Characteristics Graphs (See p. 4-12.)

| dentification

Thisisan areato select the device type of the device under test (DUT) and enter the
identification information for the DUT.

This area can be hidden or shown by clicking the line of (~' Identification.

Description:

* Operator:

Identification

0123-4567

MOSFET001

Sample

John H Smith =

- Measurement Instrument: B1506A
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a. Device Type

Lists the following device types. Select the device type of the DUT from them.

e MOSFET

MOSFET is selected. For details of the measurement items, see “MOSFET
Template” on page 4-29.

« IGBT

IGBT is selected. For details of the measurement items, see “1GBT
Template” on page 4-34.

* Diode

Diodeis selected. For details of the measurement items, see “Diode
Template” on page 4-39.

¢ Component

Displays a pop-up menu for selecting a component type appears as shown
below. Click this menu and select on from the displayed component types.

Device Type: |Component - |Inductor vl D|

Capacitor
ShuntResistor
Resistor
Connector
Cable

Relay

ings PhotoCoupler
SolidStateRelay

b. New Datasheet button /]
Creates anew ETN DS file using the selected template.

nstrument:

Reads a furnished template specified by the device type selection, opens new
ETN DSfile (measurement conditions and measurement data), and shows the
measurement conditions and measurement data defined in the template in thein
the Maximum Ratings, Characteristics Parameters, and Characteristics Graphs
aress.

c. Part Number
Enter a par number of your DUT. It is stored to the present ETN DSfile.
d. SamplelD
Enter aDevice ID to identify your DUT. It is stored to the present ETN DSfile.
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Description

Enter a device description and so on. It is stored to the present ETN DSfile.
Operator

Enter operator information. It is stored to the present ETN DSfile.
Measurement | nstrument

Enter measurement instrument information. It is stored to the present ETN DS
file.

Device Circuit Symbol

Displays the device circuit symbol corresponding to the selected device type. If
you click over thisfield, the following pop-up menu is displayed.

System Picture
Displays the default circuit symbol.

Import Picture
Opens the Open Picture dialog box used to display a
specified imagefile.

Clear Picture Clears the present picture.

Maximum Ratings

Thisisan areato set up the maximum ratings of your DUT. The entered maximum
rating values are used as the limits for the measurement conditions of the
characteristics measurement items.

You can change the column order in this table by dragging a column header.

This area can be hidden or shown by clicking the line of (~’ Maximum Ratings.

Figure4-3 Maximum Ratings
I~ Maximum Ratings
I laximum Ratings
Symbol Parameter Test Conditions Value Unit Note
I vDSS Drain to Source Voltage Tj Min. 25 °C E\ v
Max. 150 °C
VGSS Gate to Source Voltage Conitnuous Min. [E\ v
Max.
IDM Pulsed Drain Current Tc=25 °C A
1M Pulsed Body Diode Current Tc=25 °C A

a. Symbol
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Symbol of arating parameter. You can edit this by clicking on the text.
b. Parameter

Name of arating parameter. You can edit this by clicking on the text.
c. Test Condition

Condition valuesfor arating parameter. You can edit this by clicking on the text.
To close the expanded edition fields, click the Close button %],

d. Vaue

Rating value. You can edit this by clicking on the text. To close the expanded
edition fields, click the Close button (%],

e. Unit
Shows a unit for the rating value.
f. Note
Enter aremark for the rating value. It is stored to the present ETN DSfile.

Characteristics Parameters

Thisisan areato set up the characteristics parameter measurements. A line has the
measurement conditions for a characteristics parameter.

To select a characteristics parameter, click on the blank space (excepting edition
fields) of itsrow. The selected row is highlighted.

You can change the column order in this table by dragging a column header.

This area can be hidden or shown by clicking the line of (»' Characteristics
Parameters.

Figure4-4 Characteristics Parameters
ab c f g h | J
|~ Fnarefteristics parameters
Characteristifs Parameters
Symbol Parameter Test Conditions Min. Act. Max.  Unit Note
BVDSS Drain to Source Breakdown Volt: VGS 0 v (5] 100 135 v
Y] o T
J [:‘ 1DSS Drain Leakage Current VDS=100 V, VGS=0 V 359 p 10p A
J E‘ 1GSS Gate Leakage Current VGS=20V, VDS=0 V 350 p 200n A
J [:‘ 1GSS(-) Gate Leakage Current (-) VGS=-20 V, VDS=0 Vv -200n  -350 p A
| [El] ves(th) Gate to Source Threshold Volta D=1 mA 2 3.6 4 v
v VGS(th)  Gate to Source Threshold Volta-  vps=10 v, ID=1 mA 2 3.44 4 v
| [E7] RDS(on)  Drain to Source On Resistance VGS=15 V, ID=50 A, PulseWidth=200 ps 7.02m 15m ohm
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a  Check box
Mark thisfor a characteristics parameter to be measured.
b. Measurement Priority

You can set the priority of the measurement execution for each measurement
item. As default, all items are set to 1st priority. Click the button on the
right-hand side of the check box to select the priority level.

[ ]: 1t priority
&1 2nd priority
: 3rd priority

For the execution order of the measurement items, see “ Execution Order of
Measurement Items’ on page 4-14.

c. Symbol

Symbol of a characteristics parameter. You can edit this by clicking on the text.
d. Parameter

Name of a characteristics parameter. You can edit this by clicking on the text.
e. Test Conditions

M easurement condition values to measure a characteristics parameter. You can
edit this by clicking on the text. To close the expanded edition fields, click the
Close button (%]

f. Min.

Lower limit value of the expected range for the measured characteristics
parameter value. Leave ablank if thereis no lower limit.

g. Act.
Shows an actual measured value of a characteristics parameter.

The measured valueis displayed in red italic typeif it is out of the expected
range from “Min.” to “Max.”.

h. Max.

Upper limit value of the expected range for the measured characteristics
parameter value. Leave ablank if there is no upper limit.

i. Unit
Unit for a characteristics parameter.

j- Note
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Enter aremark for the characteristics parameter value. It is stored to the present
ETN DSfile.

Characteristics Graphs

Thisisan areato set up the measurements for obtaining the characteristics graphs.
Set the measurement conditions on each graph.

To select a characteristics graph, click on the graph. The outer frame of the selected
graph is highlighted.

This area can be hidden or shown by clicking the line of (»' Characteristics Graphs.

Characteristics Graphs

]

d— o line Dot Line&Dot|A

-
€
o
e
£
5

[&]

£
e

(=]

Transfer Characteristics

Drain Current

1 V/div. 1 v/div.

Drain to Source Voltage

Gate to Source Voltage

a  Check box

Mark thisfor a characteristics graph to be measured.

b. Measurement Priority

You can set the priority of the measurement execution for each measurement
item. As default, all items are set to 1st priority. Click the button on the
right-hand side of the check box to select the priority level.

1 1st priority
& 2nd priority
: 3rd priority
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For the execution order of the measurement items, see “ Execution Order of
Measurement Items’ on page 4-14.

c. Graph tool button
Shows or hides the graph toals at the top of the graph.
d. Graphtools

You can do below using the graph tools.

» Trace Representation
You can select one from the following trace representations.

The curves can be represented as Line, Dot, or combination (Line & Dot).
Select any trace representation using the radio buttons shown in the bottom
part of the graph.

* Line

Plots a line between two measurement points.
* Dot

Represents the measurement points by dots.
* Line& Dot

Represents the measurement points by dots and plots a line between two
measurement points.

¢ Tracelabel button{Al

Shows or hides labels to distinguish multiple traces on the graph.
e X/Y-axes scales

You can select scales for the X and Y-axes from the following.

e Linear
Linear scale
» Positivelog

Logarithm scale for positive data
* Negativel og
Logarithm scale for negative data
e. Graph

Keysight B1506A User’s Guide, Edition 2 4-13



GUI Reference
Datasheet Characterization Software

Shows the measured characteristics graph.

You can change the minimum and maximum values on the X and Y-axes by
clicking on the values.

For X and Y-axes of the voltage or current output values, enter the minimum and
maximum values on X and Y-axes to specify the measurement range.

Execution Order of Measurement ltems

After starting the measurement, the marked measurement items are executed in the
following order, depending on the measurement priority setting, the kind of
measurement, the location of the measurement item, and need of the adapter
changing.

1. Measurement Itemsrelated to I/V or Capacitance M easurement
a. 1st Priority Measurement items

1. Measurement Itemsin the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

b. 2nd Priority Measurement Items

1. Measurement Itemsin the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

c. 3rd Priority Measurement Items

1. Measurement Itemsin the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

2. (Changing operation of the adapter)
3. Measurement Items related to Gate Charge M easurement

a. 1st Priority Measurement items
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1. Measurement Items in the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

b. 2nd Priority Measurement Items

1. Measurement Itemsin the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

¢. 3rd Priority Measurement Items

1. Measurement Items in the Characteristics Parameters area are executed
in the order from top to bottom.

2. Measurement items in the Characteristics Graphs area are executed in
the order of top left, top right, left on second row, right on second row, ...,
bottom left, and bottom right.

Automatic Data Save

This area sets the automatic saving for all setup data including the measurement
conditions and all measurement data. These data are automatically saved to a new
ETN DSfile in the specified folder at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line
of (¥) Automatic Data Save.

Figure 4-6 Automatic Data Save
) Automatic Data Save Device ID: Device-1 + Comment: lﬁ‘ Data: E@‘ MOSFET-Sample.pda-ds.zip
Data folder: C:¥Users¥User1¥Documents¥Keysight¥SeriesB150x¥PowerDeviceAnalyzer¥Datasheet¥DataStore f Browse...
Recent data: ‘-]]Q’-’gm ‘
DevicelD Enter device ID string to the Device ID field. The maximum 10

recently-entered device | Ds can be kept as history, and you can
also select one from the history list.

The entered device ID is automatically saved to the ETN DS
file at the end of the measurement.
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You can also change the device ID in the latest ETN DSfile
after the measurement here. To change it, change the device ID
inthe Device ID field, and then click the Apply button & .

Comment Enter acomment string to the Comment field.

The entered comment is automatically saved to the ETN DSfile
at the end of the measurement.

You can also change the comment in the latest ETN DSfile
after the measurement here. To change it, change the comment
in the Comment field, and then click the Apply button & .

Data The Datafield shows the latest auto-saved or last-opened ETN
DS file name. You can do the following operations.

» Openthe ETN DSfile by clicking the Open button g .
* Renamethe ETN DSfile by clicking the ETN DS file name.
« Deletethe ETN DSfile by clicking the Delete button X |.

Data folder Shows the absol ute path of the auto-saved ETN DSfile To
changethis, click the Browse button to open the folder selection
dialog box. Select your desired folder in the dialog box.

For theinitial setting of the datafolder, see“ Summary of Files’
on page 4-73.

Recent data Shows up to 10 auto-saved ETN DS files that were
automatically saved recently, in the hyper-link format. Clicking
the hyper-link opensthe selected ETN DSfile Thisdestroysthe
presently-editing data.

If the number of the auto-saved ETN DSfilesis over ten, this
field shows “more...”. Clicking this opens the file selection
dialog box. Select aETN DSfile to open.
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Toolbar

Toolbar
GQuNSE XdaE %o @eF X, 00E

The toolbar has five tool button groups. The following shows the tool buttonsin the
tool button groups.

File tool button group

& Open Opens the Open File dialog box used to open a
specified ETN DSfile. All present setup data and
measurement data are cleared by opening the file.

[T Save Saves the present setup data and measurement data as
the same file name.

=1 Print Prints the present setup data and measurement datato
the specified printer in the datasheet format, or to a
document file in the XPS or PDF format.

ﬁ Exit Exits the datasheet characterization software. Unsaved
datais destroyed.

Edit tool button group

X Cut Moves the selected text to the clipboard.
gl Copy Copies the selected text to the clipboard.
K| Paste Pastes the text from the clipboard to the insertion point.
On-screen Displays the on-screen keyboard.
keyboard

M easurement tool button group
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p.. Sart without
" datacleared
. Sart with
0 datacleared
NOTE
m Sop
M easurement

Setup tool button group

Sart Options

All Check/

Uncheck

Starts to measure the marked measurement itemsin
seguence. At the starting point, the existing
measurement data for the all measurement itemsis
cleared. During the measurement, the measurement
status indicator on the front panel lights up.

Starts to measure the marked measurement itemsin
seguence. At the starting point, the existing
measurement data for the marked measurement itemsis
cleared, but the measurement data for the unmarked
itemsis retained. If the measurement is aborted, the
measurement data acquired before aborting is retained.
During the measurement, the measurement status
indicator on the front panel lights up.

The above two Start buttons are switched depending on
the setting of the Start Options described below.

Stops the measurement.

You can aso use the Measurement > Stop menu or the
Stop key on the front panel to stop the measurement.

Displaysthe following menu items to set the option for
the Start tool button.

*  Without data cleared
* With data cleared

This button indicates three statuses whether al of the
measurement items (characteristics parameters and
graphs) are objects to be measured.

This status shows that all measurement items are not
objects to be measured. If clicking this button under
this status, the check boxes of all measurement items
are marked to set to objects to be measured.

This status shows that some measurement items are
objects to be measured. If clicking this button under
this status, the check boxes of all measurement items
are marked to set to objects to be measured.

Keysight B1506A User’s Guide, Edition 2



GUI Reference
Datasheet Characterization Software

This status shows that all measurement items are
objects to be measured. If clicking this button under
this status, the check boxes of all measurement items
are unmarked to set to no objects to be measured.

ro! Setup Sets up the measurement of the selected measurement
item in detail.

Launches one of the following software corresponding
to the selected measurement item.

* “l/V Measurement Software’
e “Capacitance Measurement Software’
e “Gate Charge Measurement Software’

You can adjust and change the measurement conditions
that are not included in the datasheet, and try to
measure the measurement item.

5 Import Imports data in ameasurement data file created by
other measurement software to the setup and
measurement data of the measurement item highlighted
(selected) in the Characteristics Parameter area or
Characteristic Graphs area.

It isuseful when you need to import the existing datato
anew additional measurement item or replace the setup
and measurement data with the existing data.

Duplicate Makes a duplicate of the measurement item highlighted
(selected) in the Characteristics Parameters area or
Characteristics Graphs area.
The duplicated item is placed after the highlighted item.

It is useful when you need to measure the same
characteristics parameter with multiple conditions.

X Delete Deletes the measurement item highlighted (selected) in
the Characteristics Parameters area or Characteristics
Graphs area.

View tool button group
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Page Up Scrolls up.

M Page Down Scrolls down.

GotoPalette  Displays the Software Palette in full screen mode.

Main Menu

Main Menu

| File Edit WView Measurement Setup Configuration Help
The following describes the functions of the main menu.

Displays the following menu items to operate the ETN DSfile. For the file types
and extensions, see “ Summary of Files’ on page 4-26.

New Clearsall present setup data and measurement datato start from
initial setting.
Open... Opens the Open File dialog box used to open a specified ETN

DSfile. All present setup data and measurement data are
cleared by opening thefile.

Save Saves the present setup data and measurement data as the same
file name.
SaveAs... Opens the Save Data File dialog box used to save the present

setup data and measurement data as the specified file.

You can also save the setup data and measurement datato a text
file (.txt).

Print... Prints the present setup data and measurement data to the
specified printer in the datasheet format, or to adocument filein
the XPS (XML Paper Specification) format.

To print to an XPSfile, select the Microsoft XPS Document
Writer as a printer in the Print dialog box.

If the PDF Writer/Printer is available, you can also print the
present setup data and measurement data to a document filein
the PDF format.
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View Menu

Change Device
ID...

Recent Setup Files

Exit
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Changes the device ID recorded in the ETN DSfile

This opens the Change Device ID dialog box, and changes the
device D recorded in the selected ETN DSfile(s). See“Change
Device ID Dialog Box” on page 4-25.

Lists amaximum of 10 names of the ETN DS files that were
recently edited, as menu items. You can easily open aETN DS
file by using them.

Exits the datasheet characterization software. Unsaved datais
destroyed.

Displays the following menu items to edit the setup.

Cut

Copy
Paste

On-screen
keyboard...

Moves the selected text to the clipboard.
Copies the selected text to the clipboard.
Pastes the text from the clipboard to the insertion point.

Displays the on-screen keyboard.

Displays the following menu items for the display setting.

Goto Palette
Page

Main Window

Displays the Software Palette in fullscreen mode.

Displays the following menu items used the page scrolling.
Up Scrolls up.

Down Scrolls down.

Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.
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Setup Menu
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Color Settings...

Opens the Color Setting dialog box to set the color for partsin
this software. See “ Color Setting Dialog Box” on page 4-25.

Displays the following menu items for controlling the measurement.

Sart with data
cleared

Sart without data

cleared

Sop

Starts to measure the marked measurement items in sequence.
At the starting point, the existing measurement data for the all
measurement itemsis cleared. During the measurement, the
measurement status indicator on the front panel lights up.

Starts to measure the marked measurement items in sequence.
At the starting point, the existing measurement data for the
marked measurement items is cleared, but the measurement
datafor the unmarked itemsis retained. If the measurement is
aborted, the measurement data acquired before aborting is
retained. During the measurement, the measurement status
indicator on the front panel lights up.

Stops the measurement.

You can also use the Stop Measurement buttonE  on the tool bar
or the Stop key on the front panel to stop the measurement.

Displays the following menu items for setting up the measurement items.

Check All

Uncheck All

Setup

Marks the check boxes of all characteristics parameters and
graphs to measure all of them.

Unmarks the check boxes of all characteristics parameters and
graphs to not measure all of them.

Sets up the measurement of the measurement item highlighted
(selected) in the Characteristics Parameters area or
Characteristics Graphs areain detail.

Launches one of the following software corresponding to the
selected measurement item.

e “l/V Measurement Software”
» “Capacitance Measurement Software’
e “Gate Charge Measurement Software”

You can do the following tasks on the launched software.
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« Adjusting and changing the measurement conditions that
are not included in the datasheet.

e Trying to measure the measurement item.
(The measurement result is automatically reflected onto the
datasheet characterization software GUI.)

If you adjusted some measurement conditions without the
measurement execution, save the setup data on the launched
software. Thiswill reflect this change to the ETN DS file when
saving the ETN DS file on the datasheet characterization
software.

Imports datain a measurement data file created by the
following measurement software to the setup and measurement
data of the measurement item highlighted (selected) in the
Characteristics Parameter area or Characteristic Graphs area.

e “l/V Measurement Software”
» “Capacitance Measurement Software’
* “Gate Charge Measurement Software”

Dataimport can be done as follows.

1. Highlight (select) the target measurement item.
2. Select Setup > Import menu.

The Open Data dialog box opens.

Astheinitial importing folder, the initial saving folder of
the measurement software related to the highlighted itemis
opened.

3. Select ameasurement datafile to import the setup and
measurement data corresponding to the highlighted item.

As above, the existing the setup and measurement data for the
highlighted item are cleared, and the setup and measurement
data are imported from the specified measurement datafile.

It is useful when you need to import the existing data to a new
additional measurement item or replace the setup and
measurement data with the existing data.

Makes a duplicate of the measurement item highlighted
(selected) in the Characteristics Parameters area or
Characteristics Graphs area.
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Duplicate can be done as follows.

1. Highlight (select) the target measurement item.

2. Select Setup > Duplicate menu.
The duplicated item is placed after the highlighted item.

It is useful when you need to measure the same characteristics
parameter with multiple conditions.

Delete Deletes the measurement item highlighted (selected) in the
Characteristics Parameters area or Characteristics Graphs area.

Configuration Menu Displays the following menu item to administrate the configuration of the built-in
modulesin the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module
Configuration Dialog Box” on page 4-168.
Help Menu Displays the following menu item.
About... Opens the about box. See “About Box” on page 4-26.
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Change Device I D Dialog Box

The Change Device ID dialog box is used to change the device ID in all selected
ETN DSfilesat once.

This dialog box is opened by selecting the main menu File > Change Device ID....

DeviceID field
Add... button

Remove button
Execute button

Close button

Enter anew device ID. You can also select it from the history.

Opens the file selection dialog box to select the ETN DSfile(s)
that you want to change the device ID. The selected ETN DS
files are displayed into the list.

Excludes the selected ETN DS file from the list.
Changes the device ID.
Closes this dialog box.

Color Setting Dialog Box

The Color Setting dialog box is used to set colors of the following partsin this
software. The setting in the Color Setting dialog box is saved as a user setting.

*  Window Background

» Graph Background

» Graph Axis
» Graph Grid
» Graph Text

e Trace

This dialog box is opened by selecting the main menu View > Color Settings....

Clicking the color pattern opens the dialog box for selecting a color.

Apply button
Reset button
OK button

Cancel button

Applies the present setting to the graph.
Resets to the default setting.

Applies the present setting to the graph, and closes this dialog
box.

Closes this dialog box without applying the present setting.
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About Box

The about box displays the model humber, the software revision number, download
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files

The following shows the summary of the files handled by the datasheet

characterization software.

Table4-1 Summary of Files
File Type Description Extension Folder asInitial Setting

ETN DSfile File only for this software. Thishasthe | *.pda-ds.zip | C:\Users\<user name>\
measurement conditions and Documents\K eysight\Seri
measurement data for all measurement esB150x\PowerDeviceAn
itemsincluding the device ID and alyzer\Datasheet\DataSto
comment. re
The measurement conditions and (You can change this)
measurement data are automatically
saved to thisfilein the specified folder
at the end of the measurement. And,
you can aso save thisusing the File
menu anytime.

Text output file | This has the measurement conditions * txt (You can specify the
and measurement data for all folder when saving the
measurement items including the data)
device ID and comment in the text
format.
You can save this using the File menu
anytime.

AY; For importing. Thisis a measurement * pda-iv.txt C:\Users\<user name>\

M easurement datafile created by the I/V Documents\K eysight\Seri

DataFile measurement software, and has the esB150x\PowerDeviceAn
setup data and measurement data for alyzer\IV\DataStore
the 1/V measurement. (You can change this)
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File Type Description Extension Folder asInitial Setting
Capacitance For importing. Thisis a measurement * pda-cap.txt | C:\Users\<user name>\
M easurement datafile created by the capacitance Documents\K eysight\
DataFile measurement software, and has the SeriesB150x\PowerDevic
setup data and measurement data for eAnalyzer\DeviceCapacit
the capacitance measurement. ance\DataStore
(You can change this)
Gate Charge For importing. Thisisameasurement | *.pda-qg.txt | C:\Users\<user name>\
M easurement datafile created by the gate charge Documents\K eysight\
DataFile measurement software, and has the SeriesB150x\PowerDevic
setup data and measurement data for eAnalyzer\GateCharge\D
the gate charge measurement. ataStore
(You can change this)
XPS output file Output file in X PS® format * Xps (You can specify the

folder when printing this
file)

a. XPS (XML Paper Specification) is the standard document format on Windows.

Filenameof ETN DS File on Auto-saving

An auto-saved ETN DSfile is named as follows:

<Devicel D>_<TEMP> <TIME>.pda-ds.zip

<DevicelD>: DevicelD
<TEMP>: Temperature
<TIME>:

Example)

Time stamp on auto-saving

Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-ds.zip

And, the file name is decided according to the following rule.

1. <TEMP> isthe characters of the available thermometer identifiers and the
thermometer readings. To enable thermometers, use the Thermal
Monitor/Control Software. See “ Thermal Monitor/Control Software” on page

4-148.

@<thermometer>=<reading>degC

* <thermometer>: An identifier of the available thermometer
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Chl Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the ThermoStream
DUT Thermometer on the DUT port of the ThermoStream

« <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are avail able, the temperature information is
concatenated by an underscore (). The @ is attached only at the beginning
of the temperature information.

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> isthe characters of year, month, day, hour, minute, and second. The
time stamp representation depends on the time setting on Windows. And, an
invalid character is replaced with an underscore ().

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If thefile name duplicates the existing file name, the serial number from 2
enclosed by brackets is concatenated before the file extension.
Example)
Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-ds.zip
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Parameter s Defined in Furnished Templates
This section provides the maximum ratings and characteristics measurement items
defined in the representative templates furnished with this software.

MOSFET Template

The section shows the maximum ratings and characteristics measurement items
defined in the template for the MOSFET devices using some tables.

The following table shows the maximum rating parameters defined in this template.

Maximum Ratings

Parameter Symbol
Drain to Source Voltage VDSS
Gate to Source Voltage VGSS
Pulsed Drain Current IDM
Pulsed Body Diode Current ISM

The following table shows the characteristics parameters that are defined in this
template.

You can specify values to the parameters described in the Conditions column of the
following table, asthe measurement conditions. And, the rating parameter described
in the Ratings column is used as the limit for the measurement conditions.

Char acteristics Parameters

Par ameter Symbol Conditions Ratings
Drain to Source Breakdown BVDSS ID IDM
Voltage
VGS VGSS
Drain Leakage Current IDSS VDS VDSS
VGS VGSS
Gate Leakage Current IGSS VGS VGSS
VDS VDSS
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Parameter Symboal Conditions Ratings

Gate Leakage Current (- ) @ IGSS(-) VGS VGSS
VDS VDSS

Gate to Source Threshold Voltage? | VGS(th) ID IDM

Gateto Source Threshold Voltage | VGS(th) VDS VDSS

(Constant Drain to Source Voltage) D .y

Drain to Source On Resistance RDS(on) VGS VGSS
ID IDM
PulseWidth

Drain to Source On Voltage VDS(on) VGS VGSS
ID IDM
PulseWidth

Body Diode Forward Voltage VSD IS ISM
VGS VGSS

Gate Resistance Rg VGS VGSS
f

Input Capacitance Ciss VDS VDSS
VGS VGSS
f

Output Capacitance Coss VDS VDSS
VGS VGSS
f

Reverse Transfer Capacitance Crss VDS VDSS
VGS VGSS
f
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Parameter Symbol Conditions Ratings

Total Gate Charge Qg Vds VDSS

Vgs(on) VGSS
V gs(off) VGSS
Id IDM

Gate to Source Charge Qgs Vds VDSS

Vgs(on) VGSS

V gs(off) VGSS

Id IDM

Gateto Drain Charge Qagd Vds VDSS

Vgs(on) VGSS

V gs(off) VGSS

Id IDM

Gate to Source Plateau Voltage Vgs(pl) Vds VDSS

Vgs(on) VGSS
V gs(off) VGSS
Id IDM

a. Thisisameasurement with a negative voltage.
b. The same voltageis forced to between the drain-source terminals and
the gate-source terminals at the measurement.

The following table shows the characteristics graphs that are defined in this
template.

The X and Y in the Symbol column show the measurement data specified as the X
and Y-axes data on the graph. And, the rating parametersin the X and Y of the
Ratings column are used as the limit for the measurement conditions.

Keysight B1506A User’s Guide, Edition 2 4-31



GUI Reference
Datasheet Characterization Software

Table 4-4 Characteristics Graphs
Symbols Ratings
Characteristics
X Y X Y

Output Characteristics VDS | ID VDSS | IDM
Transfer Characteristics VGS | ID VGSS | IDM
Drain to Source Resistance vs. Drain ID RDS IDM
Current
Drain to Source Resistance vs. Gate to VGS | RDS | VGSS
Source Voltage
Drain to Source Voltage vs. Gateto Source | VGS | VDS | VGSS | VDSS
Voltage
Body Diode Forward Characteristics VSD | IS VDSS | ISM
Capacitances vs. Drain to Source Voltage VDS | Ciss, VDSS

Coss,

Crss
Gate Charge Characteristics Qg Vgs VGSS

The following describes about the symbols in the Conditions column of Table 4-3
on page 4-29 and in the Symbols column of Table 4-4 on page 4-32.

Table 4-5 Glossary of MOSFET Template
Symbol Description
VGS Gate-source voltage
VDS Drain-source voltage
ID Drain current

PulseWidth | Pulse width of drain current/voltage

f AC signal frequency
IS Body diode forward current (source current)
VSD Body diode forward voltage (source-drain voltage)
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Symbol Description
RDS Drain-source resistance
Ciss Input capacitance
Coss Output capacitance
Crss Reverse transfer capacitance
Qg Gate charge
Vgs Gate-source voltage (gate charge measurement)
Vgs(on) Gate-source “On-state” voltage (gate charge measurement)
V gs(off) Gate-source “ Off-state” voltage (gate charge measurement)
Vds Drain-source “Off-state” voltage (gate charge measurement)
Id Drain “On-state” current (gate charge measurement)
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IGBT Template

The section shows the maximum ratings and characteristics measurement items
defined in the template for the IGBT devices using some tables.

The following table shows the maximum rating parameters defined in this template.

Maximum Ratings

Parameter Symbol
Collector to Emitter Voltage VCES
Gate to Emitter Voltage VGES
Pulsed Collector Current ICM
Pulsed Freewheeling Diode Current IFM

The following table shows the characteristics parameters that are defined in this
template.

You can specify values to the parameters described in the Conditions column of the
following table, asthe measurement conditions. And, the rating parameter described
in the Ratings column is used as the limit for the measurement conditions.

Characteristics Parameters

Parameter Symbol Conditions Ratings
Collector to Emitter Breakdown BVCES IC ICM
Voltage
VGE VGES
Collector Leakage Current ICES VCE VCES
VGE VGES
Gate Leakage Current IGES VGE VGES
VCE VCES
Gate Leakage Current (-) @ IGES() VGE VGES
VCE VCES
Gate to Emitter Threshold Voltage? | VGE(th) IC ICM
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Parameter Symboal Conditions Ratings

Gate to Emitter Threshold Voltage | VGE(th) VCE VCES

(Constant Collector to Emitter

Voltage) IC ICM

Collector to Emitter Saturation V CE(sat) VGE VGES

Voltage . =y
PulseWidth

Freewheeling Diode Forward VF IF IFM

Voltage VF VCES

Gate Resistance Rg VGE VGES
f

Input Capacitance Cies VCE VCES
VGE VGES
f

Output Capacitance Coes VCE VCES
VGE VGES
f

Reverse Transfer Capacitance Cres VCE VCES
VGE VGES
f

Total Gate Charge Qg Vce VCES
Vge(on) VGES
V ge(off) VGES
IC ICM
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Parameter Symbol Conditions Ratings

Gate to Emitter Charge Qge Vce VCES

Vge(on) VGES

V ge(off) VGES

Ic ICM

Gateto Collector Charge Qgc Vce VCES

Vge(on) VGES

V ge(off) VGES

Ic ICM

Gate to Emitter Plateau Voltage Vge(pl) Vce VCES

Vge(on) VGES

V ge(off) VGES

Ic ICM

a. Thisisameasurement with a negative voltage.
b. The same voltageisforced to between the collector-emitter terminals
and the gate-emitter terminals at the measurement.

The following table shows the characteristics graphs that are defined in this
template.

The X and Y in the Symbol column show the measurement data specified as the X
and Y-axes data on the graph. And, the rating parametersin the X and Y of the
Ratings column are used as the limit for the measurement conditions.
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Table 4-8 Characteristics Graphs
Symbols Ratings
Characteristics

X Y X Y
Output Characteristics VCE | IC VCES | ICM
Transfer Characteristics VGE | IC VGES | ICM
Collector to Emitter Voltage vs. Gate to VCE | VGE | VCES | VGES
Emitter Voltage
Freewheeling Diode Forward VF IF VCES | IFM
Characteristics
Capacitances vs. Collector to Emitter VCE | Cies, VCES
Voltage Coes,

Cres
Gate Charge Characteristics Qg Vge VGES
The following describes about the symbols in the Conditions column of Table 4-7
on page 4-34 and in the Symbols column of Table 4-8 on page 4-37.
Table4-9 Glossary of IGBT Template
Symbol Description

VGE Gate-emitter voltage
VCE Collector-emitter voltage
IC Coallector current
PulseWidth | Pulsewidth of collector current/voltage
f AC signal frequency
IF Free-wheel diode forward current
VF Free-wheel diode forward voltage
Cies Input capacitance
Coes Output capacitance
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Symbol Description
Cres Reverse transfer capacitance
Qg Gate charge
Vge Gate-emitter voltage (gate charge measurement)
Vge(on) Gate-emitter “On-state” voltage (gate charge measurement)
V ge(off) Gate-emitter “ Off-state” voltage (gate charge measurement)
Vce Collector-emitter “ Off-state” voltage (gate charge measurement)
Ic Collector “On-state” current (gate charge measurement)

4-38 Keysight B1506A User’s Guide, Edition 2



Table 4-10

Table 4-11

GUI Reference
Datasheet Characterization Software

Diode Template

The section shows the maximum ratings and characteristics measurement items
defined in the template for the diodes using some tables.

The following table shows the maximum rating parameters defined in this template.

Maximum Ratings

Parameter Symbol
Reverse Voltage VR
Pulsed Forward Current IFM

The following table shows the characteristics parameters that are defined in this
template.

You can specify values to the parameters described in the Conditions column of the
following table, asthe measurement conditions. And, the rating parameter described
in the Ratings column is used as the limit for the measurement conditions.

Char acteristics Parameters

Par ameter Symbol Conditions Ratings
DC Blocking Voltage VDC IR
Forward Voltage VF IF IFM
Reverse Current IR VR VR
Total Capacitance CT VR VR
f

The following table shows the characteristics graphs that are defined in this

template.

The X and Y in the Symbol column show the measurement data specified as the X
and Y-axes data on the graph. And, the rating parametersin the X and Y of the
Ratings column are used as the limit for the measurement conditions.

Keysight B1506A User’s Guide, Edition 2

4-39




GUI Reference
Datasheet Characterization Software

Table 4-12 Characteristics Graphs
Symbols Ratings
Characteristics
X Y X Y
Forward Characteristics VF IF IFM
Reverse Characteristics VR IR VR
Capacitance VR CT VR

The following describes about the symbols in the Conditions column of Table 4-11
on page 4-39 and in the Symbols column of Table 4-12 on page 4-40.

Table 4-13 Glossary of Diode Template
Symbol Description
IR Reverse current
IF Forward current
VR Reverse voltage
f AC signal frequency
VF Forward voltage
CT Total capacitance

4-40 Keysight B1506A User’s Guide, Edition 2



NOTE

GUI Reference
Datasheet Characterization Software

Creating Custom File

This section introduces a procedure and essentialsto create anew ETN DSfileto be
fitted to specific devices.

1

After starting this software, select the type of your device and then click the New
Datasheet button[2] in the Identification area.

This reads the data from the selected template, and provides the foundation for a
new ETN DSfile.

Create anew ETN DS file with an appropriate name using the main menu File >
Save as.

For example, if you specify CustomMOSFET as a new name,
CustomMOSFET.pda-ds.zip fileis created.

Open the ETN DSfile (for example, CustomMOSFET) using the main menu
File > Open. Skip this step if you operate continuously.

Customize the measurement conditions and so on with referring to the
“Customization Essentials” below.

After finishing all customization, save all setup data and measurement data to
the ETN DSfile using the main menu File > Save.

To use the ETN DSfile as atemplate for evaluating same device model, it is
recommended to manage it with keeping from changing. When evaluating each
individua device, use a copy of the ETN DSfile

During opening the ETN DSfile, don't use the Device Type and New Datasheet
buttonlol. If they are used, it rewrites al data by the furnished template.

Customization Essentials

Customizing in the Identification area
e Enter appropriate information to the fields.
Customizing in the Maximum Ratings area

« Review the maximum rating values, and change them to val ues appropriate
for your device.

Customizing in the Characteristics Parameters and Characteristics Graphs areas
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« Review the measurement items, and delete unnecessary items.
To do so, highlight (select) a measurement item, and then click the Delete
button X on the toolbar (or select Delete from the Setup menu).

« Review the measurement items, and make duplicates of the measurement
item if you need to measure the same characteristics parameter/graph with
multiple conditions.

To do so, highlight (select) ameasurement item, and then click the Duplicate
button = on the toolbar (or select Duplicate from the Setup menu).

» For the characteristics parameters, change the parameter values of the Test
Conditions to new preset values appropriate for your device.

For the characteristics graphs, change the minimum and maximum values on
the voltage/current axes to new preset output values appropriate for your
device.

* Review the detailed settings for each measurement item, and change them if
necessary.
To do so, highlight (select) a measurement item, and then click the Setup
button 43 on the toolbar (or select Setup from the Setup menu).

A measurement software related to the highlighted item islaunched with the
detailed settings for the item.

Review the detailed settings on the launched measurement software, adjust
them with executing the measurement. The measurement result is
automatically reflected onto the datasheet characterization software GUI.

If you change the settings without executing the measurement on the
launched measurement software, save new settings to the present
measurement data file. The new settings saved into the measurement data
file are reflected to the ETN DS file when saving the ETN DSfile.

» Conveniently savethe ETN DSfile

By saving the ETN DSfile, the changes on the launched measurement software
arereflected to the ETN DSfile

» After finishing to adjust the settings of all measurement items, mark the check
boxes of all measurement items, start the datasheet characterization
measurement for all items, and then check all results.

4-42 Keysight B1506A User’s Guide, Edition 2



GUI Reference
I/V Measurement Software

I/V Measurement Software

I/V Measurement Software provides:

Voltage/current sweep/spot measurements
DC/pulse outputs

Linear/log sweep with both single (one-way) and double (round-trip) capability
for the primary sweep source (similar to the collector supply of a conventional
curve tracer)

Linear/list sweep capability for the secondary sweep source (corresponding to
the step generator of a conventional curve tracer)

The ability to assign the primary sweep source or the secondary sweep source to
either the collector/drain terminal or to the base/gate terminal.

Intuitive and interactive sweep/spot measurement operation using rotary knob.

Predefined templates for typical MOSFET, IGBT and Diode I/V measurements.

I/V Measurement Software supports Oscilloscope View function in the pulse mode
operation. At the specified measurement point on the characteristic trace, this
function can monitor both voltage and current waveforms for the measurement
channels of all supported modules. Oscill oscope View supports the following
modules:;

MCSMU
HVSMU
HCSMU
UHCU
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GUI Overview

The GUI (Graphical User Interface) of the I/V measurement software is comprised
of the following areas.

Figure 4-9 I/V M easurement Software GUI

IV Moasuramant =

2+ Autom

1. Work Area (Seep. 4-45.)

This area provides the functions to set the measurement conditions and observe
the measurement results. Thisis separated to the following areas.

a. Setup (Seep. 4-45.)
b. Characteristics (See p. 4-59.)
c. Connections (See p. 4-65.)
2. Automatic Data Save (See p. 4-67.)

This area provides the functions regarding the automatic saving of the
measurement datafiles.

3. Operating Tools
e Toolbar (See p. 4-68.)
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This provides the functions that are very frequently used in the button
format.

e Main Menu (See p. 4-70.)

This provides the functions needed for various operations in the menu
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes’
on page 4-72.

For the files handled by this software, see “ Summary of Files’ on page 4-73.

Work Area

In this area, set the measurement conditions and observe the measurement results.
Thisis separated to the following areas.

e Setup (Seep. 4-45.)
e Characteristics (See p. 4-59.)
» Connections (See p. 4-65.)

Setup

Thisisan areato select the device type and its measured |/V characteristics, and
enter your measurement conditions.

Figure 4-10 Setup
|a Setup Device Type: [MOSFET »| @ ID-VDS © ID-VGS ©) VGS(th) © RDS-ID () VDS-VGS ©)RDS-VGS (©)IDSS (JIGSS () IS-VSD
General settings Gate / Base Voltage Pulse Step Drain / Collector Voltage Pulse Sweep
¥ Auto Period Step Mode Lnearsinge _ +| Sweep Mode LnearSinge |
Pulse Period s0m| s Start S v Start oV
| Details Stap 12 Vv Stop &0 Vv
‘ +) Details +) 7 Voltage Compliance 0 V I
Device Type Select the device type of your DUT from below.
» MOSFET
 IGBT
» Diode
»  Generic2T

Thisisfor two-terminal general devices.
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Generic

Select the Generic to execute more general measurements for device other than
above types.

You can select one of the following I/V characteristics measurements for
“MOSFET” devicetype.

ID-VDS

Creates new settings to measure the output characteristics.
ID-VGS

Creates new settings to measure the transfer characteristics.
VGS(th)

Creates new settings to measure the threshold voltage.
RDS-ID

Creates new settings to measure the drain-source resistance characteristics for
the drain current.

VDSVGS

Creates new settings to measure the drain-source voltage characteristics for the
gate-source voltage.

RDS-VGS

Creates new settings to measure the drain-source resistance characteristics for
the gate-source voltage.

IDSS

Creates new settings to measure the drain leak current characteristics for the
drain-source voltage.

IGSS

Creates new settings to measure the gate leak current characteristics for the
gate-source voltage.

ISVSD

Creates new settingsto measure the forward characteristics of the body diode for
the source-drain voltage.

You can select one of the following I/V characteristics measurements for “1GBT”
device type.
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IC-VCE

Creates new settings to measure the output characteristics.
IC-VGE

Creates new settings to measure the transfer characteristics.
VGE(th)

Creates new settings to measure the threshold voltage.
VCE-VGE

Creates new settings to measure the collector-emitter voltage characteristics for
the gate-emitter voltage.

V CE(sat)

Creates new settings to measure the collector-emitter saturation voltage
characteristics for the collector current.

ICES

Creates new settings to measure the collector leak current characteristics for the
collector-emitter voltage.

IGES

Creates new settings to measure the gate leak current characteristics for the
gate-emitter voltage.

IF-VF

Creates new settings to measure the free-wheel diode forward characteristics.

You can select one of the following I/V characteristics measurements for “ Diode”
device type.

IF-VF
Creates new settings to measure the forward bias characteristics.
IR-VR

Creates new settings to measure the reverse bias characteristics.

You can select on of the following 1/V characteristics measurements for
“Generic2T” devicetype.

Conduction
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Creates new settings to measure the conduction resistance characteristics.
» Isolation
Creates new settings to measure the isolation characteristics.
Set your measurement conditionsin “ General settings’ on page 4-48, “ Gate/Base

drive settings’ on page 4-49, and “Drain/Collector drive settings’ on page 4-50 for
“Generic” devicetype.

In this area, you can set the following measurement conditions for DC output
measurement or pulse output measurement.

For DC output measurement:

e StepTime

Specify the period between steps for the staircase sweep.
Setting range: 500 usto5s

* Aperture

Specify the measurement time at each step for the staircase sweep.
Setting range: 2 usto 20 ms

e Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the
start voltage is forced for more than the specified time.
Setting range: 0to 655.35 s

For pulse output measurement:

e Auto Period

Enable or disable the automatic adjustment for the pulse period. To enable this,
mark the check box.

*  Pulse Period

Specify the pulse period.

Setting range: 5msto5s

If the Auto Period is enabled, this is automatically adjusted to minimum period
corresponding to the pulse width.

* Aperture

Specify the measurement time at each pulse.
Setting range: 2 usto 20 ms
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 Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the
start voltage is forced for more than the specified time.
Setting range: 0t0 655.35 s

The following parameter can be shown or hidden by clicking the line of ~' Details.
* Aperture

e Hold Time

Set the output voltage/current to the gate/base terminal. One of the following types
is automatically selected depending on the selected characteristics measurement.
The selected type is displayed on the title of thisterminal setting areaas shown in
the following figure.

Gate / Base|Voltage]

Pulse Step

Step Mgde -
Start 2| V
Stop 12 Vv
) Details
- Voltage |- Bias
- Current |- Pulse Bias
- Step
- Pulse Step

- Staircase Sweep
- Pulse Sweep

For the setting items of the types, see below.

» Bias(Seep. 4-50.)
Outputs the constant bias voltage/current.

e PulseBias(Seep. 4-51.)
Outputs the voltage or current pulse that the peak output is constant.

e Step (Seep. 4-51)
Outputs the constant voltage/current that thelevel is changed every time asweep
measurement is finished.

» Pulse Step (Seep. 4-53.)
Outputs the voltage/current pulse that the peak level is changed every timea
sweep measurement is finished.

e Staircase Sweep (Seep. 4-54.)
Outputs the staircase-swept voltage/current.
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e Pulse Sweep (See p. 4-55.)
Outputs the staircase-swept pulse voltage/current.

Set the output voltage/current to the drain/collector terminal. One of the following
typesis automatically selected depending on the selected characteristics
measurement. The selected type is displayed on thetitle of thisterminal setting area.

For the setting items of the types, see below.

* Bias(Seep. 4-50.)
Outputs the constant bias voltage/current.

* PulseBias(Seep. 4-51.)
Outputs the voltage or current pulse that the peak output is constant.

* Step (Seep. 4-51)
Outputs the constant voltage/current that the level is changed every time asweep
measurement is finished.

* Pulse Step (Seep. 4-53.)
Outputs the voltage/current pulse that the peak level is changed every time a
sweep measurement is finished.

o Staircase Sweep (Seep. 4-54.)
Outputs the staircase-swept voltage/current.

» Pulse Sweep (See p. 4-55.)
Outputs the staircase-swept pulse voltage/current.
The terminal outputs the constant voltage or current.

Set the following parameters.

» Source
Specify an output voltage/current value.

The following parameters can be shown or hidden by clicking the line of ~' Details.

» Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

» Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

» Voltage Compliance
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Specify avoltage compliance value for UHCU.
To enable this, mark the check box.
If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.
The terminal outputs the voltage or current pulse that the peak output is constant.

Set the following parameters.
» Source
Specify a pulse peak voltage/current value.

The following parameters can be shown or hidden by clicking the line of ~' Details.

» Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

» Base
Specify a pulse base voltage/current value.
e Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

» Voltage Compliance

Specify avoltage compliance value for UHCU.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

e Pulse Delay

Specify a delay time from the beginning point of the pulse period to the raising
point.

e Pulse Width

Specify a period of the pulse peak.
The terminal outputs the constant voltage or current that the level is changed every
time a sweep measurement is finished.

Set the following parameters.

*  Step Mode
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Select one from the following level change operation.

« LinearSingle: Constant level is changed by a constant step value.
« LigtSingle: Constant level is changed according to the listed levels.
Start

Specify the first step value.
Available for the “LinearSingle” Step Mode.

Stop

Specify the last step value.
Available for the “LinearSingle” Step Mode.

The following parameters can be shown or hidden by clicking the line of ~' Details.

Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

Number of Step

Specify the number of steps.
Available for the “LinearSingle” Step Mode.

List
Create the list of the output levels.
Available for the “ListSingle” Step Mode.

To insert anew step entry before the selected step vaue, click the Insert
button(Z/,

To move the selected step value up/down, click the Move button ¥ ().
To delete the selected step value, click the Delete button /.
Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

Power Compliance

Specify the power compliance value.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Not available for HYSMU.
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Voltage Compliance

Specify avoltage compliance value for UHCU.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

The terminal outputs the voltage or current pulse that the peak level is changed
every time a sweep measurement is finished.

Set the following parameters.

Step Mode

Select one from the following level change operations.

e LinearSingle: Peak level is changed by a constant step value.
e LigtSingle: Peak level is changed according to the listed levels.
Start

Specify the first pulse peak value.
Available for the “LinearSingle” Step Mode.

Stop

Specify the last pulse peak value.
Available for the “LinearSingle” Step Mode.

List
Create the list of the output levels.
Available for the “ListSingle” Step Mode.

To insert anew step entry before the selected step vaue, click the Insert
button(Z/,

To move the selected step value up/down, click the Move button ¥ ().
To delete the selected step value, click the Delete button /.

The following parameters can be shown or hidden by clicking the line of ~' Details.

Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

Base

Specify a pulse base voltage/current value.
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e Number of Step

Specify the number of steps.
Available for the “LinearSingle” Step Mode.

e Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

» Power Compliance

Specify the power compliance value.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.

» Voltage Compliance

Specify avoltage compliance value for UHCU.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

» Pulse Delay
Specify a delay time from the beginning point of the pulse period to the raising
point.

* Pulse Width
Specify a period of the pulse peak.

Staircase Sweep  Theterminal outputs the staircase-swept voltage/current.
Set the following parameters.
*  Sweep Mode
Select one from the following sweep modes.
e LinearSingle (Sweep from start to stop in alinear incremental step)
« LogSingle (Sweep from start to stop in alogarithmic incremental step)
e LinearDouble (Sweep from start to stop to start in alinear incremental step)

e LogDouble (Sweep from start to stop to start in alogarithmic incremental
step)

e Start
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Specify the sweep start value.
Stop
Specify the sweep stop value.

The following parameters can be shown or hidden by clicking the line of »' Details.

Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

Number of Step
Specify the number of sweep steps from start to stop.
Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

Power Compliance

Specify the power compliance value.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Not available for HYSMU.

Voltage Compliance

Specify avoltage compliance value for UHCU.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

The terminal outputs the staircase-swept pulse voltage/current.

Set the following parameters.

Sweep Mode

Select one from the following sweep modes.

e LinearSingle (Sweep from start to stop in alinear incremental step)

* LogSingle (Sweep from start to stop in alogarithmic incremental step)

e LinearDouble (Sweep from start to stop to start in alinear incremental step)

* LogDouble (Sweep from start to stop to start in alogarithmic incremental
step)
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+ Start

Specify the sweep start value.
« Stop

Specify the sweep stop value.

The following parameters can be shown or hidden by clicking the line of »' Details.

» Resource/Output Mode/Output Sequence

You can change the settings of thisterminal using the pull-down menu. For
details, see “ Resource/Output Mode/Output Sequence” on page 4-57.

* Base

Specify a pulse base voltage/current value.
*  Number of Step

Specify the number of sweep steps from start to stop.
» Compliance

Specify a current/voltage compliance value.
If the output exceeds this, the sweep measurement is terminated.

» Power Compliance

Specify the power compliance value.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Not available for HVSMU.

» Voltage Compliance

Specify avoltage compliance value for UHCU.

To enable this, mark the check box.

If the output exceeds this, the sweep measurement is terminated.
Available for UHCU.

» Pulse Delay

Specify a delay time from the beginning point of the pulse period to the raising
point.

* Pulse Width
Specify a period of the pulse peak.
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Depending on the selected characteristics measurement, the pre-defined output
mode and sequence are automatically selected. If necessary, you can change the
measurement resource, the output mode, and the output sequence. Table 4-14 shows
the available alternatives for the gate/base terminal, and Table 4-15 shows the

available alternatives for the drain/collector terminal.

Available Resource/Output Mode/Output Sequence for Gate/Base Terminal

M easurement Resource

Output Mode

Output Sequence

« MCSMU

MCSMU is
connected to this
terminal.

« MPSMU

MPSMU is
connected to this
terminal.

\Y

Specifiesthe DC
voltage output.

VPulse

Specifies the pulse
voltage output.

Specifiesthe DC
current output.

IPulse

Specifies the pulse
current output.

Congstant

Specifiesthe
constant bias output
sequence.

Step

Specifies the step
bias output sequence.

Sweep

Specifies the sweep
output sequence.
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Available Resource/Output M ode/Output Sequence for Drain/Collector
Terminal

M easurement Resource

Output Mode

Output Sequence

Open

No connection.
Thisterminal is
opened.

UHCU 2

UHCU is connected
to thisterminal.

HCSMU P

HCSMU is
connected to this
terminal.

HVSMU

HVSMU is
connected to this
terminal.

MPSMU

MPSMU is
connected to this
terminal.

V C
Specifiesthe DC
voltage output.
VPulse

Specifies the pulse
voltage output.

I C

Specifiesthe DC
current output.
IPulse

Specifies the pulse
current output.

Constant

Specifiesthe
constant bias output
sequence.

Step

Specifies the step
bias output sequence.
Sweep

Specifies the sweep
output sequence.

a Availablefor B1506A-H71/H51.
b. Available for B1506A-H21.

c. Not available for UHCU.

The combinations of the Output Mode and Output Sequence decide the types as

shown in the following table.
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Type Output Mode Output Sequence
Bias Vorl Constant
Pulse Bias VPulseor IPulse Constant
Step Vorl Step
Pulse Step VPulse or |Pulse Step
Staircase Sweep Vorl Sweep
Pulse Sweep VPulse or |Pulse Sweep

Characteristics

This page shows the graph of the specified I/V characteristics as the measurement
result. To display this page, click the Characteristics tab.

f
T
=y

~ [Linear - |[References:

403.85 A

5 v/div.
VDS

Oscilloscope View

The data for the X and Y-axes are assigned according to the I/V characteristics

Figure4-11 Characteristics
c
Characteristics | Connections dl l|) X ];
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b
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a. Displaying
Characteristic specified in the Setup.
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If the graph has multiple characteristic curves for different measurement conditions,
the measurement conditions are displayed on the graph with the check boxes.
Marking the check box displays the characteristic curve for the measurement
condition. You can mark multiple check boxes for the measurement conditions.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

This graph supports two kinds of markers: Domain marker and Trace marker. You
can switch these markers by clicking the Marker button shown in the bottom part of
the graph.

: Marker button when the Domain marker is used.
| : Marker button when the Trace marker is used.

The Domain marker can read multiple characteristic values for the X-axis position.

The Domain marker supports two markers (A and B). Marker A isalways available.
To use the Marker B, mark the check box for the Marker B. The Marker B isabreak
line. To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference
value (A) between the Marker B and A (B—A). And, each curve annotation has
Y-axis values and difference values (A) between the Marker B and A (B-A).

The Trace marker can read the characteristic value with tracing each characteristic
curve. It is useful when you want to read the characteristic value on double sweep
result.

The marker annotation on the graph has X-axis value for the marker. And, the traced
curve annotation has Y-axis value.

The curves can be represented as Line, Dot, or combination (Line & Daot). Select
any trace representation using the radio buttons shown in the bottom part of the
graph.

You can register the presently-displayed curves as reference traces to compare with
other measurement results on the graph. If you register them as reference traces, the
reference traces are displayed as dimmed thin lines on the graph when you open
other measurement data files or execute the next measurement. To register as the
reference traces, click the Capture button@| shown in the bottom part of the graph.
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You can register amaximum of 10 reference traces. The measurement data files
registered as the reference traces are listed in the References field under the Capture
button@|. You can show or hide the reference traces using the check boxes at the
head of the measurement data file names. The References field can be shown or
hidden by clicking the line of the (~) button on top of the graph.

To remove unnecessary reference traces, select the measurement data file in the
References field, and then click the Remove button| X .

The registration of the reference tracesis cleared when you exit the 1/V
measurement software.

Clicking the Auto Scale button|<| fits the measurement data at that time in the
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement
datais automatically fit according to the progress of the measurement.

If the fixed scale mode is selected by using the Scale mode button, the scale is fixed
until changing the scale manually or clicking the Auto Scale button.

(=] : Scale mode button duri ng selecting the auto scale mode.
.1 : Scale mode button during selecting the fixed scale mode.

The step values for the characteristic curves can be shown or hidden by clicking the

In the case that multiple curves are displayed on the | V-V DS characteristic graph of
MOSFET, IC-V CE characteristic graph of IGBT, and so on, the step value display is
useful to identify which curve isfor which step value.

You can select the data and scale for the X and Y-axes. Asdefault, the data for the X
and Y-axes are assigned according to the I/V characteristics specified in the Setup.

The X/Y datafield can be shown or hidden by clicking the line of the '~/ button on
top of the graph.

Select one from the following scales.

* Linear
Linear scale
» Positivelog

Logarithm scale for positive data

* Negativel og
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Logarithm scale for negative data

Select datafor X and Y-axes corresponding to the specified device type. The
following shows data corresponding to the device type.

For MOSFET:

» VDS: Drain-source voltage

» |ID: Drain current

* RDS: Drain-source resistance

* VGS: Gate-source voltage

* |G: Gate current

» IS Forward direction current of body diode (source current)

» VSD: Forward direction voltage of body diode (source-drain voltage)
For IGBT:

» VCE: Collector-emitter voltage

» IC: Collector current

* VGE: Gate-emitter voltage

* |1G: Gate current

» VF: Forward direction voltage of free-wheel diode
* |F: Forward direction current of free-wheel diode
For Diode:

* VF: Forward direction voltage

* |IF: Forward direction current

* VR: Reverse direction voltage

* |IR: Reversedirection current

For Generic2T:

» V:Voltage between terminals 2 and 3

e |: Terminal 2 current

* R: Resistance between terminals 2 and 3

* VGS: Voltage between terminals 1 and 3
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e |G: Terminal 1 current
* RGS: Resistance between terminals 1 and 3

For Generic:

» VDS: Voltage between terminals 2 and 3

* ID: Terminal 2 current

* RDS: Resistance between terminals 2 and 3
* VGS: Voltage between terminals 1 and 3

* |IG: Terminal 1 current

* RGS: Resistance between terminals 1 and 3
» VSD: Voltage between terminals 3 and 2

* IS Terminal 3 current
The Oscilloscope View area can be hidden or shown by clicking the column of <!
Oscilloscope View. For details, see “ Oscilloscope View” on page 4-63.

Oscilloscope View

When the measurement is in the pulse mode operation, the Oscilloscope View can
monitor both voltage and current waveforms for the measurement channels of all
supported modules, at the specified measurement point on the characteristic trace.
Oscilloscope View supports the following modules:

* MCSMU
« HVSMU
« HCSMU
+ UHCU

To monitor the waveforms in the Oscill oscope View, you need to display this area
before executing the measurement.

To display this area, clicking the column of <! Oscilloscope View at the right top
corner of the Characteristics area.
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Oscilloscope View
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To specify the observation point, use the trace marker on the left-hand
characteristics graph. After measuring the specified point, the observation point on
the characteristics graph is identified by a monitor marker (green frame), and the
time domain waveform(s) is displayed on this area.

In the case of the repeat measurement, you can move the trace marker to change the
observation point during the measurement. After measuring the changed point, the
monitor maker moves to the point and the waveforms are updated.

This area can display voltage or current waveforms characteristics for multiple
measurement channels. To display waveforms, mark the check boxes for the voltage
or current data names of the measurement channels that you want to monitor.

The scale and offset values on the Y-axis for each displayed curve are displayed on
the right upper portion.

You can change the following values on the X and Y-axes by clicking the value.

e Scaleand origin values on X-axis

» Scaeand offset values on Y-axis

There are the Auto Scale button and Scale mode button next to the scale and offset
values on the Y-axis.
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Clicking the Auto Scale button ] fits the measurement data at that time in the
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement
datais automatically fit according to the progress of the measurement.

If the fixed scale mode is selected by using the Scale mode button, the scale is fixed
until changing the scale manually or clicking the Auto Scale button.

BBl : Scale mode button duri ng selecting the auto scale mode.
E3 : scale mode button duri ng selecting the fixed scale mode.

On the graph, you can read values using the domain marker and change the trace
representation. For details, see “b. Markers’ on page 4-60, and “c. Trace
Representation” on page 4-60.

The diaphanous green zone on the graph shows the period of the Aperture value set
in the General settings.
Connections

This page shows the measurement circuit that is automatically connected according
to your specified measurement conditions. To display this page, click the
Connections tab.

Connections

( :l.l: 4

On the measurement circuit, the measurement terminal s, the measurement
resources, and the built-in capacitance and resistance are displayed. The following
shows the relationship between the terminal numbers and the measurement
terminals.
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1: Base/Gate terminal

e 2: Collector/Drain terminal

3: Emitter/Source termina

e 4: Guard terminal

If DUT isadiode, connect the cathode terminal to 2. Collector/Drain terminal, and
the anode terminal to 3. Emitter/Source terminal.

If DUT isa2-terminal general device, connect aterminal to 2. Collector/Drain
terminal, and the another terminal to 3. Emitter/Source terminal.

If the MCSMU is specified to the Base/Gate terminal as the measurement resource,
you can select one from the following base/gate resistances.

« 0Q

« 100
« 100Q
+ 1kQ

The base/gate resistance is effective to restrain the oscillation of DUT that occurs
during the ultra high current measurement and so on.

If the MV SMU is specified to the Collector/Drain terminal as the measurement
resource, you can select one from the following collector/drain resistances.

« 00
* 100 kQ

The collector/drain resistance is effective to restrain the over current that occurs
during the breakdown measurement and so on.
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Automatic Data Save

This area sets the automatic saving for the setup data and measurement data. These
data are automatically saved to a new measurement data file in the specified folder
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line
of (¥) Automatic Data Save.

Automatic Data Save

~) Automatic Data Save Device ID: Device-1

Data folder: C:¥Users¥Userl¥Documents¥Keysight¥SeriesB150x¥PowerDeviceAna yﬁ'ﬂwDataStore

| Browse...

Recent data: | more

+ Comment: \E| Data: \Z|§| MOSFET123 ID VDS 2014-07-07 15-58-14.pda-iv.bct

Device |D

Comment

Data

Enter device ID string to the Device ID field. The maximum 10
recently-entered device | Ds can be kept as history, and you can
also select one from the history list.

The entered device ID is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the device ID in the latest measurement
datafile after the measurement here. To changeit, change the
device ID in the Device ID field, and then click the Apply
button &|.

Enter acomment string to the Comment field.

The entered comment is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the comment in the latest measurement
datafile after the measurement here. To changeit, change the
comment in the Comment field, and then click the Apply
button &|.

The Datafield shows the latest auto-saved or last-opened
measurement data file name. You can do the following
operations.

« Open the measurement datafile by clicking the Open
button &l .

« Rename the measurement data file by clicking the
measurement data file name.
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« Delete the measurement datafile by clicking the Delete
button X .

Data folder Shows the absol ute path of the auto-saved measurement data
file. To change this, click the Browse button to open the folder
selection dialog box. Select your desired folder in the dialog
box.

For theinitial setting of the datafolder, see “ Summary of Files’
on page 4-73.

Recent data Shows up to 10 auto-saved measurement data files that were
automatically saved recently, in the hyper-link format. Clicking
the hyper-link opens the selected measurement data file. This
destroys the presently-editing data.

If the number of the auto-saved measurement datafilesis over
ten, thisfield shows “more...”. Clicking this opensthefile
selection dialog box. Select a measurement data file to open.

Toolbar

Figure 4-15 Toolbar
|‘ alE XOA [ =

The toolbar has four tool button groups. The following shows the tool buttonsin the
tool button groups.

File tool button group

1 Open Opens the Open File dialog box used to open a
-
specified setup file or measurement datafile. The
present datais cleared by opening thefile.

[T Save Saves the present data as the same file name.
i Exit Exits the I/V measurement software. Unsaved datais
destroyed.

Edit tool button group
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X Cut Moves the selected text to the clipboard.
gl Copy Copies the selected text to the clipboard.
K| Paste Pastes the text from the clipboard to the insertion point.
On-screen Displays the on-screen keyboard.
keyboard

M easurement tool button group

p Sart Starts a measurement. During the measurement, the
Measurement  measurement status indicator on the front panel lights
up.
Repeat Starts a repeat measurement. During the measurement,
Measurement  the measurement status indicator on the front panel
lights up.

Thisallows you to observe the measurement result with
changing the setup.

To stop the measurement, select the Measurement >

Stop menu, click the Stop Measurement buttonE on
the toolbar, or press the Stop key on the front panel.

m  Sop Stops the measurement.
M easurement

View tool button group

GotoPalette  Displays the Software Palette in full screen mode.
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Main Menu

Main Menu

|Ei|e Edit View Measurement Configuration Help

The following describes the functions of the main menu.

Displays the following menu items to operate the setup file and measurement data
file. For the file types and extensions, see “ Summary of Files’ on page 4-73.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup
file or measurement datafile. The present dataiis cleared by
opening thefile.

Save Saves the present data as the same file name.

Save Setup As...  Opensthe Save Data File dialog box used to save the present
setup data as the specified setup file.

Save DataAs...  Opensthe Save Data File dialog box used to save the present
setup data and measurement data as the specified measurement
datafile.

Change Device
ID... Changes the device ID recorded in the measurement datafile.

This opens the Change Device ID dialog box, and changes the
device | D recorded in the selected measurement datafile(s). See
“Change Device ID Dialog Box” on page 4-72.

Recent Setup Files
Lists amaximum of 10 names of the setup files that were
recently edited, as menu items. You can easily open a setup file
by using them.

Exit Exitsthe I/V measurement software. Unsaved datais destroyed.

Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.
Copy Copies the selected text to the clipboard.
Paste Pastes the text from the clipboard to the insertion point.
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On-screen

keyboard... Displays the on-screen keyboard.

Displays the following menu items for the display setting.

Goto Palette Displays the Software Palette in fullscreen mode.
Main Window Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.

Color Settings...  Opensthe Color Setting dialog box to set the color for partsin
this software. See“ Color Setting Dialog Box” on page 4-72.

Displays the following menu items for controlling the measurement.

Sart Starts a measurement. During the measurement, the
measurement status indicator on the front panel lights up.

Repeat Starts a repeat measurement. During the measurement, the
measurement status indicator on the front panel lights up.
This allows you to observe the measurement result with
changing the setup.

To stop the measurement, select the M easurement > Stop menu,
click the Stop Measurement button® on the toolbar, or press
the Stop key on the front panel.

Sop Stops the measurement.

Displays the following menu item to administrate the configuration of the built-in

modulesin the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module
Configuration Dialog Box” on page 4-168.

Displays the following menu item.
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About... Opens the about box. See “About Box” on page 4-73.

Dialog Boxes

Change Device 1D Dialog Box

The Change Device ID dialog box is used to change the device ID in all selected
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....
DevicelD field Enter anew device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement
datafile(s) that you want to change the device ID. The selected
files are displayed into the list.

Removebutton  Excludes the selected measurement data file from thelist.
Execute button  ChangesthedevicelD.

Close button Closes this dialog box.

Color Setting Dialog Box

The Color Setting dialog box is used to set colors of the following partsin this
software. The setting in the Color Setting dialog box is saved as a user setting.

» Graph Background

» Graph Axis

» Graph Grid

» Graph Text

* Marker

» Trance

Thisdialog box is opened by selecting the main menu View > Color Settings....
Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.
OK button Applies the present setting to the graph, and closes this dialog
box.
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Cancel button Closes this dialog box without applying the present setting.

About Box

The about box displays the model humber, the software revision number, download
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files

The following shows the summary of the files handled by the I/V measurement
software.

Table 4-16 Summary of Files
File Type Description Extension Folder aslnitial Setting

Setup File This has the setup data only. * pda-iv (You can specify thefolder
You can save this using the File menu when saving the data)
anytime.

M easurement This has the setup data and * pdaiv.itxt | C:\Users\<user name>\

DataFile measurement data including the device Documents\K eysight\Serie
ID and comment. sB150x\PowerDeviceAna

The setup data and measurement data
are automatically saved to thisfilein
the specified folder at the end of the

this using the File menu anytime.

yzen\IV\DataStore
(You can change this)

measurement. And, you can also save

File name of M easurement Data File on Auto-saving
An auto-saved measurement data fileis named as follows:

<Devicel D>_<TEMP>_ <TIME>.pda-iv.txt

<DevicelD>: DevicelD

<TEMP>: Temperature

<TIME>: Time stamp on auto-saving
Example)

Device-1 @Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-iv.txt
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And, the file name is decided according to the following rule.

1. <TEMP> isthe characters of the available thermometer identifiers and the
thermometer readings. To enable thermometers, use the Thermal
Monitor/Control Software. See “ Thermal Monitor/Control Software” on page
4-148.

@<thermometer>=<reading>degC

« <thermometer>: An identifier of the available thermometer

Chl Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the ThermoStream
DUT Thermometer on the DUT port of the ThermoStream

« <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is
concatenated by an underscore (). The @ is attached only at the beginning
of the temperature information.

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> isthe characters of year, month, day, hour, minute, and second. The
time stamp representation depends on the time setting on Windows. And, an
invalid character is replaced with an underscore ().

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If thefile name duplicates the existing file name, the serial number from 2
enclosed by brackets is concatenated before the file extension.

Example)
Device-l @Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-iv.txt
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Capacitance M easurement Software

Capacitance measurement software provides:

Automated measurement circuit configuration for three-terminal device
capacitance measurement (e.g. Ciss, Coss and Crss), with no need to manually
modify any device connections

e With DC hias (sweep) control up to 3 kV for Collector/Drain terminal
e With DC hias (sweep) control up to 100 V for Base/Collector terminal
Automated correction for every measurement path

Stable measurements even if the low-side load capacitance changes dueto abias
change (load adaptive gain-phase compensation)

Predefined templates for typical capacitance measurements of both
enhancement and depl etion type MOSFETS, IGBTs and Diodes
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GUI Overview

The GUI (Graphical User Interface) of the capacitance measurement software is
comprised of the following areas.

Capacitance M easurement Software GUI

& Device Capacitance Massuramant e )

Fie Edt Vew Cabbrabon Measurement Cgnfiguration  Melp
@dsE Xda= e Start Calibeation... Seluct Calibration Data...
. = T o, 0 o o o

~ Setup Dawice Type: |MOSFET =] @ Ciss, Coss, Cres

2~— -

Auttematic Dats Save Device 10:  Denoe-1 = Cormment 15 o pata: | X ||

1

3.

Work Area (Seep. 4-77.)

This area provides the functions to set the measurement conditions and observe
the measurement results. Thisis separated to the following areas.

a. Setup (Seep. 4-77.)

b. Characteristics (See p. 4-86.)

c. Connections (See p. 4-90.)
Automatic Data Save (See p. 4-94.)

This area provides the functions regarding the automatic saving of the
measurement datafiles.

Operating Tools
e Toolbar (Seep. 4-95.)

4-
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This provides the functions that are very frequently used in the button
format.

e Main Menu (Seep. 4-97.)

This provides the functions needed for various operations in the menu
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes’
on page 4-99.

For the files handled by this software, see “ Summary of Files” on page 4-102.

Work Area

In this area, set the measurement conditions and observe the measurement results.
Thisis separated to the following areas.

e Setup (Seep. 4-77.)
e Characteristics (Seep. 4-86.)
e Connections (See p. 4-90.)

Setup

Thisisan areato select the device type and its measured parameters, and enter your
measurement conditions.

Figure 4-18 Setup
~)Setup Device Type: [MOSFET ~| @ Ciss, Coss, Crss () Ciss () Coss () Crss () Cgs, Cds, Cgd () Cgs ©)Cds () Cgd O)Rg © Cox
General settings Base [ Gate Voltage Bias Collector / Drain Voltage Sweep
Frequency 100k Hz Bias 0 Vv Start 100m v
) Details Stop 100 V
Sweap Mode Logsingle -
) Details
Device Type Select the device type of your DUT from below.
e “MOSFET”
« “IGBT”
+ “Diode’
+ “Generic”

Select Generic to execute more general measurements for device other than
above types.
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You can select one of the following capacitance and resistance parameter
measurements for “MOSFET” device type.

e Ciss, Coss, Crss

Creates new settings to measure the characteristics of the input capacitance,
output capacitance, and reverse transfer capacitance for the drain-source voltage
in order.

* Ciss
Creates new settings to measure the characteristics of the input capacitance for
the drain-source voltage.

» Coss

Creates new settings to measure the characteristics of the output capacitance for
the drain-source voltage.

e Crss

Creates new settings to measure the characteristics of the reverse transfer
capacitance for the drain-source voltage.

* Cgs, Cds, Cgd

Creates new settings to measure the characteristics of the gate-source
capacitance, drain-source capacitance, and gate-drain capacitance for the
drain-source voltage in order.

 Cgs

Creates new settings to measure the characteristics of the gate-source
capacitance for the drain-source voltage.

e Cds

Creates new settings to measure the characteristics of the drain-source
capacitance for the drain-source voltage.

 Cgd

Creates new settings to measure the characteristics of the gate-drain capacitance
for the drain-source voltage.

. Rg

Creates new settings to measure the characteristics of the gate resistance for the
gate-source voltage.

e Cox
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Creates new settings to measure the characteristics of the gate oxide capacitance
for the gate-source voltage.

You can select one of the following capacitance and resistance parameter
measurements for “1GBT” device type.

Cies, Coes, Cres

Creates new settings to measure the characteristics of the input capacitance,
output capacitance, and reverse transfer capacitance for the collector-emitter
voltage in order.

Cies
Creates new settings to measure the characteristics of the input capacitance for
the collector-emitter voltage.

Coes

Creates new settings to measure the characteristics of the output capacitance for
the collector-emitter voltage.

Cres

Creates new settings to measure the characteristics of the reverse transfer
capacitance for the collector-emitter voltage.

Cge, Cce, Cgc

Creates new settings to measure the characteristics of the gate-emitter
capacitance, collector-emitter capacitance, and gate-collector capacitance for the
collector-emitter voltage in order.

Cge

Creates new settings to measure the characteristics of the gate-emitter
capacitance for the collector-emitter voltage.

Cce

Creates new settings to measure the characteristics of the collector-emitter
capacitance for the collector-emitter voltage.

Cgc

Creates new settings to measure the characteristics of the gate-collector
capacitance for the collector-emitter voltage.

Rg
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Creates new settings to measure the characteristics of the gate resistance for the
gate-emitter voltage.

You can select the following capacitance parameter measurements for “Diode”
device type.

« CT
Creates new settings to measure the characteristics of the total anode-cathode

capacitance for the reverse bias voltage.

You can select one of the following measurements for “Generic” device type.

»  Sweep Voltage Between Terminal 2-3 (Collector-Emitter/Drain-Source Voltage
Sweep Measurement)

Creates new settings to measure the Cp-G model capacitance between the
collector/drain and the emitter/source terminals for the swept collector-emitter
or drain-source voltage.

»  Sweep Voltage Between Terminal 1-3 (Base-Emitter/Gate-Source Voltage
Sweep Measurement)

Creates new settings to measure the Cs-Rs model capacitance between the
base/gate and the emitter/source terminals for the swept base-emitter or
gate-source voltage.

In this area, you can set the following measurement conditions.
* Frequency

Specify the output frequency of the AC signal from MFCMU.
Setting range: 1 kHz to 1 MHz

» ACLeve

Specify the output level of the AC signal from MFCMU.
Setting range: 0 to 250 mV

* NPLC

Specify the measurement time (integral time) in the number of power line cycle.
Setting range: 1 to 100

» Phase Compensation

Specify one from the following phase compensation modes.

e Auto
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Uses the predefined phase compensation data.
e Adaptive
Compensates the phase at each measurement point before the measurement.

It is useful when you cannot measure in the Auto compensation mode by
MFCMU oscillation.

The following parameter can be shown or hidden by clicking the line of '~ Details.
+ AClLeve

« NPLC

» Phase Compensation

Specify the output settings for the base-collector or gate-source voltage. You can set

them up depending on the types of the selected measurement: forcing the constant
bias voltage or sweeping the bias voltage.

Base/Gate Voltage Bias:

You can specify the following parameters to force the constant bias voltage.

* Bias

Specify the bias voltage.

Setting range: —100V to +100 V
Base/Gate Voltage Sweep:
You can specify the following parameters to sweep the bias voltage.
o St

Specify the sweep start value.

Setting range: —100 V to +100 V
e Siop

Specify the sweep stop value.

Setting range: —100 V to +100 V
*  Sweep Mode

Select one from the following sweep modes.

* LinearSingle (Sweep from start to stop in alinear incremental step)

* LogSingle (Sweep from start to stop in alogarithmic incremental step)

e LinearDouble (Sweep from start to stop to start in alinear incremental step)
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e LogDouble (Sweep from start to stop to start in alogarithmic incremental
step)

e Number of Step

Specify the number of sweep steps from start to stop.
Setting range: 1 to 1001

e Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the
start voltage is forced for more than the specified time.
Setting range: 0to 655.35 s

» Delay Time

Specify the delay time of the measurement at each sweep step. The measurement
is executed after waiting for more than the specified time at each sweep step.
Setting range: 0to 65.535 s

e ZeroBiasTime

Keeps OV at every terminal for more than the specified time after one sweep
measurement.
Setting range: 0t0 99.9 s

In the measurement of the same capacitance parameter as shown in the
following table, the characteristics results by the single measurement and the
continuous measurement may have the difference depending on the bias voltage
condition between the measurements. This parameter is used to cancel the
dependence on the bias voltage condition in the continuous measurement.
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Device Type Mce%r;j?;rg:rit Single M easurement

MOSFET » Ciss, Coss, Crss + Ciss
*+ Coss

* Crss

» Cgs, Cds, Cgd * Cgs

» Cds

 Cgd

IGBT » Cies, Coes, Cres * Cies
* Coes

* Cres

* Cge, Cce, Cgc « Cge

* Cce

« Cqgc

The following parameter can be shown or hidden by clicking the line of ' Details.

e Number of Step

* Hold Time

e Delay Time

» ZeroBiasTime

Specify the output settings for the collector-emitter or drain-source voltage. You can

set them up depending on the types of the selected measurement: forcing the
constant bias voltage or sweeping the bias voltage.

Collector/Drain Voltage Bias:
You can specify the following parameters to force the constant bias voltage.
* Bias

Specify the bias voltage.
Setting range: —3000 V to +3000 V
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Collector/Drain Voltage Sweep:

You can specify the following parameters to sweep the bias voltage.

Start

Specify the sweep start value.
Setting range: —3000 V to +3000 V

Stop

Specify the sweep stop value.
Setting range: —3000 V to +3000 V

Sweep Mode

Select one from the following sweep modes.

e LinearSingle (Sweep from start to stop in alinear incremental step)
« LogSingle (Sweep from start to stop in alogarithmic incremental step)
e LinearDouble (Sweep from start to stop to start in alinear incremental step)

e LogDouble (Sweep from start to stop to start in alogarithmic incremental
step)

Number of Step

Specify the number of sweep steps from start to stop.
Setting range: 1 to 1001

Hold Time

Specify the hold time of the sweep start voltage. At the sweep start point, the
start voltage is forced for more than the specified time.
Setting range: 0t0 655.35 s

Delay Time

Specify the delay time of the measurement at each sweep step. The measurement
is executed after waiting for more than the specified time at each sweep step.
Setting range: 0t0 65.535 s

Zero Bias Time

Keeps 0V at every terminal for more than the specified time after one sweep
measurement.
Setting range: 0t0 99.9 s
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In the measurement of the same capacitance parameter as shown in the
following table, the characteristics results by the single measurement and the
continuous measurement may have the difference depending on the bias voltage
condition between the measurements. This parameter is used to cancel the
dependence on the bias voltage condition in the continuous measurement.

Device Type Mce(;nsﬂrngrﬁ:t Single M easurement
MOSFET Ciss, Coss, Crss + Ciss
*+ Coss
* Crss
Cgs, Cds, Cgd * Cgs
* Cds
» Cgd
IGBT Cies, Coes, Cres » Cies
» Coes
* Cres
Cge, Cce, Cgc « Cge
* Cce
« Cqgc

The following parameter can be shown or hidden by clicking the line of >’ Details.

Number of Step
Hold Time
Delay Time

Zero Bias Time
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Characteristics

This page shows the graph of the specified parameter characteristics asthe
measurement result. To display this page, click the Characteristics tab.

Characteristics

g x: |vDs
bl
a
g
5
‘T
g
8
a. Displaying

Characteristic
Curves

b. Markers

100p F

100 m v

The datafor the X and Y-axes are assigned according to the parameter
characteristics specified in the Setup.

If the graph has multiple characteristic curves for different measurement conditions,
the measurement conditions are displayed on the graph with the check boxes.
Marking the check box displays the characteristic curve for the measurement
condition. You can mark multiple check boxes for the measurement conditions.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

This graph supports two kinds of markers: Domain marker and Trace marker. You
can switch these markers by clicking the Marker button shown in the bottom part of
the graph.

: Marker button when the Domain marker is used.
: Marker button when the Trace marker is used.

The Domain marker can read multiple characteristic values for the X-axis position.
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The Domain marker supports two markers (A and B). Marker A isawaysavailable.
To use the Marker B, mark the check box for the Marker B. The Marker B isabreak
line. To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference
value (A) between the Marker B and A (B—A). And, each curve annotation has
Y-axis values and difference values (A) between the Marker B and A (B-A).

The Trace marker can read the characteristic value with tracing each characteristic
curve. It is useful when you want to read the characteristic value on double sweep
result.

The marker annotation on the graph has X-axis value for the marker. And, the traced
curve annotation has Y-axis value.

The curves can be represented as Line, Dot, or combination (Line & Daot). Select
any trace representation using the radio buttons shown in the bottom part of the

graph.

You can register the presently-displayed curves as reference traces to compare with
other measurement results on the graph. If you register them as reference traces, the
reference traces are displayed as dimmed thin lines on the graph when you open
other measurement data files or execute the next measurement. To register as the
reference traces, click the Capture button@| shown in the bottom part of the graph.

You can register a maximum of 10 reference traces. The measurement data files
registered as the reference traces are listed in the References field under the Capture
button /. You can show or hide the reference traces using the check boxes at the
head of the measurement data file names. The References field can be shown or
hidden by clicking the line of the '~/ button on top of the graph.

To remove unnecessary reference traces, select the measurement data file in the
References field, and then click the Remove button|X| .

The registration of the reference tracesis cleared when you exit the capacitance
measurement software.

Clicking the Auto Scale button|<| fits the measurement data at that time in the
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement
dataisautomatically fit according to the progress of the measurement.

If the fixed scale mode is selected by using the Scale mode button, the scale is fixed
until changing the scale manually or clicking the Auto Scale button.
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(=] : Scale mode button duri ng selecting the auto scale mode.
1] : Scale mode button during selecting the fixed scale mode.

The step values for the characteristic curves can be shown or hidden by clicking the

In the case that multiple curves (Ciss, Coss, and Crss of MOSFET, and so on) are
displayed on the graph, the parameter name display is useful to identify which curve
isfor which parameter.

You can select the data and scale for the X and Y-axes. As default, the datafor the X
and Y-axes are assigned according to the parameter characteristics specified in the
Setup.

The X/Y datafield can be shown or hidden by clicking the line of the '~/ button on
top of the graph.

Select one from the following scales.

e Linear
Linear scale
» Positivelog

Logarithm scale for positive data
* Negativel og
Logarithm scale for negative data

Select datafor X and Y-axes. The data corresponding to the parameter specified in
the Setup is represented as Capacitance, Conductance, or Resistance.

For example, in the case of the Ciss measurement, Cp is represented as Capacitance
and G is represented as Conductance. In like manner, in the case of the Rs
measurement, Rsis represented as Resistance and Csis represented as Capacitance.

° Cp
Parallel capacitance on the Cp-G model
e G

Conductance on the Cp-G model
* Cs

Serial capacitance on the Cs-Rs model
* Rs
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Seridl resistance on the Cs-Rs model
e Ls
Serial inductance on the Ls-Rs model
. L p
Parallel inductance on the L p-G model
* R
Resistance on the R-X (impedance) model
e X
Reactance on the R-X (impedance) model
e G
Conductance on the G-B (admittance) model
- B
Susceptance on the G-B (admittance) model
« VGS (for MOSFET)/VGE (for IGBT)
Gate-source voltage or base-emitter voltage
e IG
Gate or base current
« VDS (for MOSFET)/VCE (for IGBT)
Drain-source voltage or collect-emitter voltage
« 1D (for MOSFET)/IC (for IGBT)

Drain or collector current
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Connections

This page shows the measurement circuit that is automatically connected according
to your specified measurement conditions. To display this page, click the
Connections tab.

Figure 4-20 Connections
Characteristics | Connections
1 Base [ Gate 2 Collector / Drain 3 Emitter / Source 4 Guard
a—
¥ b ) v
L) o
71 Detaily
U High / Low AL Guard / AC Short o Bias Guard
T s i : : : : ; g e
Hi Low | Floating
HIg L Low |
b - Low |
Lo Cor |
Lo L |
Lo froe ° Com

a. Measurement
Circuit

NOTE

b. Details

On the measurement circuit, the measurement terminal s, the measurement
resources, and the built-in capacitance and resistance are displayed. The following
shows the relationship between the terminal numbers and the measurement
terminals.

» 1: Base/Gate terminal
e 2: Collector/Drain terminal
e 3: Emitter/Source terminal

e 4: Guard terminal

If DUT isadiode, connect the cathode terminal to 2. Collector/Drain terminal, and
the anode terminal to 3. Emitter/Source terminal.

In the case that the specified parameter characteristics has multiple measurements
such as Ciss, Coss, and Crss measurements, the measurement circuits are
respectively separated for the measurements by |eft-side tabs.

Thisareais hidden as default. You can show this areaunder the measurement circuit
by clicking the line of (~) Details.
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This area shows the connection status for the terminalsin the table format. To edit
the settings, mark the check box in this area. You can set up the connections by the
combination of the following items.

CMU High/Low

Select acombination of connections between the DUT terminals (1 to 3) and the
CMU terminals (High and Low).

High Connectsthe DUT terminal to the High terminal of CMU.
Low Connects the DUT terminal to the Low terminal of CMU.
--- No connection

AC Guard/AC Short

Select a combination of connections between the DUT terminals (1to 3) and AC
Guard terminal, or AC short connection between the DUT terminals 2 and 3.

Com. Connects the DUT terminal to the circuit common directly.

Floating Connects the DUT terminal to the selected bias source or
the circuit common viathe built-in capacitor.

2-Short-3 Shorts between DUT terminals 2 and 3 viathe built-in
capacitor.

--- No connection

Bias

Select acombination of connections between the DUT terminals (1 to 3) and the
DC bias source (SMU, CMU, or Common).

CMU Uses the bias source in the CMU that is connected.
SMU Connects the DUT terminal to an SMU as the bias source.
Com. Connects the DUT terminal to the circuit common.

--- No connection

Guard

Select a connection between the DUT terminal 4 and AC Guard terminal.
Com. Connects the DUT terminal 4 to circuit common directly.

Floating Connects the DUT terminal 4 to the selected bias source or
the circuit common viathe built-in capacitor.
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The following table shows applicable connections between the DUT terminals and
the measurement resources. The rightmost column shows the potential at the DUT
terminal 4 when it is connected to the AC Guard terminal in the built-in capacitor
(Floating connection). In the table, the blank cell means “same as above”.

Table 4-17 Applicable Connections
CMU High/L ow AC Guard/AC Short Bias Guard
1 2 3 1 2 3 1 2 3 Floating
High --- Low --- Com. --- CMU | Com. | Com. AC Guard
SMU | Com. | Com. AC Guard
--- Floating | --- CMU | SMU | Com. Terminal 2
SMU | SMU | Com. Termina 2
CMU --- Com. AC Guard
SMU --- Com. AC Guard
--- 2-Short-3 CMU | SMU | Com. Termina 2
SMU | SMU | Com. Terminal 2
High Low Low --- --- --- CMU | Com. | Com. AC Guard
SMU | Com. | Com. AC Guard
--- High Low Com. --- --- Com. | SMU | Com. AC Guard
Floating --- --- SMU | SMU | Com. AC Guard
--- CMU | Com. AC Guard
SMU | CMU | Com. AC Guard
Low High --- --- --- Com. | Com. | SMU | Com. AC Guard
SMU | SMU | Com. AC Guard
Com. | CMU | Com. AC Guard
SMU | CMU | Com. AC Guard
Low High Low --- --- --- Com. | SMU | Com. AC Guard
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CMU High/L ow AC Guard/AC Short Bias Guard
1 2 3 1 2 3 1 2 3 Floating
SMU | SMU | Com. AC Guard
Com. | CMU | Com. AC Guard
SMU | CMU | Com. AC Guard
Low High High --- --- - Com. | CMU | CMU AC Guard
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Automatic Data Save

This area sets the automatic saving for the setup data and measurement data. These
data are automatically saved to a new measurement data file in the specified folder
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line
of ¥) Automatic Data Save.

Figure4-21 Automatic Data Save
) Automatic Data Save Device ID: Device-1 ~ Comment: 1 | Data: | X |
Data folder: C:¥Users¥User1¥Documents¥Keysight¥SeriesB150x¥PowerDeviceAnalyzer¥DeviceCapacitance¥DataStore Browse
Recent data: ‘ more... |
Device D Enter device ID string to the Device ID field. The maximum 10

recently-entered device |Ds can be kept as history, and you can
also select one from the history list.

The entered device ID is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the device ID in the latest measurement
datafile after the measurement here. To changeit, change the
device ID in the Device ID field, and then click the Apply
button|&|.

Comment Enter acomment string to the Comment field.

The entered comment is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the comment in the latest measurement
datafile after the measurement here. To changeit, change the
comment in the Comment field, and then click the Apply
button|&|.

Data The Datafield shows the latest auto-saved or last-opened
measurement data file name. You can do the following
operations.

« Open the measurement datafile by clicking the Open
button &l .

« Rename the measurement data file by clicking the
measurement data file name.

« Delete the measurement datafile by clicking the Delete
button X |.
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Figure 4-22 Toolbar

Gl XOANE

The toolbar has five tool button groups. The following shows the tool buttonsin the

tool button groups.
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Shows the absol ute path of the auto-saved measurement data
file. To change this, click the Browse button to open the folder
selection dialog box. Select your desired folder in the dialog
box.

For theinitial setting of the data folder, see “ Summary of Files’
on page 4-102.

Shows up to 10 auto-saved measurement data files that were
automatically saved recently, in the hyper-link format. Clicking
the hyper-link opens the selected measurement data file. This
destroys the presently-editing data.

If the number of the auto-saved measurement datafilesis over
ten, thisfield shows “more...”. Clicking this opensthefile
selection dialog box. Select a measurement data file to open.

Start Calibration... Select Calibration Data...

File tool button group

& Open
[T Save
a Exit

Opens the Open File dialog box used to open a
specified setup file or measurement datafile. The
present datais cleared by opening thefile.

Saves the present data as the same file name.

Exits the capacitance measurement software. Unsaved
datais destroyed.

Edit tool button group

¥

Cut

Moves the selected text to the clipboard.
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il Copy
cfl Paste

On-screen
keyboard

Copies the selected text to the clipboard.

Pastes the text from the clipboard to the insertion point.

Displays the on-screen keyboard.

M easurement tool button group

> Sart

M easurement
m Sop

M easurement

View tool button group

Goto Palette

Starts a measurement. During the measurement, the
measurement status indicator on the front panel lights

up.
To stop the measurement, select the Measurement >

Stop menu, click the Stop Measurement button® on
the toolbar, or press the Stop key on the front panel.

Stops the measurement.

Displays the Software Palette in full screen mode.

Calibration tool button group

Sart Calibration...

Select Calibration
Data...

Opens the Calibration dialog box to get the calibration
data. See “Calibration Dialog Box” on page 4-100.

Opens a dialog box for the file selection, and then
applies the selected calibration datafileto the
measurement.
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File Menu

Edit Menu

GUI Reference
Capacitance Measurement Software

Main Menu

Main Menu

| File Edit WView Calibration Measurement Configuration Help
The following describes the functions of the main menu.

Displays the following menu items to operate the setup file and measurement data
file. For the file types and extensions, see “ Summary of Files’ on page 4-102.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup
file or measurement datafile. The present dataiis cleared by
opening thefile.

Save Saves the present data as the same file name.

Save Setup As...  Opensthe Save Data File dialog box used to save the present
setup data as the specified setup file.

Save Data As...  Opensthe Save Data File dialog box used to save the present
setup data and measurement data as the specified measurement
datafile.

Change Device
ID... Changes the device ID recorded in the measurement datafile.

This opens the Change Device ID dialog box, and changes the
device | D recorded in the sel ected measurement datafile(s). See
“Change Device ID Dialog Box” on page 4-99.

Recent Setup Files
Lists amaximum of 10 names of the setup files that were
recently edited, as menu items. You can easily open a setup file
by using them.

Exit Exits the capacitance measurement software. Unsaved datais
destroyed.

Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.
Copy Copies the selected text to the clipboard.
Paste Pastes the text from the clipboard to the insertion point.
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On-screen

keyboard... Displays the on-screen keyboard.

Displays the following menu items for the display setting.

Goto Palette Displays the Software Palette in fullscreen mode.
Main Window Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.
Color Settings...  Opensthe Color Setting dialog box to set the color for partsin
this software. See “ Color Setting Dialog Box” on page 4-100.
Displays the following menu items for the calibration.

Sart Opensthe Calibration dialog box to get the calibration data. See
“Calibration Dialog Box” on page 4-100.

Select Data Opens a dialog box for the file selection, and then appliesthe
selected calibration datafile to the measurement.

Load Factory
Default Appliesthe factory default calibration datafile to the
measurement.

Displays the following menu items for controlling the measurement.

Sart Starts a measurement. During the measurement, the
measurement status indicator on the front panel lights up.

To stop the measurement, select the M easurement > Stop menu,
click the Stop Measurement button® on the toolbar, or press
the Stop key on the front panel.

Sop Stops the measurement.
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Displays the following menu item to administrate the configuration of the built-in
modulesin the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module
Configuration Dialog Box” on page 4-168.

Displays the following menu item.

About... Opens the about box. See “ About Box” on page 4-101.

Dialog Boxes

Change Device I D Dialog Box

The Change Device ID dialog box is used to change the device ID in all selected
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....
DevicelD field Enter anew device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement
datafile(s) that you want to change the device ID. The selected
files are displayed into the list.

Removebutton  Excludes the selected measurement data file from thelist.
Execute button  ChangesthedevicelD.

Close button Closes this dialog box.
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Color Setting Dialog Box

The Color Setting dialog box is used to set colors of the following partsin this
software. The setting in the Color Setting dialog box is saved as a user setting.

» Graph Background
» Graph Axis
e Graph Grid
e Graph Text
*  Marker
* Trace
+ First
*  Second
e Third
Thisdialog box is opened by selecting the main menu View > Color Settings....
Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.

Reset button Resets to the default setting.
OK button Applies the present setting to the graph, and closes this dialog
box.

Cancel button Closes this dialog box without applying the present setting.

Calibration Dialog Box

The Calibration dialog box is used to acquire the calibration data regarding the
leakage conductance, parasitic capacitance, residual resistance, and inductance on
the signal paths, and apply it to the measurement.

If you change the signal pathsto DUT, you need to acquire the calibration data for
the new paths.

The calibration data supports the situation that the signal pathsin the test fixture are
automatically switched.

Thisdialog box is opened by selecting the main menu Calibration > Start.

Full Path Calibration M easurement
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Select to acquire the calibration data for al available signal
paths.

Minimum Path Calibration M easurement

Sart button

Save and Apply
button

Cancel button

About Box

Select to acquire the calibration datafor the signal pathsused in
the present setup.

For signal paths except for them, the factory default calibration
dataisapplied.

Starts to acquire the calibration data. Open or short the
capacitance measurement circuit according to instructions of
the wizard.

Savesthe acquired calibration datato afile, and appliesit to the
measurement.

Destroys the acquired calibration data and closes this dialog
box.

The about box displays the model number, the software revision number, download
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....
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Summary of Files

The following shows the summary of the files handled by the capacitance

measurement software.

Table 4-18 Summary of Files
File Type Description Extension Folder aslnitial Setting
Setup File This has the setup data only. * pda-cap (You can specify thefolder
You can save this using the File menu when saving the data)
anytime.
M easurement This has the setup dataand * pda-cap.txt | C:\Users\<user name>\
DataFile measurement dataincluding the Documents\K eysight\
device ID and comment. SeriesB150x\PowerDevice
The setup data and measurement data AnalyzenDeviceCapacitan
. e ce\DataStore
are automatically saved to thisfilein (You can change this)
the specified folder at the end of the 9
measurement. And, you can also save
this using the File menu anytime.
CdlibrationData | Calibration data * pda-cap.cal | C:\ProgramData\K eysight\
File Thisis automatically saved after the SerlesBlSOX\I?owerDeylce
calibration execution AnalyzenDeviceCapacitan
’ ce\UserCalibrationData
Factory Default Calibration data C:\ProgramData\K eysight\
Thisis used when thereis no user SeriesB150x\PowerDevice
Analyzer\DeviceCapacitan

calibration data.

ce\CalibrationData

File name of M easurement Data File on Auto-saving

An auto-saved measurement data file is named as follows:

<Devicel D>_<TEMP>_<TIME>.pda-cap.txt

<DevicelD>: DevicelD
<TEMP>: Temperature
<TIME>:

Example)

Time stamp on auto-saving

Device-1_@Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-cap.txt
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And, the file name is decided according to the following rule.

1. <TEMP> isthe characters of the available thermometer identifiers and the
thermometer readings. To enable thermometers, use the Thermal
Monitor/Control Software. See “ Thermal Monitor/Control Software” on page
4-148.

@<thermometer>=<reading>degC

« <thermometer>: An identifier of the available thermometer

Chl Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the ThermoStream
DUT Thermometer on the DUT port of the ThermoStream

« <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is
concatenated by an underscore (). The @ is attached only at the beginning
of the temperature information.

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> isthe characters of year, month, day, hour, minute, and second. The
time stamp representation depends on the time setting on Windows. And, an
invalid character is replaced with an underscore ().

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If thefile name duplicates the existing file name, the serial number from 2
enclosed by brackets is concatenated before the file extension.

Example)
Device-l @Ch1=30degC_Ch2=30degC _2014-10-30_18-56-55(3).pda-cap.txt
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Gate Char ge M easurement Software

Gate charge measurement Software provides;

»  Support for both constant current load mode and resistive load mode
» Correction of parasitic capacitance and residua resistance in the gate path

» Monitoring of gate and drain/collector voltage/ and current waveforms during
the DUT turn-on period phase

» JESD?24-2 compliant Qg curve, line fitting and parameter extraction
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GUI Overview

The GUI (Graphical User Interface) of the gate charge measurement software is
comprised of the following areas.

Gate Charge M easurement Software GUI

B Gate Charge Measuriment | ———
3— Fle EQt yew Calbranon Measurement EQ"Fg-Jrat'.'y'\ Halp
a@lE XtoHa@m e Start Cakibration... Select Calibration Data...
~ | Conditions
a— c Gat
& gs{odf) [4 o
sgs{on =
g
<1,
Vgs(th) £
.
> e
| i -
h Curre

Vgs, Gate to Source Voltage

100 n

Qg, G

ats Save Device ID: Device-1

1 Data: [p¢] | MosFeT

1. Work Area (Seep. 4-106.)

This area provides the functions to set the measurement conditions and observe
the measurement results. Thisis separated to the following aress.

a. Conditions (See p. 4-106.)
b. Gate Charge Characteristics (See p. 4-108.)
¢. Switching Waveform (See p. 4-112.)

2. Automatic Data Save (See p. 4-117.)

This area provides the functions regarding the automatic saving of the
measurement datafiles.

3. Operating Tools
e Toolbar (See p. 4-118.)
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This provides the functions that are very frequently used in the button
format.

e Main Menu (See p. 4-120.)

This provides the functions needed for various operationsin the menu
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes’
on page 4-122.

For the files handled by this software, see “ Summary of Files” on page 4-125.

Work Area

In this area, set the measurement conditions and observe the measurement results.
Thisis separated to the following areas.

e Conditions (See p. 4-106.)
» Gate Charge Characteristics (See p. 4-108.)
e Switching Waveform (See p. 4-112.)

Conditions

Thisis an areato enter your measurement conditions. For the setting range of the
condition parameters, see Table 4-19 on page 4-108.

This area can be hidden or shown by clicking the line of (' Conditions.

Conditions

Gate ¥| Current Load
60 V Vags(off) o Vv LoadVgs{off) o v
200 A vags(on) 15 Vv Loadvgs(on) 15 vV
Ig 5m A

Set the conditions for driving the drain of DUT.
Vds(off) Enter a value of the drain-source voltage at the off-state.

Id(on) Enter avalue of the drain current at the on-state when the
constant current load is used.
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When the constant current load is not used, the on-state current
is decided by the off-state voltage, resistance of the resistive
load, and the on-state resi stance/saturation voltage. For the
current output range of the power supply, the minimum range
including Id(on) is automatically selected.

Set the conditions for driving the gate of DUT.

V gs(off) Enter a value of the gate-source voltage to change the DUT to
the off-state.

Vgs(on) Enter a value of the gate-source voltage to completely change
the DUT to the on-state.

Ig Enter alimit value of the gate current. Thisvalue impactson the
switching time. Large g shortens the switching time, and small
Ig elongatesiit.

Mark the check box when you want to use the constant current | oad.

Set the conditions for driving the gate of the transistor for the constant current load,
that isthe source of the on-state current described in “Drain” on page 4-106.

When you use the resistive load (not use the constant current load), unmark the
check box to disable the constant current load.

L oadV gs(off) Enter avalue of the gate-source voltage to change the transistor
for the constant current load to the off-state.

L oadVgs(on) Enter a value of the gate-source voltage to completely change
the transistor for the constant current load to the on-state.

Before the gate charge measurement, DUT is completely changed to the on-state.
During this situation, the gate-drain voltage of the transistor is searched from

V gs(off) to Vgs(on) so that the specified on-state current Id (on) flows. The
transistor is driven by the searched gate-source voltage, and then the gate charge
measurement is executed. Where, “DUT is completely changed to the on-state”
means the state that the gate-source voltage of the DUT is set to the Vgs(on) entered
for the gate drive condition.
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Table 4-19 Setting Range for Parameters
Setting Range
Setting Par ameter
B1506A-H21 B1506A-H51 B1506A-H71

Vds(off) @High Voltage 0V to +3000V
Vds(off) @High Current | - 40V to +40V -60V to+60V
Id(on) max. 20A 450 A 1100 A
V gs(off) -30Vto+30V
Vgs(on) -30Vto+30V
Ig 1pAtolA
L oadV gs(off) -30Vto+30V
L oadV gs(on) -30Vto+30V

Gate Charge Characteristics

This page shows the graph and extracted parameters of the gate charge
characteristics as the measurement results. To display this page, click the Gate
Charge Characteristics tab.
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Gate Charge Characteristics

d

e
. G
Vgs(on) refrerrreenen ey =
c1, 51 g
L E
A 8
vags(pl) -orqmreesd 5
vgs(th) ---
3 v
vags(off) ---

aglon) i} -
Derived | High Current | High Voltage

Symbol  Value Unit Description,
vgs(pl) 5.52 V gate plateau voltage
Qgs 89.2n C gate-source charge
Qgd 209 n
Qg(th) 48.6n

C gate-drain charge
(o}
Qgon) 743n C
E
F

gate-source threshold ch
on-state g,

ci 16.1n g (

c2 46.8 n {Qg(on)-Q

S1 31.9m slope 1

100 n C/div.

S2  11.4m slope 2

Qg, Gate Charge . i ; |

This area can display multiple characteristics curves as shown in the following list.
To display curves, mark the check boxes for the characteristics curves you want to

display.

JESD24-2 (Derived)

Shows the gate charge characteristics when the off-state voltage and the on-state
current specified in “Drain” are applied.

Vgs-Qg (H.C))

Shows the gate charge characteristics when the on-state current specified in
“Drain” is applied.

When the constant current load is not used, the on-state current is decided by the
off-state voltage, resistance of the resistive load, on-state resistance, and the
output voltage of UHCU/HCSMU.

Vgs-Qg (H.V.)

Shows the gate charge characteristics when the off-state voltage specified in
“Drain” is applied.

JESD24-2 (H.C))
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Shows an approximation straight line of Vgs-Qg (H.C.) gate charge
characteristics. The approximation is calculated on sloops (S, S,, and S)
defined in JEDEC Standard JESD24-2.

« JESD24-2 (H.V.)

Shows an approximation straight line of Vgs-Qg (H.V.) gate charge
characteristics. The approximation is calculated on sloops (S, S,, and S)
defined in JEDEC Standard JESD24-2.

* Vds-Qg(H.C)

Shows the relationship between the drain-source voltage and gate charge when
the Vgs-Qg (H.C.) is measured.

For HCSMU, the drain-source voltage is a voltage between the drain of the
constant current load transistor and the source of DUT.

* VdsQg(H.V.)

Shows the relationship between the drain-source voltage and gate charge when
the Vgs-Qg (H.V.) is measured.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

This graph supports two markers (A and B). Marker A isaways available. To use
the Marker B, mark the check box for the Marker B. The Marker B isabreak line.
To move the marker position, use the rotary knob or mouse.

The marker annotation on the graph has X-axis values for markers, and a difference
value (A) between the Marker B and A (B—A). And, each curve annotation has
Y-axis values and difference values (A) between the Marker B and A (B-A).

The curves can be represented as Line, Dot, or combination (Line & Dot). Select
any trace representation using the radio buttons shown in the bottom part of the

graph.

You can register the presently-displayed curves as reference traces to compare with
other measurement results on the graph. If you register them as reference traces, the
reference traces are displayed as dimmed thin lines on the graph when you open
other measurement data files or execute the next measurement. To register as the
reference traces, click the Capture button@| shown in the bottom part of the graph.
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You can register amaximum of 10 reference traces. The measurement data files
registered as the reference traces are listed in the References field under the Capture
button@|. You can show or hide the reference traces using the check boxes at the
head of the measurement data file names. The References field can be hidden or
shown by clicking the line of the ¥’ button on top of the graph.

To remove unnecessary reference traces, select the measurement data file in the
References field, and then click the Remove button| X .

The registration of the reference traces is cleared when you exit the gate charge
measurement software.

To extract and show the gate charge parameter values according to JESD24-2
(Derived), JESD24-2 (H.C.), and JESD24-2 (H.V.) in this area, enter the threshold
voltage Vgs(th) of the DUT. You can change the display contents by clicking the
tabs.

Vas(pl) Gate plateau voltage
Qgs Gate-source charge
Gate charge for slope S; according to JEDEC Standard
JESD24-2
Qaqd Gate-drain charge
Gate charge for slope S; according to JEDEC Standard
JESD24-2
Qg(th) Gate-source threshold charge
Gate charge from V gs(off) to Vgs(th)
Qg(on) On-state gate-source charge
Gate charge from V gs(off) to Vgs(on)
C1 Qgs{Vgs(pl)- Vgs(off)}
Equivalent capacitance for S; in JESD24-2
c2 { Qg(on)- Qgs- Qgd}/{Vgs(on)- Vgs(pl)}
Equivalent capacitance for S, in JESD24-2
Sl S; in JESD24-2
2 S, in JESD24-2

This area can be hidden or shown by clicking the column of >/ Parameters at the
right side of the window.
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Switching Waveform

This page shows the switching waveforms of DUT to observe the switching
behavior. And, you can also set detailed parameters before the measurement. To
display this page, click the Switching Waveform tab.

The gate charge characteristics is cal culated from the gate current and waveform
data of the gate-source voltage obtained from the switching, and the calibration data.

There are the following switching modes.

e “High Current Switching Mode’

UHCU or HCSMU is used as a power supply to force the on-state current
specified in “Drain” to DUT viathe constant current load specified in “ Current
Load”.

And, the applied voltage is determined as follows, depending on the off-state
voltage specified in “Drain”.

« |f the off-state voltage is within the output voltage range of UHCU/HCSMU,
they force the specified voltage. The maximum output voltage of UHCU is
60V andit of HCSMU is20V at 20 A range.

« |f the off-state voltage exceeds the output voltage range of UHCU/HCSMU,
UHCU forces 60 V and HCSMU forces 20 V.

If you don’t use the constant current load, the applied current is determined from
the load resistance, on-state resistance of DUT, and the output voltage of the
power supply.

» “High Voltage Switching Mode”

HVSMU is used as a power supply to force the off-state voltage specified in
“Drain” to DUT.

This page has the graph area to display the time-domain switching waveforms and
the advanced setup area to set the detail ed parameters for the measurement in the
above modes. To switch the mode, click the tab (High Current or High Voltage) on
theleft side.
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High Current Switching Mode

Switching Waveform (High Current Switching Mode)
c b

a. Displaying
Characteristic
Curves

b. Adjusting Scale

This area can display the following switching waveformsin the high current
switching mode. To display switching waveform(s), mark the check boxes for the
waveforms.

e Vds: Drain-source voltage waveform

* |d: Drain current waveform

» Vgs: Gate-source voltage waveform

+ Ig: Gate current waveform

» LoadVgs: Gate-source voltage waveform of the current load

» Loadlg: Gate current waveform of the current load

The scale and offset values on the Y-axis for each displayed curve are displayed on
the right upper portion.

You can change the following values on the X and Y-axes by clicking the value.

» Scaleand origin values on X-axis
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» Scale and offset values on Y-axis

There are the Auto Scale button and Scale mode button next to the scale and offset
values on the Y-axis.

Clicking the Auto Scale button ] fits the measurement data at that time in the
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement
datais automatically fit according to the progress of the measurement.

If the fixed scale mode is sel ected by using the Scale mode button, the scale is fixed
until changing the scale manually or clicking the Auto Scale button.

BBl : Scale mode button duri ng selecting the auto scale mode.
E3 : scale mode button duri ng selecting the fixed scale mode.

On the graph, you can read values using the markers, change the trace
representation, and use the reference traces. For details, see “b. Markers’ on page
4-110, “c. Trace Representation” on page 4-110, and “ d. Reference Traces’ on page
4-110.

This areais hidden as default. You can show this area under the graph area by
clicking the line of (»~/ High Current Setup.

This area showsthe setup items on the measurement circuit and timing chart. To edit
the setting values, mark the check box of the High Current Setup.

Loadlg Gate current limit for Current Load
Ig Gate current limit for DUT

Gate Resistor Gate resistance for DUT
(Same value is used between the both switching modes.)

Id(on) On-state drain current
LoadVgs Gate to-source voltage for Current Load adjusted to 1d(on)

By marking the check box, you can overwrite the gate-source
voltage of the current load that was adjusted according to the
Id(on).

L oadV gs(off) Off-state gate-source voltage for Current Load

Vds(off) Off-state drain-source voltage
Vgs(stop) Stop value for Vgs
Vgs(start) Start value for Vgs
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DelayVds Delay time from Current L oad gating to off-state drain-source
voltage application

DelayVgs Delay time from off-state drain-source voltage application to
start of Vgs swing

OnPeriod Period from start of Vgs swing to Vds zero

High Voltage Switching Mode

Figure 4-28 Switching Waveform (High Voltage Switching M ode)
c b
Gate Charge Charactenistics | Switching W veform v !
a—t
|
|
d Ig . ” al\
o _‘| AN
_r gl ;
= = :
I. . L g g — .-4 -
he
a. Displaying This area can display the following switching waveformsin the high voltage
Characteristic switching mode. To display switching waveform(s), mark the check boxes for the
Curves waveforms.

» Vds: Drain-source voltage waveform
* |d: Drain current waveform

» Vgs: Gate-source voltage waveform
* |g: Gate current waveform

b. Adjusting Scale The scale and offset values on the Y-axis for each displayed curve are displayed on
the right upper portion.
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You can change the following values on the X and Y-axes by clicking the value.

» Scaleand origin values on X-axis
e Scaleand offset values on Y-axis

There are the Auto Scale button and Scale mode button next to the scale and offset
values on the Y-axis.

Clicking the Auto Scale button ] fits the measurement data at that time in the
graph scale.

If the auto scale mode is selected by using the Scale mode button, the measurement
datais automatically fit according to the progress of the measurement.

If the fixed scale mode is sel ected by using the Scale mode button, the scale is fixed
until changing the scale manually or clicking the Auto Scale button.

B : Scale mode button duri ng selecting the auto scale mode.
E3 : scale mode button duri ng selecting the fixed scale mode.

On the graph, you can read values using the markers, change the trace
representation, and use the reference traces. For details, see “b. Markers’ on page
4-110, “c. Trace Representation” on page 4-110, and “ d. Reference Traces’ on page
4-110.

This areais hidden as default. You can show this area under the graph area by
clicking the line of ‘' High Voltage Setup.

This area shows the setup items on the measurement circuit and timing chart. To edit
the setting values, mark the check box of the High Voltage Setup.

o} Gate current limit for DUT

Gate Resistor Gate resistance for DUT
(Same value is used between both switching modes.)

Vds(off) Off-state drain-source voltage

Vgs(stop) Stop value for Vgs

Vgs(start) Start value for Vgs

DelayVgs Delay time from off-state drain-source voltage application to

start of Vgs swing
OnPeriod Period from start of Vgs swing to Vds zero
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Automatic Data Save

This area sets the automatic saving for the setup data and measurement data. These
data are automatically saved to a new measurement data file in the specified folder
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line
of (¥) Automatic Data Save.

Automatic Data Save

n Automatic Data Save Device ID: Device-1

+ Comment: [18] pata: [ | gl| MOSFET123 2014-07-04_13-49-53.0da-qg.txt

Data folder: C:¥Users¥User1¥Documents¥Keysight¥SeriesB150x¥PowerDeviceAnalyzer¥GateCharge¥DataStore [ Browse... |

Recent data: Im—l

Device |ID

Comment

Data

Enter device ID string to the Device ID field. The maximum 10
recently-entered device | Ds can be kept as history, and you can
also select one from the history list.

The entered device ID is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the device ID in the latest measurement
datafile after the measurement here. To changeit, change the
device ID in the Device ID field, and then click the Apply
button &|.

Enter acomment string to the Comment field.

The entered comment is automatically saved to the
measurement datafile at the end of the measurement.

You can also change the comment in the latest measurement
datafile after the measurement here. To changeit, change the
comment in the Comment field, and then click the Apply
button &|.

The Datafield shows the latest auto-saved or last-opened
measurement data file name. You can do the following
operations.

» Open the measurement datafile by clicking the Open
button &l .

* Rename the measurement data file by clicking the
measurement data file name.

» Delete the measurement datafile by clicking the Delete
button X .
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Data folder Shows the absol ute path of the auto-saved measurement data
file. To change this, click the Browse button to open the folder
selection dialog box. Select your desired folder in the dialog
box.

For theinitial setting of the data folder, see “ Summary of Files’
on page 4-125.

Recent data Shows up to 10 auto-saved measurement data files that were
automatically saved recently, in the hyper-link format. Clicking
the hyper-link opens the selected measurement data file. This
destroys the presently-editing data.

If the number of the auto-saved measurement datafilesis over
ten, thisfield shows “more...”. Clicking this opensthefile
selection dialog box. Select a measurement data file to open.

Toolbar
Figure 4-30 Toolbar
ﬁ H xi ';fj u-] é‘j 3 _’ Start Calibration... select Calibration Data...

The toolbar has five tool button groups. The following shows the tool buttonsin the
tool button groups.

File tool button group

1 Open Opens the Open File dialog box used to open a
-
specified setup file or measurement datafile. The
present datais cleared by opening thefile.

[T Save Saves the present data as the same file name.

i Exit Exits the gate charge measurement software. Unsaved
datais destroyed.

Edit tool button group
X Cut Moves the selected text to the clipboard.
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gl Copy Copies the selected text to the clipboard.
K| Paste Pastes the text from the clipboard to the insertion point.
On-screen Displays the on-screen keyboard.

keyboard

M easurement tool button group

p Sart Starts a measurement. During the measurement, the
Measurement  measurement status indicator on the front panel lights
up.

To stop the repeat measurement, select the
Measurement > Stop menu, click the Stop

Measurement buttonE on thetoolbar, or press the Stop
key on the front panel.

m  Sop Stops the measurement.
M easurement

View tool button group

GotoPalette  Displays the Software Palette in full screen mode.

Calibration tool button group

Sart Calibration... Opens the Calibration dialog box to get the calibration
data. See “Calibration Dialog Box” on page 4-123.

Select Calibration Opens a dialog box for the file selection, and then
Data... applies the selected calibration data file to the
measurement.
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File Menu

Edit Menu

GUI Reference
Gate Charge Measurement Software

Main Menu

Main Menu

File Edit WView Calibration Measurement Configuration Help
The following describes the functions of the main menu.

Displays the following menu items to operate the setup file and measurement data
file. For the file types and extensions, see “ Summary of Files’ on page 4-125.

New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup
file or measurement datafile. The present dataiis cleared by
opening thefile.

Save Saves the present data as the same file name.

Save Setup As...  Opensthe Save Data File dialog box used to save the present
setup data as the specified setup file.

Save DataAs...  Opensthe Save Data File dialog box used to save the present
setup data and measurement data as the specified measurement
datafile.

Change Device
ID... Changes the device ID recorded in the measurement datafile.

This opens the Change Device ID dialog box, and changes the
device | D recorded in the selected measurement datafile(s). See
“Change Device ID Dialog Box” on page 4-122.

Recent Setup Files
Lists amaximum of 10 names of the setup files that were
recently edited, as menu items. You can easily open a setup file
by using them.

Exit Exits the gate charge measurement software. Unsaved datais
destroyed.

Displays the following menu items to edit the setup.

Cut Moves the selected text to the clipboard.
Copy Copies the selected text to the clipboard.
Paste Pastes the text from the clipboard to the insertion point.
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On-screen

keyboard... Displays the on-screen keyboard.

Displays the following menu items for the display setting.

Goto Palette Displays the Software Palette in fullscreen mode.
Main Window Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.
Color Settings...  Opensthe Color Setting dialog box to set the color for partsin
this software. See “ Color Setting Dialog Box” on page 4-122.
Displays the following menu items for the calibration.

Sart Opensthe Calibration dialog box to get the calibration data. See
“Calibration Dialog Box” on page 4-123.

Select Data Opens a dialog box for the file selection, and then appliesthe
selected calibration datafile to the measurement.

Load Factory
Default Appliesthe factory default calibration datafile to the
measurement.

Displays the following menu items for controlling the measurement.

Sart Starts a measurement. During the measurement, the
measurement status indicator on the front panel lights up.

To stop the repeat measurement, select the Measurement > Stop
menu, click the Stop Measurement button® on the toolbar, or
press the Stop key on the front panel.

Sop Stops the measurement.
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Displays the following menu item to administrate the configuration of the built-in
modules in the mainframe and test fixture.

Module... Opens the Module Configuration dialog box. See “Module
Configuration Dialog Box” on page 4-168.

Displays the following menu item.

About... Opens the about box. See “ About Box” on page 4-124.

Dialog Boxes

Change Device I D Dialog Box

The Change Device ID dialog box is used to change the device ID in all selected
measurement data files at once.

This dialog box is opened by selecting the main menu File > Change Device ID....
DevicelD field Enter anew device ID. You can also select it from the history.

Add... button Opens the file selection dialog box to select the measurement
datafile(s) that you want to change the device ID. The selected
files are displayed into the list.

Removebutton  Excludes the selected measurement data file from thelist.
Execute button  ChangesthedevicelD.

Close button Closes this dialog box.

Color Setting Dialog Box

The Color Setting dialog box is used to set colors of the following partsin this
software. The setting in the Color Setting dialog box is saved as a user setting.

» Graph Background
» Graph Axis

» Graph Grid

» Graph Text

*  Marker

» Gate Charge Characteristics
« JESD24-2 (H.C)
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« VgsQg(H.C)

* VdsQg(H.C)

« JESD24-2 (H.V.)

* VgsQg(H.V)

* VdsQg(H.V)

e JESD?24-2 (Derived)
»  Switching Waveform

* Vds

e Id

* Vgs

. g

e LoadVgs

* Loadlg
This dialog box is opened by selecting the main menu View > Color Settings....
Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.
Reset button Resets to the default setting.
OK button Applies the present setting to the graph, and closes this dialog

box.

Cancel button Closes this dialog box without applying the present setting.

Calibration Dialog Box

The Calibration dialog box is used to acquire the calibration data regarding the
residual resistance and parasitic capacitance on the signal paths, and apply it to the
measurement.

If you change the signal pathsto DUT, you need to acquire the calibration data for
the new paths.

Thisdialog box is opened by selecting the main menu Calibration > Start.

This page is used to acquire the calibration datafor “Open” and “ Short” of the DUT
gate drive circuit under the predetermined measurement condition.
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User Series
Resistor

M easure button

Save and Apply
button

Cancel button

Enter the value of the external seriesresistor to be not measured
by the “Short” calibration.

Theresidual resistance measured by the “ Short” calibration and
this resistance value are used for the calibration.

Starts to acquire the calibration data. Open or short the gate
charge measurement circuit according to instructions of the
wizard.

Savesthe acquired calibration datato afile, and appliesit to the
measurement.

Destroys the acquired calibration data and closes this dialog
box.

This pageis used to acquire the calibration datafor “Open” of the DUT gate drive
circuit under the present setup.

M easure button

Clear button

Close button

About Box

Starts to acquire the calibration data. Open the gate charge
measurement circuit according to instructions of the wizard.

Destroys the calibration data acquired on this tab page, and
cancelsto apply. The factory default calibration datais used for
the “Open” calibration.

Closes this dialog box.

The about box displays the model humber, the software revision number, download
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....
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The following shows the summary of the files handled by the gate charge

measurement software.

Table 4-20 Summary of Files
File Type Description Extension Folder as|nitial Setting
Setup File This has the setup data only. * pda-qg (You can specify thefolder
You can save this using the File menu when saving the data)
anytime.
Measurement This has the setup data and * pda-qg.txt | C:\Users\<user name>\
DataFile measurement dataincluding the device Documents\K eysight\
ID and comment. SeriesB150x\PowerDevice
The setup data and measurement data AnalyzenGateCharge\Data
. S Store
are automatically saved to thisfilein (You can change this)
the specified folder at the end of the 9
measurement. And, you can also save
this using the File menu anytime.
CdlibrationData | Calibration data *.pda-qg.cal | C:\ProgramData\K eysight\
File o : SeriesB150x\PowerDevice
I;‘:E:;?g:}ogiﬁsg saved after the Analyzer\GateCharge\User
' CalibrationData
Factory Default Calibration data C:\ProgramData\K eysight\
Thisis used when thereis no user SeriesBl50x\PowerDe«ige
- Analyzer\GateCharge\Cali
calibration data. .
brationData

File name of M easurement Data File on Auto-saving

An auto-saved measurement data file is named as follows:

<Devicel D>_<TEMP>_<TIME>.pda-qg.txt

<DevicelD>: DevicelD
<TEMP>: Temperature
<TIME>:

Example)

Time stamp on auto-saving

Device-l @Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55.pda-qg.txt
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And, the file name is decided according to the following rule.

1. <TEMP> isthe characters of the available thermometer identifiers and the
thermometer readings. To enable thermometers, use the Thermal
Monitor/Control Software. See “ Thermal Monitor/Control Software” on page
4-148.

@<thermometer>=<reading>degC

« <thermometer>: An identifier of the available thermometer

Chl Channel 1 thermometer of B1506A

Ch2 Channel 2 thermometer of B1506A

Air Thermometer on the air outlet port of the ThermoStream
DUT Thermometer on the DUT port of the ThermoStream

« <reading>: A reading value of the thermometer in degrees centigrade

If multiple thermometers are available, the temperature information is
concatenated by an underscore (). The @ is attached only at the beginning
of the temperature information.

Example) @Ch1=25degC_Ch2=75degC_Air=100degC

2. <TIME> isthe characters of year, month, day, hour, minute, and second. The
time stamp representation depends on the time setting on Windows. And, an
invalid character is replaced with an underscore ().

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

3. If thefile name duplicates the existing file name, the serial number from 2
enclosed by brackets is concatenated before the file extension.

Example)
Device-l @Ch1=30degC_Ch2=30degC_2014-10-30_18-56-55(3).pda-qg.txt
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Power Loss Calculation Software
Power |oss cal culation software provides:
» Calculation of switching device power lossfor:

« Hard switching mode
«  Soft switching mode
e Inputsto characterize the following parameters:
* Gate resistance
* Onresistance
e Gatecharge
» Gate switching charge
« Equivalent output capacitance (energy related)
» Equivalent output capacitance (time related)

e Input parameter assistance using related measurement dataincluding:
» Display of source measurement data
»  Switching condition parameter input
e Support of parameter sweep for one parameter

» Power loss calculation results of ;

» Total power loss

* Conductive power loss

» Driving power loss

*  Switching power loss (inductive |oad)

»  Graph representation of loss components for optional parameter sweep
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GUI Overview

The GUI (Graphical User Interface) of the Power loss calculation softwareis
comprised of the following areas.

Power L oss Calculation Software GUI

8 Power Loss Caloutabon I
3 —fFe fot wew cacson tep
ahm S005T > -
a_
C—
2—.’, Autnmatic Data Save Devics [0: Device-1 = Commant: ‘| Data: )<|{. evice-1_Powe I

1. Work Area (Seep. 4-129.)

This areaprovides the functionsto set the cal culation conditions and observe the
calculation results. Thisis separated to the following aress.

a. Conditions (See p. 4-129.)
b. Inputs (Seep. 4-130.)
c. Results (Seep. 4-137.)
2. Automatic Data Save (See p. 4-140.)

This area provides the functions regarding the automatic saving of the
calculation datafiles.

3. Operating Tools
e Toolbar (Seep. 4-141.)
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This provides the functions that are very frequently used in the button
format.

e Main Menu (Seep. 4-143.)

This provides the functions needed for various operations in the menu
format.

For the dialog boxes displayed during this software operation, see “Dialog Boxes’
on page 4-145.

For the files handled by this software, see “ Summary of Files” on page 4-146.

Work Area

Inthis area, set the cal culation conditions and observe the calculation results. Thisis
separated to the following areas.

e Conditions (Seep. 4-129.)
e Inputs (Seep. 4-130.)
* Results (Seep. 4-137.)

Conditions

Thisisan areato specify your assumption to calculate the power loss on your
switching device.

This area can be shown or hidden by clicking the line of ©~' Conditions.

Figure 4-33 Conditions

i) Conditions ‘

Load Type
@ Inductive Psw = 1/2*f*Vds*Id*(Rg+Rg(ext))*Qsw*{1/(Vgs(on)-Vgs(pl))+1/(vgs(pl)-Vas(off))}
Resistive  Psw = 1/6*f*Vds*Id*(Rg+Rg(ext))*Qsw={1/(Vgs(on)-Vgs(pl))+1/(vgs(pl)-vgs(off))}

Load Type Select the assumed load type to calcul ate the power loss. You can select one from
the following load types.

e |nductive: Inductive load

» Resistive; Resistive load
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a. Device Type

Drive Conditions | Device Parameters.

Sweep
v

a

Parameter

Switching Frequency

Gate-Source turn on Voltage  Vgs(on) 15
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Inputs

Thisis an areato specify the device type of your DUT, and driving condition and
device characteristic parameters that are used as the input datafor calculation. The
driving condition parameters and device characteristic parameters are separated by
tabs.

Other than manually entering the parameter values with referring the device data
sheet, you can also enter them using existing measurement data files. Thisareais
equipped with the functions to read existing measurement datafiles, display the
characteristic curve graphs, and extract some parameter values from them. The
following measurement datafiles are readable.

* |/V measurement datafile

e Capacitance measurement datafile
e Gate charge measurement datafile
They are separated by tabs.

This area can be hidden or shown by clicking the line of *' Inputs.

Inputs
f g h
[Urnputs Device Type: [MoSFET | |
Output Characteristics | Gate Resistance | Capacitance | Gate Charge
Symbol Value Unit = |E‘C:¥User5¥U59r1¥D ur ysight¥SeriesB1: DeviceAnalyzer¥IV¥DataStor
f Start Wk Hz
Stop 2M

Sweep Mode  |Log -

Number of Step 50

Gate-Source turn off Voltage  Vgs(off)
Drain Current Id
Drain-Source Voltage vds

Evtarnal Gata Rasistanca Ralevt)
m

Select the device type of your DUT from below.

e MOSFET
 IGBT
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b. Sweep Select one parameter that is swept to observe the loss changes for the changes of this

Parameter parameter, from the driving condition parameters and device characteristic
parameters. To select it, mark the check box of the parameter. As the default, the
Switching Frequency parameter in the Driving parameters is selected.

Specify the following items for the selected parameter as the sweep parameter.

o« Start

Specify the sweep start value.
« Siop

Specify the sweep stop value.
*  Sweep Mode

Select one from the following sweep modes.

e Linear (Sweep from start to stop in alinear incremental step)

« Log (Sweep from start to stop in alogarithmic incremental step)
e Number of Step

Specify the number of sweep steps from start to stop.

c. Drive Specify the driving condition parameter values.
Conditions For MOSFET:
» f: Switching Freguency
Specify the switching frequency.
» Vgs(on): Gate-source turn on Voltage
Specify the gate-source voltage required to turn the device on.
» Vgs(off): Gate-source turn off Voltage
Specify the gate-source voltage required to turn the device off.
* |d: Drain Current
Specify the On-state drain current.
» Vds: Drain-source Voltage
Specify the Off-state drain-source voltage.
* Rg(ext): External Gate Resistance

Specify the gate resistance included in the external driving circuit.
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Irms: Effective Drain Current
Specify the effective drain current (the root mean square of the load current).

The effective drain current (Irms) is the product of the square root of the drain
current (Id) and the duty cycle (D).

D: Duty Cycle
Specify the duty cycle within the range from 0 to 1.

For IGBT:

f: Switching Frequency

Specify the switching frequency.

Vge(on): Gate-Emitter turn on Voltage

Specify the gate-emitter voltage required to turn the device on.

V ge(off): Gate-Emitter turn off Voltage

Specify the gate-emitter voltage required to turn the device off.

Ic: Collector Current

Specify the On-state collector current.

Vce: Collector-Emitter Voltage

Specify the Off-state collector-emitter voltage.

Rg(ext): External Gate Resistance

Specify the gate resistance included in the external driving circuit.
Irms: Effective Collector Current

Specify the effective collector current (the root mean square of the load current).

The effective collector current (Irms) isthe product of the square root of the
collector current (Ic) and the duty cycle (D).

D: Duty Cycle
Specify the duty cycle within the range from 0 to 1.

Specify the device characteristic parameter values.

For MOSFET:

Qg(on): Gate Charge at on
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Specify the On-state gate charge.
Qg(on) — Qg(off) isregarded as the gate charge required to turn the device on.

Qg(off): Gate Charge at off

Specify the Off-state gate charge.
Qg(on) — Qg(off) isregarded as the gate charge required to turn the device on.

Rg: Gate Resistance
Specify the gate resistance.
Qsw: Gate Switching Charge (Crss)

Specify the required gate charge (Mirror Charge) so that the drain-source
voltage is same as the gate-source voltage when the device state changes from
Off to On.

Vgs(pl): Gate Plateau Voltage
Specify the gate plateau voltage.
Rds(on): On Resistance
Specify the On-state resistance.

For IGBT:

Qg(on): Gate Charge at on

Specify the On-state gate charge.
Qg(on) — Qg(off) isregarded as the gate charge required to turn the device on.

Qg(off): Gate Charge at off

Specify the Off-state gate charge.
Qg(on) — Qg(off) isregarded as the gate charge required to turn the device on.

Rg: Gate Resistance
Specify the gate resistance.
Qsw: Gate Switching Charge (Cres)

Specify the required gate charge (Mirror Charge) so that the collector-emitter
voltage is same as the gate-emitter voltage when the device state changes from
Off to On.

Vge(pl): Gate Plateau Voltage
Specify the gate plateau voltage.
Vce(sat): Saturation Voltage
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Specify the collector-emitter saturation voltage.

It isthe saturation voltage when the collector current (I¢) carries under the Drive
Condition settings.

Specify the measurement data file taken by the 1/V measurement software. To read
thefile, click the Load Measurement Data button &l in the top |eft corner. Thefile
selection dialog box opensto read thefile. The file name to be read is displayed next
to the Load Measurement Data button. And, the output characteristic datais
displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

For MOSFET:

The measurement data file that has any of the following output characteristicsis
readable.

* |ID-VDS
* RDSID
» VDSVGS
* RDSVGS

The following parameter value is extracted from the Vgs(on) parameter value
specified in the Drive Conditions and the output characteristic datato be read.

» Device Parameters
¢ Rds(on): On Resistance
For IGBT:

The measurement data file that has any of the following output characteristicsis
readable.

« IC-VCE
. VCE(sa)
« VCE-VGE

The following parameter value is extracted from the V ge(on) parameter value
specified in the Drive Conditions and the output characteristic datato be read.

» Device Parameters

e Vce(sat): Saturation Voltage
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f. Gate Resistance Specify the Rg characteristic measurement data file taken by the capacitance

g. Capacitance

measurement software. To read thefile, click the Load M easurement Data button il
in the top left corner. The file selection dialog box opens to read the file. Thefile
name to be read is displayed next to the Load Measurement Data button. And, the
Rg characteristic datais displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

For MOSFET:

The following parameter value is extracted from the V gs(off) parameter value
specified in the Drive Conditions and the Rg characteristic data to be read.

* Device Parameters

e Rg: Gate Resistance
For IGBT:

The following parameter value is extracted from the V ge(off) parameter value
specified in the Drive Conditions and the Rg characteristic data to be read.

* Device Parameters

* Rg: Gate Resistance

Specify the measurement data file taken by the capacitance measurement software.
To read thefile, click the Load Measurement Data button &l in the top |eft corner.
Thefile selection dialog box opens to read the file. The file nameto beread is
displayed next to the Load Measurement Data button. And, the characteristic datais
displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

For MOSFET:

The measurement data file that has the following capacitance characteristicsis
readable.

e Ciss, Coss, Crss (Coss or Crss)
The Coss characteristics data is used to cal cul ate the output capacitance loss.

The following parameter value is extracted from the V gs(off) and V ds(off)
parameter values specified in the Drive Conditions and the Crss characteristic data
to be read.
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» Device Parameters
e Qsw: Gate Switching Charge
Charge when the Crssis charged from 0 V to Vds(off)- Vgs(off).
For IGBT:

The measurement data file that has the following capacitance characteristicsis
readable.

e Cies, Coes, Cres (Coesor Cres)
The Coes characteristics data is used to cal culate the output capacitance loss.

The following parameter value is extracted from the V ge(off) and V ce(off)
parameter values specified in the Drive Conditions and the Cres characteristic data
to be read.

* Device Parameters
e Qsw: Gate Switching Charge
Charge when the Cresis charged from 0 V to Vds(off)- Vgs(off).
Specify the measurement data file taken by the gate charge measurement software.
To read thefile, click the Load Measurement Data button &l in the top |eft corner.
Thefile selection dialog box opens to read the file. The file nameto beread is

displayed next to the Load Measurement Data button. And, the gate charge
characteristic data is displayed on the graph.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.

The following parameter values are extracted from the gate charge characteristic
datato be read.

For MOSFET:
» Drive Conditions

« Vgs(on): Gate-source turn on Voltage
« Vg9(off): Gate-source turn off Voltage
e Id: Drain Current

e Vds: Drain-source Voltage

* Device Parameters
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Qg(on): Gate Charge at on

Qg(off): Gate Charge at off

Qsw: Gate Switching Charge (Crss)
Vgs(pl): Gate Plateau Voltage

For IGBT:

Drive Conditions

Vge(on): Gate-source turn on Voltage
V ge(off): Gate-source turn off Voltage
Ic: Collector Current

Vce: Collector-Emitter Voltage

Device Parameters

Qg(on): Gate Charge at on

Qg(off): Gate Charge at off

Qsw: Gate Switching Charge (Cres)
Vge(pl): Gate Plateau Voltage

Results

This area shows the power loss datain the list and the trend chart formats, that was
calculated along your parameter settings specified in the Inputs.

Figure 4-35 Results
a
Index f(Hz) Cond. Loss{W) Coss Loss(W) Switch. Loss(W) Drive Loss(W) Tota Power Loss vs. Switching Frequency
0  10000.000000  7.500000 0.047468  0.813162 0111270 8.4
1 11141913842 7.500000 0.052888  0.906018 0123976 8.5 W W gl Losk
2 7.500000 0.058928  1.009477 0138133 8.7
3 7.500000 0.065657  1.124751 0.153907 8.8 ut|Cappcitance Loss
4 7.500000 0073154  1.253188 0171481 s.o | [
5 7.500000 0.081508 1396291 0191063 9.1 g
6 7.500000 0.020815  1.555735 0212881 9.3 g
7 7.500000 0.101185  1.733387 0237150 9.5 | | W
8  23750.806785  7.500000 0.112740  1.831325 0264275 9.8
9  26462.044287  7.500000 0.125614  2.151866 0294453 10 7‘/
10 20484784525  7.500000 0.139958  2.397590 0328077 10. 0 ——— e e
11 32851692883  7.500000  0.155940  2.671374 0365541 10. 10k Hz decade/div.
n Switching Frequency
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a. List Shows the loss data for the swept parameter values as the calculation result in the
list format.

* Index

Shows the index number of the sweep step.
*  Sweep parameter

Shows the sweep parameter value specified in the Inputs.
» Conduction Loss

Shows the conduction loss as the cal cul ation result.
Thisis calculated from the following expression.

For MOSFET:

2
Rds(on) x Irms

For IGBT:

/,
Vee(sat) 11'/2152
Ic

» Coss (or Coes) Loss

Shows the output capacitance loss as the calculation result.
Thisis calculated from the following expression.

For MOSFET:
b

fXJ. (Cossx V- dV)

a
a = Rds(on) x Id(on)
b= Vds

For IGBT:

b
ij (Coesx V- dV)
a

a = Vece(sat)

b= Vece

e Switching Loss

Shows the switching loss as the calculation result.
Thisiscalculated from either of the following expressions.
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When the Load Type specified in the Conditionsis “Inductive” (MOSFET):

1 1 1
= Vs + 2 K +
i x Vdsx Idx {Rg+ Rg(ext)} x chx{ Vaston)—TasoD) | Tesr )= Vgs(off)}

When the Load Type is “Resistive” (MOSFET):

1 1 1
1 x Fx Vdsx Idx {Rg+ Re(ext +
g [ Vdsx Idx{kg+ Re(ext)} x 05‘”{ Vas(om —Ves(pl)  Ves(pl)— Vgs(off)}

When the Load Type specified in the Conditionsis “Inductive” (IGBT):

1 1 1
Sx Fx Veex Iex {Rg+ Re(ext +
gx [ Veex lex{kg+ Re(ex )}ngw{ufge(on)—Vge(pj) Vge(pj)—ufge(off)}

When the Load Typeis “Resistive” (IGBT):

1 1 1
1x Fx Veex Iex {Rg+ Re(ext +
g [ Veex Tex{Rg+ Re(ex )}ngw{ufge(on)—Vge(pj) Vge(pj)—ufge(off)}

» Driving Loss

Shows the driving loss as the calculation result.
Thisis calculated from the following expression.

For MOSFET:

'x {|Qg(on)| x Vgs(on)—|Qg(or)| x Vgs(off)}

For IGBT:

x{|Qg(on)| x Vge(on)—@g(o )| x Vge(of)}

» Total Loss

Shows the total sum of the conduction loss, output capacitance loss, switching
loss, and driving loss.

Shows the loss data for the swept parameter values as the calculation result in the
trend chart format. Where, the sweep parameter is assigned to the data for the
X-axis, and the conduction loss, output capacitance loss, switching loss, and driving
loss are assigned to the data for the Y-axis and are accumulated in this order.

You can change the minimum and maximum values on the X and Y-axes by clicking
thevalue.
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Automatic Data Save

This area sets the automatic saving for the setup data and measurement data. These
data are automatically saved to a new measurement data file in the specified folder
at the end of the measurement.

The Data folder and Recent data fields can be shown or hidden by clicking the line
of ¥) Automatic Data Save.

Figure 4-36 Automatic Data Save
| Automatic Data Save Device ID: Device-1 « Comment: @l Data: E@l Device-1 Powerloss 2014-11-12 12-01-15.pda-pl.bxt
Data folder: C:¥Users¥User1¥Documents¥Keysight¥SeriesB150x¥PowerDeviceAnalyzer¥PowerLoss¥DataStore Browse... ‘

Recent data: [more...

DevicelD Enter device ID string to the Device ID field. The maximum 10
recently-entered device |Ds can be kept as history, and you can
also select one from the history list.

The entered device ID is automatically saved to the calculation
datafile at the end of the calculation.

You can also change the device ID in the latest calculation data
file after the calculation here. To change it, change the device
ID inthe Device ID field, and then click the Apply button /.

Comment Enter acomment string to the Comment field.

The entered comment is automatically saved to the calculation
datafile at the end of the calculation.

You can also change the comment in the latest calculation data
file after the calculation here. To changeit, change the comment
in the Comment field, and then click the Apply button & .

Data The Datafield shows the latest auto-saved or last-opened
calculation data file name. You can do the following operations.

e Open the calculation datafile by clicking the Open
button &l .

« Rename the calculation datafile by clicking the calculation
datafile name.

« Delete the calculation datafile by clicking the Delete
button X |.
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Data folder Shows the absol ute path of the auto-saved calculation datafile.
To change this, click the Browse button to open the folder
selection dialog box. Select your desired folder in the dialog
box.

For theinitial setting of the data folder, see“ Summary of Files’
on page 4-146.

Recent data Shows up to 10 auto-saved calculation data files that were
automatically saved recently, in the hyper-link format. Clicking
the hyper-link opens the selected calculation datafile. This
destroys the presently-editing data.

If the number of the auto-saved calculation datafilesis over ten,
thisfield shows “more...”. Clicking this opens the file selection
dialog box. Select a calculation data file to open.

Toolbar

Toolbar
‘ﬁﬂ"i ¥xga=_ e =

The toolbar has four tool button groups. The following shows the tool buttonsin the
tool button groups.

File tool button group

& Open Opens the Open File dialog box used to open a
specified setup file or calculation data file. The present
datais cleared by opening thefile.

[T Save Saves the present data as the same file name.
i Exit Exitsthe power loss cal culation software. Unsaved data
is destroyed.

Edit tool button group
X Cut Moves the selected text to the clipboard.
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gl Copy Copies the selected text to the clipboard.
K| Paste Pastes the text from the clipboard to the insertion point.
On-screen Displays the on-screen keyboard.

keyboard

Calculation tool button group

Sart Starts a calculation.

Calculation To stop the calculation, select the Calculation > Stop

menu, click the Stop Calculation buttonEl on the
toolbar, or press the Stop key on the front panel.

m Sop _ Stops the calculation.
Calculation

View tool button group

GotoPalette  Displays the Software Palette in full screen mode.
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Edit Menu

Main Menu

Main Menu
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|Ei|e Edit View Calculation Configuration Help

The following describes the functions of the main menu.

Displaysthe following menu items to operate the setup file and calculation datafile.
For the file types and extensions, see “ Summary of Files’ on page 4-146.

New

Open...

Save
Save Setup As...

Save Data As...

Change Device
ID...

Recent Setup Files

Exit

Clears the present data to start from initial setting.

Opens the Open File dialog box used to open a specified setup
file or calculation data file. The present datais cleared by
opening thefile.

Saves the present data as the same file name.

Opens the Save Data File dialog box used to save the present
setup data as the specified setup file.

Opens the Save Data File dialog box used to save the present
setup data and cal culation data as the specified calculation data
file.

Changes the device ID recorded in the calculation datafile.

This opens the Change Device ID dialog box, and changes the
device ID recorded in the selected calculation data file(s). See
“Change Device ID Dialog Box” on page 4-145.

Lists amaximum of 10 names of the setup files that were
recently edited, as menu items. You can easily open a setup file
by using them.

Exits the power |oss calculation software. Unsaved datais
destroyed.

Displays the following menu items to edit the setup.

Cut

Copy
Paste

Moves the selected text to the clipboard.
Copies the selected text to the clipboard.
Pastes the text from the clipboard to the insertion point.
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On-screen
keyboard... Displays the on-screen keyboard.
View Menu Displays the following menu items for the display setting.

Goto Palette Displays the Software Palette in fullscreen mode.
Main Window Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.
Color Settings...  Opensthe Color Setting dialog box to set the color for partsin
this software. See “ Color Setting Dialog Box” on page 4-145.
Calculation Menu  Displays the following menu items for controlling the calculation.
Sart Starts a calculation.

To stop the present calculation, select the Calculation > Stop
menu, click the Stop Calculation buttonEl on the toolbar, or
press the Stop key on the front panel.

Sop Stops the calculation.
Help Menu Displays the following menu item.
About... Opens the about box. See “ About Box” on page 4-146.
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Dialog Boxes

Change Device I D Dialog Box

The Change Device ID dialog box is used to change the device ID in all selected
calculation datafiles at once.

This dialog box is opened by selecting the main menu File > Change Device ID....
DevicelD field Enter anew device ID. You can also select it from the history.

Add... button Opensthefile selection dialog box to select the calculation data
file(s) that you want to change the device ID. The selected files
are displayed into the list.

Removebutton  Excludes the selected calculation datafile from the list.
Executebutton  ChangesthedevicelD.

Close button Closes this dialog box.

Color Setting Dialog Box

The Color Setting dialog box is used to set colors of the following partsin this
software. The setting in the Color Setting dialog box is saved as a user setting.

» Graph Background
» Graph Axis
» Graph Grid
» Graph Text
e Trend
e Driving Loss
e Output Capacitance Loss
e Switching Loss
» Conduction Loss
e Trace
Thisdialog box is opened by selecting the main menu View > Color Settings....
Clicking the color pattern opens the dialog box for selecting a color.

Apply button Applies the present setting to the graph.
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Reset button Resets to the default setting.
OK button Applies the present setting to the graph, and closes this dialog
box.

Cancel button Closes this dialog box without applying the present setting.

About Box

The about box displays the model humber, the software revision number, download
URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files

The following shows the summary of the files handled by the power loss calculation
software.

Table 4-21 Summary of Files
File Type Description Extension Folder aslnitial Setting
Setup File This has the setup data only. * pda-pl (You can specify thefolder

You can save this using the File menu when saving the data)

anytime.

Cadlculation data
File

This hasthe setup dataand calculation | *.pda-pl.txt C:\Users\<user name>\

dataincluding the device ID and Documents\K eysight\Serie
comment. sB150x\PowerDeviceAna
yzer\PowerL oss\DataStore

The setup dataand cal culation data are
automatically saved to thisfilein the
specified folder at the end of the
calculation. And, you can also save
this using the File menu anytime.

(You can change this)
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File name of calculation data File on Auto-saving
An auto-saved calculation data file is named as follows:

<Devicel D> _<TIME>.pda-pl.txt

<DevicelD>: DevicelD
<TIME>: Time stamp on auto-saving
Example)

Device-1_2014-10-30_18-56-55.pda-pl .txt
And, the file name is decided according to the following rule.

1. <TIME> isthe characters of year, month, day, hour, minute, and second. The
time stamp representation depends on the time setting on Windows. And, an
invalid character is replaced with an underscore ().

Example 1) 2014-10-30_18-56-55
Example 2) 30-10-2014_6-56-55_PM

2. If thefile name duplicates the existing file name, the serial number from 2
enclosed by brackets is concatenated before the file extension.

Example)
Device-1 2014-10-30_18-56-55(3).pda-pl.txt
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Thermal Monitor/Control Software
Thermal monitor/control software provides;

e Thermometer indication
» Thermal profile with measurement triggers
e Control of inTEST ThermoStream

The thermal monitor/control software has two view modes: Monitor mode and
Control mode. Just after starting this software, the control mode GUI is displayed.

The following sections describes about GUI (Graphical User Interface) in two view
modes.

Monitor M ode GUI

The monitor mode GUI is a panel without aframe, and is displayed at the
upper-right corner of the screen. It aways stays on top of other windows. You can
move this panel by dragging and releasing it.

The monitor mode GUI is comprised of the following areas.

Thermal Monitor/Control Software GUI (Monitor Mode)

1 TriggerStatus  Idle
T | B1506A Ch.1: - Ch.2: --—- Ch.1-2: -
| | ThermoStream Air: --- DUT: ---

" Switch View

_ Minimize : - |

33—

] & Exit

1. Trigger Status (Seep. 4-149.)

This displays the thermal condition for theidled DUT characteristics
measurement and the target temperature controlled by ThermoStream.

2. Thermometer Readings (See p. 4-149.)
This displays the readings on the thermometers.
3. Context Menu (See p. 4-150.)

This provides the functions needed for various operations in the menu format.
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Trigger Satus

This displays the thermal condition for theidled DUT characteristics measurement
and the target temperature controlled by ThermoStream. When no thermo-trigger
list is executing, this displays “Idle”.

» During the DUT characteristics measurement iswaiting until the thermal
condition istrue, this displays the thermal condition for the idled measurement.

»  During controlling the temperature of the ThermoStream, this displays the target
temperature controlled by ThermoStream and the thermometer position.

For details, see “ Thermo-Trigger” on page 4-156.

Thermometer Readings

This displays the readings of the following thermometers. It displaysinvalid value
for invalid thermometers.

B1506A Displays temperatures measured by thermocouples connected
to the test fixture.

« Ch1l

Displays a temperature measured by a thermocouple
connected to the thermocoupl e connector 1.

e Ch2

Displays a temperature measured by a thermocouple
connected to the thermocoupl e connector 2.

e Chl-2
Displays a gap between the above Ch.1 and 2 values.

ThermoSream  Displaystemperatures measured by thermometers on the
ThermoStream.

o Air
Displays atemperature at the air outlet.
« DUT
Displays a temperature measured by the DUT thermometer.
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Context Menu
The following context menu is displayed by right-clicking on the panel.

Switch View Switches the view mode to the Control mode.
You can also switch to the Control mode by double-clicking on
the panel.

Minimize Minimizes the panel.

Movetothelnitial

Position Moves the panel to the initial position.

Exit Closes the panel and exits the thermal monitor/control software.
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Control Mode GUI

The control mode GUI is comprised of the following areas.

Figure 4-40 Thermal Monitor/Control Software GUI (Control Mode)
2_'“:*:: W:tm - 'm:_ - = 22202 I -l
E]Ii"i Iﬁ'ﬁ-u’l "F

Insert Corcson| Insart Contral | Cuphate tp | dDown P |

1. Work Area (Seep. 4-153.)

This area providesthe functionsto set the thermometers and ThermoStream, and
create the thermo-trigger list, in addition to all the functions on the monitor
mode panel. Thisis separated to the following aress.

a. Monitor (See p. 4-153.)

b. Configuration (See p. 4-154.)

c. Thermo-Trigger (See p. 4-156.)
2. Operating Tools

e Toolbar (See p. 4-160.)

This provides the functions that are very frequently used in the button
format.

e Main Menu (Seep. 4-161.)

This provides the functions needed for various operationsin the menu
format.

For the dialog box displayed during this software operation, see “Dialog Boxes’ on
page 4-166.
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For the files handled by this software, see “ Summary of Files” on page 4-167.
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Work Area

In this area, set the thermometers and ThermoStream, and create the thermo-trigger
list. Thisis separated to the following areas.

* Monitor (Seep. 4-153.)

» Configuration (See p. 4-154.)

e Thermo-Trigger (See p. 4-156.)

Thisis an areato display the following items that are common information on the
monitor mode panel.

The following fields can be hidden or shown by clicking the line of () Monitor.

Monitor

ch.i: - Ch.2: — Ch.1-2: -

1dle
Air: - DUT: -

Trigger Satus This displays the thermal condition for theidled DUT
characteristics measurement and the target temperature
controlled by ThermoStream. When no thermo-trigger listis
executing, thisdisplays“Idle”.

e During the DUT characteristics measurement is waiting
until the thermal condition is true, this displays the thermal
condition for the idled measurement.

« During controlling the temperature of the ThermoStream,
this displays the target temperature controlled by
ThermoStream and the thermometer position.

For details, see “ Thermo-Trigger” on page 4-156.

B1506A Displays temperatures measured by thermocouples connected
to the test fixture.

« Ch1l

Displays a temperature measured by a thermocouple
connected to the thermocoupl e connector 1.

e Ch2

Displays a temperature measured by a thermocouple
connected to the thermocoupl e connector 2.
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e Chl-2
Displays a gap between the above Ch.1 and 2 values.

ThermoSream  Displaystemperatures measured by thermometers on the
ThermoStream.

o Air
Displays atemperature at the air outlet.
« DUT
Displays atemperature measured by the DUT thermometer.
Thisis an areato set the following items regarding the B1506A’s thermometers and
ThermoStream’s thermometers and control.
The following fields can be hidden or shown by clicking the line of (»

Configuration.

Configuration

~ Canfiguration

G::INSTR Connect

[~ Cptional Commands
Initalization Finalization

a  B1506A Thermometer

Thisisan areato set the following items regarding the B1506A’s thermometers.

Reading Time

Span Specify the reading time span for the B1506A’s
thermometers.
Setting range: 2 sto 3600 s (resolution: 1 s). The default
settingis5s.

While executing a measurement by any measurement
software, the reading is delayed.
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b. ThermoStream
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Enable (On) or disable (Off) athermocouple connected to
the thermocouple connector 1 on the test fixture.

Enable (On) or disable (Off) athermocouple connected to
the thermocouple connector 2 on the test fixture.

Thisisan areato set the following items regarding the ThermoStream.

Thermometer

GPIB

Set up the thermometers of the ThermoStream.
Reading Time Span

Specify the reading time span for the ThermoStream’s
thermometers.

Setting range: 2 sto 3600 s (resolution: 1 s). The default
settingis5s.

Air check box

Enable (On) or disable (Off) the thermometer at the air
outlet of ThermoStream.

DUT check box

Enable (On) or disable (Off) the DUT thermometer of
ThermoStream.

Set up the communication with ThermoStream using the
GPIB.

NOTE To control the ThermoStream from B1506A, set B1506A to the system controller.

* VISA Address
Specify the VISA address string of the ThermoStream.
The default valueis "GPIB0::9::INSTR”.

»  Connect/Disconnect button

Tries to connect with the ThermoStream using the
specified VISA Address, or to disconnect from it.

e Connection Status

Displays the result of the connection trial.
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¢ Connected

Means that the ThermoStream is successfully
connected.

* Disconnected

Means that the ThermoStream is NOT connected or
is disconnected.

c. Optional Commands

You can specify additional ThermoStream command string that is sent to
ThermoStream when executing the thermo-trigger list. For the ThermoStream
commands, see InTest ThermoStream’s manual.

Thisfield can be shown or hidden by clicking the line of (~’ Optional
Commands.

e [nitidization

Specify command string that is sent at the beginning of the thermo-trigger
list execution.

You can also specify multiple commandsin list format.
* Finalization

Specify command string that is sent at the end of the thermo-trigger list
execution.

You can also specify multiple commandsin list format.

Thermo-Trigger Thisisan areato create athermo-trigger list.

Insert thermal condition steps and thermal control steps using the edition buttons on
the bottom of the thermo-trigger list area, and set up the parameters of their stepsto
create athermo-trigger list.

The following fields can be hidden or shown by clicking the line of (»
Thermo-Trigger.
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Thermo-Trigger

=| Setpoint 0 s Ramp 2 o min Optional Command

Canter 30 SC  Radws 1 ¢ Delay 5 g Action |TRIGGER »

a | Tortrei Mode |DUT

Temperature | Tharmastrasm_DUT .

Il.-u-a-r::uu:nwu Iresert Control | Duphcate | +Up + Down X Delete

[
b

a. Thermo-Trigger List

The thermo-trigger list is a sequence comprised of thermal condition steps and
thermal control steps.

The thermo-trigger list is executed from the top to the bottom of the list. If the
ThermoStream is not connected, all thermal control stepsin thelist are skipped.

During executing one thermo-trigger list, a measurement on the measurement
software waits until the thermal condition istrue. Then, when it istrue, the
measurement is executed.

A thermo-trigger list can have maximum 100 steps.
Create athermo-trigger list using the following edition buttons.
b. Edition Buttons

* Insert Condition
Inserts a new thermal condition step just before the selected step.
A new thermal condition step is added if the list is empty.

* Insert Control
Inserts a new thermal control step just before the selected step.
A new thermal control step is added if thelist is empty.

e Duplicate

Makes aduplicate of the selected step and insert it just before the selected
step.
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. Up
Move the selected step up oneline.
* Down
Moves the selected step down one line.
* Delete
Deletes the selected step.
c. Parameters of Thermal Condition Step

The thermal condition step compares the specified temperature reading with the
specified temperature window, and do the specified action such astriggering the
DUT characteristics measurement if the temperature is within the window.

Specify athermal condition (used thermometer and temperature window) and an
action if the condition istrue, in athermal condition step.

Temperature Select atemperature that is used for the condition judgment.

e Channel

Temperature measured by a thermocouple connected to
the thermocouple connector 1 on the test fixture.

e Channel2

Temperature measured by a thermocouple connected to
the thermocouple connector 2 on the test fixture.

e Channell 2
A gap between the above Channel 1 and 2 values.
e ThermoStream_Air
Temperature at the air outlet of ThermoStream.
e ThermoStream DUT
Temperature measured by the DUT thermometer of

ThermoStream.
Center Specify the center of the temperature window of the thermal
condition.
Radius Specify the range of the temperature window of the thermal

condition. If you specify the Center parameter to 30° C and
the Radius parameter to 2° C, the range of the thermal
condition is from 28° C to 32° C.
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Delay Specify atime after that the condition is true and before the
specified action is done.
Action Select an action if the condition istrue.
* TRIGGER
Sends the start trigger for DUT characteristics
measurement.
« NOP

No operation, and goes to the next step.
Thisisuseful to set multiple thermal conditions for a
measurement.

« END
Finishes the thermo-trigger list execution.

d. Parameters of Thermal Control Step

NOTE Thisareaisfor the thermal control using the ThermoStream. Skip this section if you
use the thermal plate for thermal control.

The thermal control step controls the ThermoStream so that the temperature of
the specified observation point reaches to the specified target temperature.

If thereis athermal condition step before athermal control step in the
thermo-trigger list, the thermal control step is executed after finishing the
measurement triggered from the thermal condition step.

Specify a temperature observation point (control mode) an atarget temperature
in athermal control step.

Control Mode Select the thermal control mode from bel ow.
* Air
Controls the temperature with referring to the
thermometer at the air outlet of ThermoStream.
« DUT

Controls the temperature with referring to the DUT
thermometer of the ThermoStream.

Setpoint Specify the target temperature.
Ramp Specify the ramp rate of the temperature.
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Optional
Command

Toolbar

Toolbar

You can specify additional ThermoStream command string
that is sent to ThermoStream when executing the thermal
control step. For the ThermoStream commands, see InTest
ThermoStream’s manual .

You can also specify multiple commandsin list format.

WlE Xdo= » =

The toolbar has four tool button groups. The following shows the tool buttonsin the

tool button groups.

File tool button group

& Open
Y] Save
ﬁ Exit

Edit tool button group

X Cut
EI_] Copy
|:f| Paste

On-screen
keyboard

Opens the Open File dialog box used to open a
specified setup file. The present datais cleared by
opening thefile.

Saves the present data as the same file name.

Exits the therma monitor/control software. Unsaved
datais destroyed.

Moves the selected text to the clipboard.

Copies the selected text to the clipboard.

Pastes the text from the clipboard to the insertion point.

Displays the on-screen keyboard.

Trigger tool button group
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p Sart Starts to execute the thermo-trigger list, and then
switches the view mode to the monitor mode.

To stop the thermo-trigger list execution, select the

Trigger > Stop menu, or click the Stop button® on the
toolbar.

m  Sop Stops the thermo-trigger list execution.

View tool button group

GotoPalette  Displays the Software Palette in full screen mode.

I.ZT Switch View Switches the view mode to the Monitor mode.

Main Menu

Main Menu

File Edit WView Trigger Configuration Help
The following describes the functions of the main menu.
Displays the following menu items to operate the setup file. For the file types and
extensions, see “ Summary of Files’ on page 4-167.
New Clears the present data to start from initial setting.

Open... Opens the Open File dialog box used to open a specified setup
file. The present datais cleared by opening thefile.

Save Saves the present data as the same file name.

Save Setup As...  Opensthe Save Data File dialog box used to save the present
setup data as the specified setup file.

Recent Setup Files
Lists amaximum of 10 names of the setup files that were
recently edited, as menu items. You can easily open asetup file
by using them.

Exit Exits the therma monitor/control software. Unsaved datais
destroyed.
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Edit Menu Displays the following menu items to edit the setup.
Cut Moves the selected text to the clipboard.
Copy Copies the selected text to the clipboard.
Paste Pastes the text from the clipboard to the insertion point.
On-screen
keyboard... Displays the on-screen keyboard.
View Menu Displays the following menu items for the display setting.

Goto Palette Displays the Software Palette in fullscreen mode.
Switch View Switches the view mode to the Monitor mode.
Main Window Displays the following menu item.

Fullscreen Changes the display style of the main
window.

If thisis marked, the main window does not
have the titlebar and is displayed in
full screen mode.

If thisis unmarked, the main window has
thetitlebar and is displayed in the regular
window style.

Thisisinitially marked.

Trigger Menu Displays the following menu items for controlling the thermo-trigger list execution.

Sart Starts to execute the thermo-trigger list, and then switches the
view mode to the monitor mode.

The thermo-trigger list is a sequence comprised of thermal
condition steps and thermal control steps. For details, see
“Thermo-Trigger” on page 4-156.

During executing one thermo-trigger list, you can execute a
measurement on one of the following software in
synchronization if the thermal conditions are respectively true.

» Datasheet Characterization Software (See p. 4-5.)
e 1/V Measurement Software (See p. 4-43.)
» Capacitance Measurement Software (See p. 4-75.)
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e Gate Charge Measurement Software (See p. 4-104.)

During executing one thermo-trigger list, a measurement on the
measurement software waits until the thermal condition istrue.
Then, when it istrue, the measurement is executed. For the
measurement execution in synchronization with the
thermo-trigger list, see “ Executing Measurement in
Synchronization with Thermo-trigger List” on page 4-164.

Sop Stops the thermo-trigger list execution.

The measurement software cancels the idled measurement.
Hence, the measurement is not executed.

Configuration Displays the following menu item for the ThermoStream parameter setting.
Menu .

Define

ThermoStream

Parameters... Opens the ThermoStream Parameters dialog box. See

“ThermoStream Parameters Dialog Box” on page 4-166.

Help Menu Displays the following menu item.
About... Opens the about box. See “ About Box” on page 4-167.
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Executing M easurement in Synchronization with
Thermo-trigger List

You can execute a DUT characteristics measurement using one of the following
software in synchronization with the thermo-trigger list. Along the progress of the
thermo-trigger list, the temperature around DUT is controlled and the measurement
is executed if it reaches within the target temperature window.

» Datasheet Characterization Software
* |/V Measurement Software

e Capacitance Measurement Software
» Gate Charge Measurement Software

If you use the ThermoStream to control the temperature around DUT, do the
following preparation for the measurement in synchronization with the
thermo-trigger list.

*  On the measurement software:
Set up the measurement conditions, and confirm the measurement is
successfully executed at normal temperature. And then, save the setup datato a
setup file or measurement datafile.

*  On the thermal monitor/control software:
Set up the thermal condition and ThermoStream control, and create a
thermo-trigger list in the control mode. And then, save the setup data to a setup
file.

After this preparation, follow the step below to execute the measurement in
synchronization with the thermo-trigger list.

1. Start the thermal monitor/control software.
2. Switch the view mode to the Control mode.
3. Open the prepared setup file on the thermal monitor/control software.
4. Start the measurement software.
5

. Open the prepared setup file or measurement data file on the measurement
software.

6. Click Start tool button in the toolbar (or select Trigger > Start menu) on the
thermal monitor/control software. The thermo-trigger list is executed.
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7. Click Start tool button in the toolbar (or select Measurement > Start menu) on

the measurement software.

At thistime, the measurement is not executed, and waits until the temperature
reaches within the target temperature window. Along the progress of the
thermo-trigger list, the temperature around DUT is controlled and the
measurement is executed if it reaches within the target temperature window.

If you use the thermal plate to control the temperature around DUT, you need to
control the thermal source manually. Even in this case, you can execute the
measurement in synchronization with the thermo-trigger list using the similar
manner as above. The following shows the differences.

Preparation on the thermal monitor/control software:
Set up the thermal conditions only, and create a thermo-trigger list that has only
thermal condition steps, not thermal control steps.

With checking the present temperature around DUT and the next target
temperature window (thermal condition) using the monitor mode panel of the
thermal monitor/control software, control the thermal source manually.

When the present temperature reaches within the target temperature window, the
measurement is executed. Wait until finishing the measurement, control the
thermal source again so that the temperature goes to the next target temperature
window.
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Dialog Boxes

ThermoStream Parameter s Dialog Box

The ThermoStream Parameters dialog box is used to define the ThermoStream
parameters. For details of the parameters, InTest ThermoStream’s manual.

Thisdialog box is opened by selecting the main menu Configuration > Define
ThermoStream Parameters....

DUT sensor Select the type of the thermocouple used asthe DUT
thermometer.
« OFF (disable)
« K
e T

DUT self tuning

control Select OFF or ON to disable or enable the self tuning control
regarding the overshoot and speed of the DUT thermal
controlling.

DUT thermal

constant Specify athermal constant for DUT thermal controlling.

Air toDUT max Specify the maximum acceptable difference between the DUT
temperature and the temperature at the air outlet of
ThermoStream.

Air temperature
max Specify the maximum temperature at the air outlet of
ThermoStream.

Air temperature
min Specify the minimum temperature at the air outlet of
ThermoStream.

Apply button Applies the present setting to the ThermoStream.

OK button Appliesthe present setting to the ThermoStream, and closesthis
dialog box.

Cancel button Closes this dialog box without applying the present setting.
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The about box displays the model humber, the software revision number, download

URL for software updating, and so on.

This dialog box is opened by selecting the main menu Help > About....

Summary of Files

The following shows the summary of the files handled by the thermal

monitor/control software.

Table 4-22 Summary of Files
File Type Description Extension Folder aslnitial Setting
Setup File This has the setup data. * pda-th (You can specify thefolder

You can save this using the File menu
anytime.

when saving the data)
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Common GUI Components

This section describes the following GUI components commonly used in the
Keysight Easy Test Navigator software.

» “Module Configuration Dialog Box”

Module Configuration Dialog Box
You can do the following operations in the Module Configuration dialog box.

» Checking the revision of the firmware

» Setting the power line cycle

» Checking the status of the hardware modules

* Resetting the hardware modules

» Executing the self-test

» Executing the self-calibration

» Executing the self-diagnostics

This dialog box is opened by selecting the main menu Configuration > Module....

Firmware Revision Showstherevision of the firmware.

Line Frequency Sets the power line frequency. Select one from bel ow.
* 50Hz
s 60Hz

Module Name and Shows the modul€'s model numbers and the result of the self-test, self-calibration,
Status and self-diagnostics for the modules.

* BI1506A-H51/H71

Table 4-23 shows the configuration and status for B1506A-H51 and
B1506A-H71.

» B1506A-H21
Table 4-24 shows the configuration and status for B1506A-H21.
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Operation Buttons The Module Configuration dialog box has the following buttons for operations.
Reset Initializes and re-acknowledges all the modules.
Self Test Starts the self-test for al the modules.
Self Calibration  Starts the self-calibration for al the modules.
Diagnosis Starts the self-diagnostics for all the output selectors.

After clicking this button, adialog box is opened to instruct the
terminal connections. Connect the terminals according to the
displayed instructions.

Abort Aborts the process in progress.
Close Closes the Modul e Configuration dialog box.
Error Log Thisisadisplay area situated between the Abort and Close buttons. Error messages

are displayed when errors occur during a process. The error messages are cleared
when you do any new operation.
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Table 4-23 B1506A-H51/H71 Configuration and Status
Configuration Satus
GNDU : B1500-66505 « Pass
MPSMU (SMU1) : B1511B Passed
MFCMU : B1520A * Testing
Self-testing now

MCSMU (SMU2) : B1514A

e Cadlibrating
MCSMU (SMU3) : B1514A

Calibrating now
MCSMU (SMU4) : B1514A

e Fall
MCSMU (SMUS) : B1514A Self-test failed or self-calibration
HVSMU (SMU6) : B1513C failed
UHCU e Unavailable

Not acknowledged

I/V Selector e Pass
Device Capacitance Selector Passed

» Diagnosing

Diagnosing now
e Fall

Self-diagnostics failed
+ Unavailable?

Not acknowledged

a. Thisalso occurs beforeit is turned on.
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Configuration Satus

GNDU : B1500-66505 + Pass
MPSMU (SMU1) : B1511B Passed
MFCMU : B1520A * Testing
MCSMU (SMUZ2) : B1514A Self-testing now

e Cdlibrating
MCSMU (SMU3) : B1514A

Calibrating now

HCSMU (SMU4) : B1512A il

. al

HVSMU (SMU5) : B1513C

Self-test failed or self-calibration

failed
Unavailable
Not acknowledged

I/V Selector .

Device Capacitance Selector

Pass

Passed

Diagnosing
Diagnosing now

Fail

Self-diagnostics failed
Unavailable 2

Not acknowledged

a. Thisalso occurs beforeit is turned on.
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